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GCC_E:'* Expert Il. PykoBoactso

BaxkHaa uHdopmauyusa

Bnarogapum 3a npuobpeteHune pexyuiero nrnotrepa GCC Expert .
[Mepen Havanom paboTbl C NAOTTEPOM HEODXOANMO O3HAKOMUTLCS
C MepamMu NpeaoCTOPOXKHOCTU U yKa3aHUAMU HUXKE.

A

BHAMATE - MEPBI MPEAOCTOPOXHOCTU!

> B uensax 6e3onacHOCT Npu nepemMeLleHMn HeobXxoAMMO HadEeXHO yaepKMBaThb

PeXyLLMI NNoTTEeP 3a OCHOBaHUe. 3anpellaeTca nepemMellaTb NNoTTep, yaepXxunsas

ero 3a 60KOBbIE MOBEPXHOCTM.
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» 3anpelaetcsa TpACTM 1 BpocaTtb AepaTerb HOXa — PUCK OTNIaMbIBaHUSA KPOMKN HOXa.

» 3anpelyaeTcs KacaTbCs B npouecce paboTbl ABMXKYLLMXCA YacTen NnoTrepa, BKYas
kapeTky. CrneauTb, YTOObLI B NNIOTTEP HE NMonanu BOochkl U ogexaa.

» Kabenb anekTponuTaHus NOAKNIYaTh TOMbKO K PO3ETKE C 3a3eMIEHUEM.

» Mcnonb3oBaTb TOMbLKO KOMMIIEKTHLIW Kabenb anekTtponutanms. Cneauntb, YTobbl kKabernb
3MEKTPONUTaAHUS HE NEPEKPYYMBArCa U HE 3acTpeBarn Mexay npegMmeTamu.

» 3anpelyaeTcs nogknoyaTh kKabenb aNeKTponUTaHNs K CETEBOMY pPa3BeTBUTENIO, ECIN
K HEMY NOAKNIYEHO Apyroe obopynoBaHue, N NCNONb30BaTb YAMMHUTENbHbIV
Kabernb. OTO MOXET NPUBECTM K NEperpeBy 1 BbIXo4y YCTPOUCTBA M3 CTPOS.

» WHCTpymMeHTbl HeOOXoaNMMO AepKaTb B HEAOCTYNHOM ANs AeTen MecTe.

> [MpwXnMHbIE PONNKM HEOBXOAMMO BbipaBHUBATL MO GenbiM OTMETKaM.

BaykHaa nHpopmauus
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Paspen 1. O6Owwme cBeaeHwus

1.1 O6was nugopmauumna

Pexywmne nnottepbl cepun Expert || npegHasHayeHbl Ans nonyyYeHns co3gaHHbIX

Ha KOMMblOTEepe N306paXeHNn N KOHTYPHOW PE3KN PYNIOHHOMO 1 NIMCTOBOrO MaTepuana

Ha ocHOBe nonmeMHUNa. Pexyuwme nnotrtepsbl cepun Expert || MOXXHO ncnonb3oBaTtb

He TONbKO ANt KAYeCTBEHHOWN PE3KM NINCTOBBIX U PYNTIOHHBIX MaTepuarnos, HO 1 B Ka4eCcTBe
rpagonocTpontenen. B HacTodwwemM pykoBOACTBE MO SKCMyaTaunum pacCMOTPEHDI
cnegyouwne Mogenu pexyLmx nnotrepos cepumn Expert Il:

Ex 11-24 ansa matepuanos wunpuHon: ot 50 o 719 mm

Ex 11-24LX ans matepuanos wupuHou: ot 50 go 719 mm, ¢ dpyHkumen AAS

Ex 11-52 ans matepuanos wupuHon: ot 50 go 1470 mm

Ex 11-52LX ansa matepuanos wupuHon: oT 50 go 1470 mm, ¢ pyHkumen AAS

1.2 YnakoBka
B komnnekt noctaBkn mogenen cepumn Expert [l BxogaT nepevncneHHble

HW>X€ KOMMNOHEHTHI. Cnep,yeT BHMMaATEJIbHO NMPOBEPUTb KOMIMIIEKTALUIO,
M B Cltydae HexXBaTKn KOMMNOHEHTOB O6paTI/ITbCFI K permoHasnibHOMy Ounepy.

BneMeHT KormyectBo
PexyLumil nnoTrep 1 KoMnexT
Odon. KOMNOHeHTbI 1 KOoMMneKkT

1. YcTaHOBOYHbIA ANCK 2. llIHyp aneKTponuTaHua

3. OnopHble KPOHLUTENHbI

6. Mpoknagka K kKapeTke

Obuwme cBeaeHUn 1-1
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1.3 TexHu4yeckne xapakTepucTuku
Hwxe nepedncrneHbl OCHOBHbIE TEXHUYECKNE XapaKTEPUCTUKN PEXYLLNX NIIOTTEPOB
cepun Expert IlI:
+  ABYXMOPTOBOE MNOAKMIOYEHue: nocnegoBatenbHbln nHTepdenc n USB;
+ ycunue pesa go 350 rc;
+ ckopocTb pesa o 705 mm (EXII-24(LX) n 635 mm (EXII-52 (LX)) B cekyHay
(nop yrnowm 45 rpagycos);
* rapaHTMpoBaHHOE OTCMeXMBaHME TOYHOCTU B 3 METPa;
+ ynyyleHHasi cuctema aBToMaTmyeckoro BolpaBHmBaHus (AAS II)
OIS aBTOMaTUYECKON KOHTYPHOM pe3ku (Tonbko and mogenen LX).

1.4 BHewHuu Bug (EX 11)
141 Bua cnepean
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O6BbekT OnucaHue
A | OCHOBHOW NPWXXMMHOW PONUK YaepxuBaeT matepuan npu peske
B | OtpesHon nas [MomoraeT poBHO OTpe3aTb MaTepuar
C | IlnHenika BblpaBHMBaHMeE NO NpPoO3payHbIM METKaM
D | KapeTka MHCTpymMeHTOB Peska yctaHaBnMBaeMbIM HOXXOM UIN NOCTPOEHUE

nepom

E | Jepxatenb HOXa dukcupyeT HOX
F | OnopHas nnactuHa dukcupyeT 1 NoAAepXKMBaeT MmaTtepuarn npu peske
G | MapsaH 3awmuaeTt HOX 1 NnacTuHy npu pabote
H | MaHenb ynpaBneHus 10 knaBuw 1 6 cBETOAMOAHLIX MHOMKATOPOB
J | Pewetyatbii 6apabaH MNepemellaeT maTepuan Bnepen 1 Hasag

Obuwme ceeaeHUA 1-2
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Pwuc. 1-3

Puc. 1-4

O0bekKT

OnucaHue

K | CoeanHutenb nutaHus
NnepeMeHHOro HanpsKeHus

[ns nogknoyeHns LHYypa nnTaHnA

L | MpepoxpaHutenb

3A

CunoBon BbIKtOYaTeNb

BkntoveHne 1 OTKMoYEHNE yCTpOIZCTBa

N | Mopt USB

MoakntoyeHre pexyLero nnoTTepa K KOMMnblTepy
yepes kabenb USB

O | MNMopT nocnegoBaTenbHOMO
nHTepdenca

MookntoyeHMs pexyLLero NnoTTepa K KOMMNbTepyY
yepes kabenb RS-232

Obuwme cBeaeHuUa

1-3
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Pa3pen 2. YcTtaHOBKa

2.1.

MepbI NpefoCcTopoOXXHOCTHU
[Mepen Ha4Yanom ycTaHOBKMU U3Yy4NTb MHOOPMALINIO HUXKE.

Mpumeyvanune 1

e [lepen ycTaHOBKOW pexyLlero nnotrepa yoeanTbCs, YTO CUTOBOWN BbIKMNOYATESb
HaxoAUTCS B OTKITHOYEHHOM MOJTOXKEHUMN.

e Bo n3bexaHue TpaBM cobnogaTb OCTOPOXXHOCTb NPU NepeMeLLeHny NnoTTepa.

MpumeyaHue 2 MNMopanok BbIOOpa MecTa yCTaHOBKM pexyLlero niorrepa

[lo Hayana ycTaHOBKM pexyLLlero nnoTrepa Bolbpatbh noaxoasiiee Mecto, oTBevatollee
cneayoLwmuM YCroBUsIM.

Nmetotcs yﬂO6HbIe noaxoabl K yCTpOIZCTBy CO BCeX CTOPOH.

NmeeTcs noctaTtodHO MecTa Ans nnoTTepa, BCrioMoratensHoro obopyaoBaHus
N pacxoaHbIX MaTepuarnos.

[MoBEPXHOCTb YCTAHOBKWN YCTONYMBA, HE LOMYyCKaeT 3Ha4YnTenbHoOM Bubpaumu.

Temnepatypa B nomeLrueHun ot 15 oo 30 °C.
OTHOCUHTENbHas BNaXHOCTb B nomMmeLleHnn ot 25 % o 75 %.
YCTPOMCTBO 3aLLMULLEHO OT MNbISIN U CKBO3HAKOB.

Ha ycTponcTBOo He nonagaeT SpKui 1 NPAMOKN COSTHEYHbIN CBET.

I'Ipumeqal-me 3 nOpH,D,OK noAKNMK4YeHUA WHYypa 3N1eKTponnTaHus

Y6eanTbCcs, YTO BUMKA LUHYpa 3NEKTPONMTaHUS NOAXOAUT K HACTEHHOW po3eTke. Ecnin He,
CBSI3aTbCS C AUSIEPOM.

BcTaButb BUJIKY B PO3ETKY 3JIEKTPONMNTAHNA C 3a3EeMITIEHNEM.

BTopoli KoHel, lWHypa NOAKMIYMTE K COEAMHUTENNIO MMTaHMS peXxyLLero nnoTrepa.

MpumeyvaHune 4 MNMopsaaok 3aTsXKKM U ocnabneHna BUHTOB

Mpwn

paboTe KIHOYOM U SNEKTPUYECKOW OTBEPTKOM HeobxoaMmo cobniogaTh

OCTOPOXHOCTb M He npunaratb Ype3MepHbIX YCUITMI NpU 3aTarBaHUM 1 ocnabneHum
BMHTOB. [Mpu 3aTarMBaHMm 1 ocnabneHum BUHTOB U3 OOLIYHOW M Hep)XaBetoLlen cTanm

nonb3oBaTbCA crieaylowen Tabnuuen pacyeta ycunusa 3aTskkM BMHTA. PacuyeTbl ans

BMHTOB U3 APYrnx MmatepumarnoB HE NpuBeaeHbl.

YcTtaHoOBKa 2-1
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OnameTp Ycunue 3atskku (Krc/cm)
BMHTa CraHpgapT 3aTsXKku Anst BbICOKONPOYHbIX MaTepuarnos
M3 6
M4 16
M5 30
M6 50

YcTtaHoOBKa

2-2
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2.2 YcTtaHOBKa CTOMKU
[na mogenen Ha 24 aonma (61 cm) cTorka npuobpeTaeTcst AONONHUTENBHO.

2.21 YcTtaHOBKa CTOMKMU
[ns cbopa CTonKM cnegoBaTb MHCTPYKUMAM HUXE.

MMEYE] Nepen Hauanom ycTaHOBKM HaTW B KAPTOHHOW KOpPOBKe CO BCOMOraTesbHbIMU

KOMIMOHEHTaMM K CTOVKe Takue getanu:

Onsa Expert |l cTorika npnobpeTtaeTcss AONONHUTENBHO, CINCOK AeTaneun:
® JleBas CTOpOHa BepPTUKanbHOM CTOMKM — 1 LWIT.

[MpaBas cTopoHa BepTUKaNbHOW CTONKM — 1 LT,

Onopa gnst neBon CTOpOHbl — 1 WT.

Onopa anst npaBon CTOPOHbI — 1 WT.

TpaBepca — 1 wr.

HwXHune cTonku ¢ konecamm — 2 wT.

Ckonb3swme onopbl Ans 3axeata bymarm — 2 wr.

Kntoy nog BHYTPeHHUN wecturpaHHuk (M5) anam. 4 — 1 wr.

BuHTbI ¢ noTtanHon ronoekon (M6x12) — 28 wr.

PykoBoaCTBO NO MOHTaxy — 1 wT.

Pacronoxus NeByto BepTUKanbHY CTONKY NepneHankynsipHo k anementy @, Bctasutsb
B OTBEPCTUS BUHTbI U 3aTAHYTb UX, NONYy4YMB neByo T-00pa3Hyto CTOWKY (puc. 2-1).
MoBTOPUTE OS5 NpaBOW BEPTUKASTbHOM CTOMKN.

e

s
& s
R

JleBag BepTukanoHas
cTounka

-3

O HuxHsia cToiika

Puc. 21

YcTtaHoOBKa 2-3
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MomecTnB TpaBepcy npsiMmo Ha T-00pasHytd CTOWKY, BCTaBUTb B OTBEPCTUS BUHTHI,
HO NMoKa He 3aTarmBaTb. LIeHTpOBOYHbIE WTUMPTHI He npegycmoTpeHbl. CoBmellaTb

BMHTbl C TFOJSIOBKOW C BHYTPEHHUMM LUECTUrPaHHMKOM C pe3bboBbIMU OTBEPCTUAMU
Ha 06eunx T-oOpasHbiX CTOMKaX.

Expert Il. PykoBoacTtso

TpaBepca

__ T-obpasHas cTouka

Puc. 2-2

M3Bneyb pexywmnm nnoTrTep n3 KOpobkn. YCTaHOBUTL CTOMKY Mo NIIOTTEPOM. Ha HMXKHeN
YacTu NnoTTepa C Kaxaon CTOPOHbI UMeeTCs Mo O4HOMY OTBEPCTUIO NS LLIEHTPOBOYHbIX
WwTngpToB. BecTaBuTb WITUMTEI B OTBEPCTUA. [1OCrne 3Toro BCTaBuUTb BUHTLI B OTBEPCTUSA
Ha CTOMKe, YTOObI 3aKpenuTb NIOTTEP, U 3aTAHYTb X, KakK NoKasaHo Ha puc. 2-3.

BuHTbI

Puc. 2-3

YcTtaHoOBKa 2-4
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GCC..

CoBMeCTUTb OTBEPCTUS Ha onopax aepxatensa pyrnoHa ¢ pe3bboBbiIMY OTBEPCTUSIMA
CTOWKMN, HAXXUBUTb N 3aTAHYTb BUHTbI, Kak MOKa3aHo Ha puc. 2-4. Pe3bboBble 0TBEPCTUSA

BbI6VIpalOTCF| B 3aBMCUMOCTU OT XeJTaeMOoro noJioXXeHnaA ornopb.bil.

Onopa gepxatena pynoHa

3 BMHTa

Puc. 2-4

MomecTuTb ABa AepxaTens pyrioHa Ha onopy u ybeamTbes, Yto 6enas BbicTynatowas

YacTb NeXuT B Nnpopesn (puc. 2-5).

™~ Hepxatens 2

My Onopa aepxarens

Jepxatenb 1
Puc. 2-5

YcTtaHoOBKa 2-5
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CHsIB ynakoBKy C AepkaTens pynoHa 2, NOBEPHYTb BUHT MPOTMB YaCOBOW CTPENKM OKOS0
Tpex pas (puc. 2.2-9).

BcTtaButb Topeu aepxatens pynoHa 6e3 aemndepa B NeByto ornopy aepxartens. 3atem
BCTaBWTb Topel, AepxaTens ¢ aemndepoM B npasyto onopy. Yoeantbcs, 4yto 6enas
BbICTYMNatoLLas YacTb NEXUT B NMPOPE3N.

YcTtaHoOBKa 2-6
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38T$|HyTb BUHT Ha /J,emncbepe TakK, YTobbl NSIOTHO NPUTAHYTb AepXaTeslb K npaBoﬁ onope.

g

[Mocne cOopKkM YCTPOMCTBO OOMKHO BbIrMAAETb, Kak MoOKasaHo Huke (puc. 2-6).

Puc. 2-6

YcTtaHoOBKa 2-7
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2.3  XoMyT U KpoHLWTEeUH Ana kabensa USB

XOMYT 1 KpOHLITENH Ans kabena USB ycTtaHaBnmBaloTCA TONMBKO B KOMMIIEKTE C NOACTaBKOM
Ans rmbkux matepuarnos.

MTEYE] XomyT ans kabens npoaeTb CBEPXY BHU3 Yepes BepXHee OTBEPCTHE KPOHLLTEHa.

OTOWN CTOPOHOWN BBEPX

[MMEY®] NomecTuThb kabenb USB B XOMyT 1 3aTsiHYTb XOMYT.

u"’(\

Kak ocBo60anNTb kaberb: BbITAHYTb XOMYT = MOAHATH 3allenky = ocrnabutb XoMyT.

YcTtaHoOBKa 2-8
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BbITSHYTb XOMYT

MogHATh 3aluernky

Ocnabutb xomyT

YcTtaHoOBKa 2-9
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2.4 YcTaHOBKa HOXa Wmpr

Ha puc. 2-7 nokasaH gepxaTerib HoXa.

HoX BCTaBnseTcs B HWXKHIOW YacTb

BHeluHee KOnbLIO /
aepxatens. [Ana nssneyeHus
HeobXx0aNMMO HaXaTb Ha LITUPT. BUMHT perynupoBku BbICOTbI /
3anpeLlaeTcs KacaTbCa OCTPUS HOXa
nanbuamu.

Puc. 2-7

BctaBuTtb HOX (puc. 2-8). [MPOTONKHYTb HOX B HMKHIOK YacTb

aepxarens (puc. 2-9).

-
Puc. 2-9
OTperynupoBaTb BbISIET peXyLLen 4acTu,
noBoOpayMBasi BUHT PEryNMPOBKN HOXa
MO 4YacoBOW UNM NPOTUB YaCOBOW CTPENKM
(puc. 2-10).
CoBerT:

OnTumanbHON BbICOTOM pexyLLlen
YacTu cunTaeTcs nessue, BoineT
kKoToporo Ha 0,1 mm 6ornbLie TONWWHbI
nneHkn. Ecnu TonuwmHa nneHkn
coctaBngaeTt 0,5 MM, BbINeT HOXa
Heobxoaumo yctaHoBuUTb Ha 0,6 MM,
4TO6bl HOX MOMHOCTLIO Npope3an
MNEHKY, HO HE MOAJSTOXKY.

YcTtaHoOBKa 2-10
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BcTaBuTb gepxatenb HoXa B kapeTky. Y6eanBLUNCE, YTO BHELLHEE KONbLIO AepxaTens
HadeXHO BXoaUT B Xenob kapeTku (puc. 2-11), 3akpenuTb KpbILWKY (puc. 2-12).

Puc. 2-11

[ns pemoHTaxa Aepatensi NOBTOPUTL Lark B 06paTtHOM Mopsiake.

M3BneuveHue Hoxa. UTOOLI M3BNEYb HOX, NoAnexawun 3ameHe, HaxaTtb Ha «lWTudT gana
M3BIrieYeHUs HoXay.

BHumMaHue!

CnycTa onpegeneHHoe BpeMs aKCrnryaTtaumm HOX yTpadmBaeT OCTPOTY; 3TO
MOXeT MOBSIMATb Ha KayecTBO pe3a. KomneHcMpoBaTtb 3TOT aPdeKT MOXKHO
yBenMYeHnem ycunus pesa. Ho ecnm HOX U3HOLWLEH U pexeT HecTabunbHo,
ero cregyeTr 3amMeHuTb HOBbIM. HOX — 3TO pacxogHbin maTepuan. YTolbl
obecneynBaTb KayecTBO pesa, ero HeobxoOUMO 3aMeHATb Tak 4acTo, Kak
notpebyeTtcsa. KayecTBO HOXa CyLLECTBEHHO BNUSAET Ha KavyecTBO pe3a. [ns
OOCTUXKEHUSA XOPOLUUX pe3ynbTaToB crefyeT MCNofb30BaTh HOXM BbICOKOMO
KayecTBa.

CoBeTtbl Korga 3ameHsAATb HOX Ha HOBbIN:
v' Ecnu Hox cnomarcs, ero cnegyet 3aMeHUTb HOBbIM.

v' Ecnu kayecTtBO pe3ku ynano, BO3MOXXHO, HOX clriefyeT 3aMeHUTb
HOBbIM.

v' Ecnu maTepuan He pexeTcs gaxe npv yBenu4yeHun ycunus pesa,
BO3MOXXHO, HOX crieyeT 3aMeHUTb HOBbIM.
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2.5 3arpys3ka maTtepuana

2.5.1 3arpyska nMcToBOro matepmana
[lnsa npaBunbHOWM 3arpy3ku matepuana
BbIMOMHUTbL NepeYnCreHHble HXKe Lwaru:

[MoaHATL ABa NPUMXMMHBIX Banvka ABYMS pbl4aramu
C TbIfTbHOW CTOPOHBI NroTTepa (puc. 2-13).

Hanoxute maTepuan Ha OMNOPHY MNAacTUHy
W NPOTOSIKHYTb €ro NoA NPWXKUMHbIE POMMKM
cnepean wunu  cboky. [Ona  BblpaBHMBaHWUSA
maTepvana Ha OMOpPHOW nnacTUHe MWMeTCS
NPUBOAOYHbIE NUHENKU (puc. 2-14).

Puc. 2-14

BpyyHyto nepemMecTuTb MPMXKUMHbBIE POSNIUKU B HYXXHOE nonoxeHue. [MpXuMHble ponunkm
OOSMKHbI HaAXOAUTbLCA Ha pelwleTyaToMm OapabaHe. lNonoxeHune peweTtyaTbix 6apabaHoB
nokasaHoO HaknemMkKkamm Ha OCHOBHOW TpaBepce (puc. 2-15).

Puc. 2-16

Puc. 2-15

Hakneiiku
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OcTopoMHO

v' poBepuUTb NPaBUNLHOCTb NOJIOXKEHUA BCMOMOraTeNbHOro
M OCHOBHbIX NPUMKUMHbIX POJIUKOB.

v/ YCTaHOBUTb OCHOBHbIE NPUXMMHbIE POZIMKYU CIpaBa U ciesa
OT maTepuana.

v' YcTaHOBUTb BCMOMOraTe/IbHbIi MPUXMMHOM PONUK NO LEHTPY

matepuana.

(0)
BEPHO

MpumeyvaHue. Ha nnntocrpaumm nnotrep Expert Il

BcnomoraTesibHbii OCHOBHOM (X)
NPUXUMHOI PONUK NPUXKUMHO PONUK HEBEPHO

OTBecTu pblyar Hazag, YTobbl ONYCTUTL NPWXUMHBbIE POSNUKK (puUC. 2-16).

BknounTtb nutaHue. Kapetka MHCTpYMeHTa aBToMaTU4eCKn onpeaennt pasMmep matepvana.
PexyLwwmnin nnotrep Ha4yHeT paboTaTb.
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MpumeyvaHne
v' PerynupoBkKy NonoXxeHusi NpoBOANTb TOMbKO C MOAHSTLIMU NPUXKUMHbLIMU
ponukamu.

v" YT106bl N3MEHUTL MOMOXEHME NPUKUMHOIO POSINKA, Er0 YAEepXKUBaoT
3a LeHTp 1 nepemMeLLaroT rno HanpasneHuo oT 3agHen yactu (puc. 2-19).

v HE NMEPEMELUATb npmXnMHOM ponuk 3a nepeaHo NPope3nHEHHY YacTb
(pnc. 2-20).

BepHo HesepHo

2.5.2 3arpyska pyfloOHHOro matepuana

Bo3MoXHO ncnone3oBaHne CTonku. HacTponka annapaTtHoOW YacTu — CM. rnasy 2.2.
3arpyska matepuana — cMm. rnasy 2.5.1.

2.5.3 Kak noBTOpHO 3amepuTb pabouyto obnactb, He OTKNYas yCTPOUCTBO?

Mpn paboTtatowem yctponcTBe HaxaTtb Origin set. Korga HayHeT mMuraTb KpacCHbIA CUrHas

ownbKKM, HaxaTb eLle pas. YCTPOMCTBO Ha4yHeT paboTaTb Ans NOBTOPOro 3amepa paboyen
obnactun. OTkpbITb Nporpammy VLCD. B pasgene Poll size 6yayT ykasaHbl HOBbIE pa3mepbl.
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2.5 KabenbHble coeguHeHUs

Pexywmnin nnottep obMeHnBaeTcst 4aHHbIMKU ¢ koMmnbloTepoM Yeped nopt USB (Universal
Serial Bus) nnu nocnepoBatenbHbin nopt (RS-232C). B atom pasgene paccmMoTpeHo
NOAKMoYeHNe NnoTTepa K OCHOBHOMY KOMMbIOTEPY, a Takke HaACTponka oOMeHa LaHHbIMU
KOMMbtoTEPA C NIIOTTEPOM.

NMPUMEYAHUE. Mpun ycTtaHoBKe coeanHeHus Yyepe3 USB nocnegoBaTtesibHbIN NOPT
OTKIMOYaeTCs aBTOMaTUYECKN.

2.5.1 UnTepcpenc USB
USB-uHTepdenc nnottepos cepumn Expert || cootTBeTCTBYET Cneumdpurkaumm yHuBepcansHOm
nocnegoBaTenbHON WNHbI Bepcumn 2.0 (NonHas CKopocTb).

2.5.1.1 NopknioyeHue pexyuwero nnotrepa GCC

1. BKNOYNTb KOMNbIOTEP.

2. MopkntounTb K ycTponctey kabenb USB. dpansep USB 6yget yctaHoOBREH
aBToMmatuveckn. O6HapyxeHne yCTponcTea 3aHMMaEeT 40 HECKOSTbKNMX MUHYT.
HE OOIMYCKAETCA otcoeamHsaTb kabenb USB oo 3aBeplieHus npouecca
YCTaHOBKM.

3. [Baxabl WeNKHYTb Ha 3Ha4yke USB Ha naHenu 3agad, yéeamBLinch, YTo
KOMMbIOTEP pacno3Has YCTPOUCTBO.

l,b Your device is ready touse % ¥

Device driver software installed successfully.

2.5.1.2 YcTtaHOBKa apanBepa
[ns ObICTPON yCTaHOBKM ApariBepa PEKOMEHOYETCA UCNONb30BaTb MIHOBEHHYHO
YyCTaHOBKY. [INs1 HACTPOWKN BbIMOMNHUTbL NEePEeYMCIIEHHbIE HUXKE Laru.

v Ecnu Ha koMmnbloTepe yctaHoBneHa OC Windows 7 u Bbilue,
B CUCTEMY BXOAUTb Yepe3 YUYEeTHYI0 3anuchb ¢ npaBamu
agMuUHUCTpaTopa.

[MEYK] BcrasuTh ycTaHoBOUHBIN Arck DVD B yCTPOMCTBO YTEHNS KOMNAKT-ANCKOB.
MNMepen Hayanom ycTaHOBKU ApanBepa yoeantbcs, 4yto USB-ycTponcTeo
NOAKMIOYEHO.

[ITEY. BLi6path 13 cnvcka apaiBepoB HyXHYH Moaenk 1 HaxaTb Windows Driver (Win 7

and Above) (Automatic Detection) nnu Windows Driver (Win 7 and Above)
(Manual Selection), ytobbl ycTaHOBUTE ApanBep n moaynb AAS.
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Cutting Platter

Win 877/ Vst | XP Driver atematic D1
Win 817 { Vista ! XP Oriver (Massal Selectiza)
g

Apparel Ploftie
_ Mogus

Plisgein Sottware

Lo

inatsll Acrobat 10.1.4

EXIT

i hagten 5 VLHICHT S0

ENENEENEORENENENENNERREE
AlFies

Tt Fesainin | minute 0 seconds

[ 1]}

fufise Installation WoardR

| [ cancel

HIETW: [1ns ycTaHOBKM gpariBepa nonb3osatensam Windows 7 v Bbilwe He0obxogmMmo
HaXaTb Ha KpaCHYIO CCbIJIKY U NMPOYECTb, KaK OTKITIO4YUTb q)yHKLI,Vll'O obHoBNEHUN
Windows Update. Haxxas OK, nepentu K cnegytoLiemy Liary.

' = ==

Windows 7 and above users please follow this
step by step instruction
to disahle Windows Update to allow succe&\

driver installation.

Thank you.

MEEE V6enmBLuvch, 4To NUTaHWE BKIIOYEHO W NMOTTEP NOACOEAMHEH K pasbemy
USB, Haxatb kHonky OK.

Flease make sure the cutting plotter is powered on Please make sure the cutting plotter is powered on
and connected to the USE device and connected to the USB device

-OK -OK

Mepen Hauyanom ycTaHOBKM NOATBEPAUTL 3aKpbITUE paboTaroLmx
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nporpamm n HaxaTb OK.
.

wy
C,!;rj-/.in
PHICS SuffSy

Itis strongly recommended that all running application programs
are dosed before you start instaling the driver

11ET{ YcTaHoBKa 3aHMMaEeT HECKONbKO MUHYT. 10 OKOHYaHMM YCTaHOBKU Ha 3KpaHe
nosiBUTCS cnegytowee coobuieHne, nog KOTopbiM HYXXHO HaxaTtb OK.
Hapgeemcs, Bam noHpasuTtcs pabotatb ¢ nnotrepom GCC!

GCC Driver Installation

Add RXI-1325 Printer driver Successfully

Em Utobbl yctaHoBuTb AASII VBA B MO CorelDRAW un Adobe lllustrator, 3akpbiTb
CorelDRAW n Adobe lllustrator n HaxxaTb kHonky Install.

.
iy GCC AAST installer le. =5

Welcome to the installer for AAS | VBA on
CorelDRAW version 11 1213 141516 17 18 and
Adobe lllustrator CS3 CS4 CS5 CS6 CC

It is strongly recommended that you exit
CorelDRAW and lllustrator program before
continuing

Install Exit

[MMEYE) Mposeputs Bepcumn CorelDRAW 1 Al B okHe Install Message, 3aTeMm LLENKHY T

Ha kHonke OK.

| coral Message
Install CorelDRAW 17.0 GCCAASII_Draw.gms successful

Al Message
AI Plug-in not find
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MpumeyaHwue:

(1) Npn noBTOPHOM yCTaHOBKE NOb30BaTEN HEOOXOANMO NOATBEPAUTD, HYXKHA
1 emy KOMus yXKe YCTaHOBEHHOrO ApanBepa.

GCC Driver Inslzllatiu:\‘h [

. The RXI-1325 driver installed
.-'JA Do you want te add an attachment?

(2) Npwu BbIGOPE onumn Yes byaeTt ycTaHOBMNEHa eLle OgHa Konus gpanseepa.
GCC Driver lnslzl@_- ‘*g

Add RX¥I-1325 1 Printer driver Successfully

(3) Monb3oBaTensam, o6HosuBwM Adobe lllustrator nnn CorelDRAW, Hy>KHO OTKPbITb
Bknagky AAS Installer B okHe CBoncTBa npuHTepa n Haxatb Install
(YcTaHoBUTB), 4TOObI NONY4YnUTb AOCTYN K nocrneaHen sepcun moayns GCC AAS.
General | Shaing | Pots | Advanced | Color Management | Secuity | Options

Pen | Paper | AAS Installer

GCC AAS Installer

Press the "Install" button to begin the
installation process

Install
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2.5.1.3 YpaneHue gpanBepa
[Mepen ycTaHOBKOW HOBOW BepCUM ApanBepa C KOMMboTepa HEOBX0OMMO NOSTHOCTLIO

yoanutb npegplayLlyto Bepcuio. MNpoueaypa yaaneHus onucaHa Hmke.

BbinonHue Control Panel > Hardware (Marens ynpasnenus > O6opyaoBaHue 1
3BYK), OTKpbITb OKHO Sound/Devices and Printers (lMpocmoTp ycTponcTs u

npuHTepoB). LLlenkHyB npaBoi KHONKOW MbilLK Ha NpUHTEpPE, Bbibpatb Remove
device (YganuTb yCTPOUCTBO).

o o= ]|

- Search Devices and Printers pel

Add a device Add a printer Seewhat's printing = Manage default printers Print server properties  » =] - @

* 87
it

@ » Control Panel » Hardware and Sound v Devices and Printers

> Devices (2)

4 Printers and Faxes (11)

i

-~ =

CUF =R A Adobe PDF Bullzip PDF

i-Craft Microsoft XPS

_KYOCERA Printer Document Writer
F5-2025D KX on
gpprinter

]

8
N

MUTOH_VC-1300 RXI-1015 HEE OneNote
2010

= e

- = See what's printing
RAT- Set as default printer

Printing preferences

Printer properties

r vy v v ¥

Delete print queue
Create shortcut

RXI-1325  Model: RXI-1325
Category: Printer Troubleshoot

w Status: 0 decument(s) in queue
-~
e

./ Are you sure you want to remove this device?

=

RXI-1325

CD

AEMNOBASI
NHNUNATNBA

www.delinit.by
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lMocne yoaneHus yCTPOWCTBA LLENKHYTb Ha JIloOoM NpuHTEpEe B OKHE 1 BbIGpaTh
Print server properties (Conctaa cepsepa nevatn) — ana Windows 7 1 Bblwe.
Ona Windows XP: wernkHyTb NpaBon KHOMKOW He Ha NpUHTEpPe, a Ha NyCTOM MecTe
B OKHe, 1 BblbpaTb Print server properties.

v Control Panel » Hardware and Sound » Devices and Printers -

Add a device Add a printer See what's printing Manage default printers | Print server proﬁrties | Remove device =

» Devices (2)

|| « Printers and Faxes (10)

e g S ) )

%\

4F EiE_HA Adobe PDF Bullzip PDF Fax Graphtec CEG000 i-Craft Microsoft XPS
_KYOCERA Printer Document Writer
F5-2025D KX on
gpprinter
MUTOH_VC-1300 RXI-1015 B3 E OneNote

2010

Mepeiitn Ha Bknagky Drivers.

T S

Forms | Ports | Drivers | Security | Advanced |

Formson:  MARKET-EILEENC

Delete

Save Form

Farm narne: 10:41

[ Create a new form

Define a new form by editing the existing name and
rneasurerments, Then click Save Form,

Form description (measurements)

Units: @ Metric () English

Paper size: Printer area margins:

’ @ Change Ferm Settings l

Cancel
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BbIGpaB HyxHyo Moaenb, HaxaTb Remove (Yaanuth).

e IR T =

| Forms | Parts | Drivers |Sec14|rrt1|r | M\ranc.ad|

;! MARKET-EILEENC

Installed printer drivers:

Name Processor Type

Adobe PDF Converter xB6 Type 3 - User Mode
Bullzip PDF Printer x4 Type 3 - User Mode
Bullzip PDF Printer xB6 Type 3 - User Made
Graphtec CEB000 xB6 Type 3 - User Mode
HP Color Laserlet 2800 5... %86 Type 3 - User Mode
i-Craft xB6 Type 3 - User Made
Microseft enhanced Poi.., 86 Type 3 - User Mode
Microsoft XP5S Documen... %86 Type 3 - User Mode
MUTOH_VC-1300 xB6 Type 3 - User Made
R¥I-1015 36 Type 3 - User Mode
RXO-1325 %86 Type 3 - User Mode
R¥II-13251 xB6 Type 3 - User Made

l Add... ] l I Remove... l l Properties

[ '@' Change Driver Settings ]

[ ok ][ Cancel

[MEYEE BLi6pas Remove driver and driver package (YaanuTb apaiiBep u nakeT apaiisepa),
HaxxaTb KHonky OK.

T

Do you want to remove the driver(s) only, or remove
the driver(s) and driver package(s) frem your system?

(") Remove driver only.

@ Removwe driver and driver package.

L3

Bbi6paTh Yes, HaxaTb kHonku Delete n OK. YcTaHoBReHHbIN Apaiisep 6yaet
yAaneH ¢ komnbtoTepa.

-
Print Server Prnperti_e“- u

/JA Deleting this printer driver package will
— remove it from the system. Are you sure
you want to delete RXII-1325_17
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Driver package information collected. Driver package deleted.

The follawing driver(s) wil be deleted: - Driver RXII-1325_1 was removed.

RXII-1325_1 (x85)

Delete

2.5.2 UnTtepcpenc RS-232
B [logkntodeHne kK nopTty RS-232 (nocnegoBaTeribHOMY)

1. Ins nonb3oBatenen IBM PC, PS/2 n coBMeCcTUMbIX YCTPOWCTB: NOAKITHOUNTD
kabenb RS-232C k HyxxHOMy nocriegosaTernibHomy nopty (COM1 nnu COM2)
rMaBHOIO KOMMbHOTEPA.

2. HactpouTb napameTpbl 06MeHa aaHHbiMu (Baud Rate (CkopocTtb 6ut/c) n Data
Bits/Parity (Kon. 6yt /4eTHOCTb)) B cooTBeTCTBUM ¢ NnapameTpamu 0. Cm. pasgen
3 — onucaHue knasuwmn Misc.

OcTtopoxHo! OTKNYUTL NIOTTEpP Nepea nogcoeamHeHmem kabens RS-232C.

2.5.3 lNepepayva gaHHbIX
lMepepaTtb OaHHbIE C KOMMbIOTEPA HA PEXYLLUIA NIIOTTEP MOXHO ABYMSI cnocobamu:

BapwaHT 1. [pn npaBunbHO HACTPOEHHbLIX NapamMeTpax MOXHO rnepeAaBaTb AaHHbIE
13 NporpaMmmbl NPSMO Ha pexyLime nnoTTepsbl.

BapwaHT 2. NpakTuyecku Bce nporpammMbl NoA4epXmnBatoT amynsaunio komaHg HP-GL
n HP-GL/2. Ecnu cann B popmate HP-GL nnm HP-GL/2, owmnbku npu BeiBOAE
Ha pexyLleM nrnoTTepe UCKMYEHbI.

YcTtaHoOBKa 2-22



GCC... Expert Il. PykoBoacTtso

2.5.4 Hactpouka obuwero goctyna
Ha komnbtotepe A-PC HacTponTb ApanBep NnpuHTepa Kak o6 NpmMHTEp, 3aTem
ucrnonb3oBaTtb koMnbtoTep B-PC ana nogkntoyveHus k npuHtepy A-PC 4epes Intranet.

A-PC B-PC
Intranet

A
/
4

USB unn COM

MTEYE] Ha komnbloTepe A-PC HacTpouTb ApaiiBep npuHTEpa Kak obLuuii npuHTep.
(LLlenkHyTb NpaBoW KHOMKOW MbILUX Ha 3HA4YKe NpuHTEpa, BblibpaTb Printer properties
(CeowictBa npuHTepa). Haxatb Sharing (O6wmi goctyn), 3atem Share this printer

(OBWwmKr gocTyn K NpUHTEpPY).

| General | Sharing |Ports | Advanced | Color Management | Securty | Option
—

./ You can share this printer with other users on your network. 1
#¥7  printer will not be available when the computer is sleeping or
off.

S

/
g See what’s printing

Share this printer
Benc : s F
= 3et as default printer | Shaenzoe. CEEETNG
Printing preferences
ap [] Render print jobs on client computers
Printer properties
[T List in the directory
Create shortcut
Drivers

Troubleshoot If this printer is shared with users running different versions of
# . Windows, you may want to install additicnal drivers, so that the
T = Remove device users do not have to find the print driver when they connect to tl
Jagua shared printer.

Prﬂpertles Additional Drivers...
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[MMEY®.) Ha eknagke Advanced BeiBpaTs Print directly to the printer.

e
—

| | General I Sharing | F‘urtl | Advanced Malur Management I Security I Option | Paper |
_

i@ Always available

() Awvailable from 12:00 AM Ta 12:00 AM
Pricrity: 1 E
Dirier: ’ Bengal-80 v] ’ Mew Driver...

i) Spool print documents so program finishes printing faster
Start printing after last page is spooled

(@ Start printing immediately

i@ Print directly to the printer§

[ ]Held mismatched documents
[ ] Print spocled documents first
[ Keep printed documents

[ Enable advanced printing features

HIETg OTnpaBuTb 3agaHne ¢ komnbtotepa A-PC Ha yCcTponcTBo, YTOObLI NPOBEPUTD,
NOAKITOYEH NN K yCcTponcTBy koMnbtoTep A-PC.

¥ CorelDEAW 11

W CorelDRAT X4 (2)

L ST S T,

Expert24 LE

OTtnpasuTb
3a/laHue, YTobbI

npoBepuTb
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MEYE AkTvBMpoBaTh ApaiiBep npuHTepa Ans komnbiotepa A-PC yepes ceTb B-PC.

4 €l Network
> (8 ADMIN-ANITAY!
> (8 ADMIN-ELAIN
> (M ADMIN-HR

> (M ADMIN-JULIA T
- 8 Al BERTTHINK ‘Ej Bengal-6
8 CBAD30003

> 8 CBA050033 7 ==
> % CBAOB0019 ‘gg

MpaBoit KHOMKOW MbILLI LLEMKHYTb Ha 3Hauke NpuHTEpa U BbIGpaTh Connect
(Mogkntounte) Anga npuHtepa A-PC.

7=
—I Connect... I

)

l Create shorteut

2.6 YcTaHOBKa nporpamm

2.6.1 YcrtaHoBka GreatCut

MTEYE] Ha ycranoBouHoM auncke BbIGpaTh onuuio GreatCut Registration.
Ha Beb6-canTte http://gccvoucher.eurosystems.lu/ BBeCTU KOA C KyrnoHa,
nonyyeHHoro npu nokynke GreatCut, n Haxatb Go on!

Apparel Plotter

Plug-in Software % e e
G ; 'ou must en voucher
e, Dnline‘wgistration code and complete the online
Install Acrobat 10.1.4 FRE R/ e registration in order to get a
license code for Greatcut.

User Manual

www. G CCworld .com
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Great Computer Corp. Software Voucher Code “c Gre—ojt CU':

VErL T
| el

Please enter your voucher code completely and accurately as it stands on the voucher.

Voucher Code [KGCC-XH00K-KXXXA-00H-000] |

Go Onl >

In case of problems or questions M can reach our technical support over tech support@agec. com tw.

[Homepage Great Computer Corp. |

[ITEY# KHonkoit Request (3anpoc) nepeiiTn Ha CTpaHuLy perucTpaumu.

Great Computer Corp. Software Voucher Code “c G‘E/!; CUI:

You are holding in your hands a software voucher for a full license of GreatCut 3.
In order to receive the free of charge license code and download GreatCut 3, please use the following button:

License code for new full license \M\

[Homepage Great Computer Corp. |

[ITEYEE BeecTu HysxHyI0 MHOPMALMIO 1 LLEMNKHYTL Ha kHomke Request license code
(BanpocuTb KO4 NUUEH3NN).

Software Download GreatCut 3
tGy
Great Cut
Software Registration
Last name, first name: [Eileen Chen ! 1 Required fields
Would you plesse use Latin re: Vest-Eurcpesn characters! "
Company: |GCC
Street: |4F-1, No 235, Fude 2Znd Rd., Xizhi D\st i
PO box:
City: INew Taipei City I
State/Prov.: [_onl\f LS and Canada) v
Zip (postcode): 22151 i
Country: | Taiwan A !
Phone: (886266165692 |
Fax: N
eMail address: |ei|een.chen@gcc.cum.tw !
Impaortant: Pay attention to r ellail address comactly,
because licenss =t to this addrass!
Request license code

MEE Pervctpauus 3aBepLueHa. Mo anekTpoHHoN noute 6yaeT oTnpaBneHo Aga
COO0BLLEHNS: NepBOE C NOATBEPXAESHNEM PErCTPaLIMM W CChIMKON AN akTUBaLmK,
BTOpPOE — C [AaHHLIMM NMNLIEH3MN B dhopmarTe .ecf.

Registration Successful

Thank you, that you decided for GreatCut 3.

An email with further information for GreatCut 3 was sent to the given email address (eileen.chen@gcc.com.tw). Please be
patient, as it may last up to 30 minutes until you can receive this email.

If you dont receive an email, please fill outthe form on geocvoucher. eurosystems U again with a working email address

[Home Great Computer Corp. )
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MEYEY Haiitn cobinky ans akTueBaumm B NoNy4YeHHOM NUCLME U NepeiiTh No Helt Ansa 3arpysku
Great Cut.

BHE: tech.support@gee com. b
W= eileen.chend goo com.tw
Eil

== GreatCut 3 - Activation Link

Dear Customer,

thank vou, that vou decided for GreatCut 3.
Please click the following activation link or enter it in vour web browser:

http:/gccvoucher. eurosvstems. lu/activate.dml id=128461259209629vul FOOa K eRlh(,
eatCut 3

After clicking the link, vou immediately will get download links and license data for Gr

If vou have questions, vou can reach our support over tech support(@gcc.com.tw.

Best regards
Great Computer Corp.

MBS BuiGpats Install GreatCut us meHio ycTaHoBO4YHOrO Aucka DVD.

Apparel Plotter
Uy
Plug-in Software o o A T
GrestOt ) FTI|< code and complete the online
Install Acrobat 10.1.4 [FEH [ F skl | registration In order to get a
EXIT User Manual i license code for Greateut.

www. GCCwaorld com

11ET( Ykas3aTb nanky Ans yCTaHOBKM.

Blowse:

InstallShizld < Back I HETE Cancel
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MTEYE VcraHosuBe nepeknioyatens Typical (CTaHaapTHas ycTaHoBKa), HaxaTb Next.

MpumeyaHue. [Ina ycTaHOBKM OONOMHUTESNbHBIX ApaniBepoB BbibpaTb Custom
(Monb3oBaTenbckas ycTaHoBKa).

InistallShield < Back Mext > Cancel

MEYE) YkasaTb HyHyto nanky v WenkHyTb Ha kHomke Next.
Manka gns yctaHoBku no ymondanuto B MeHto NMyck: GCC/GreatCut 3.

Admiristrative Tools
ASUS Uty

Bulzip

Catalyst Cantrol Center
CorelDR&W Graphics Suits %7
Craft Edge

Evpress Gate

Games

Google Earth Pro
[Zhre

Java

InstallShield < Back Nest > Cancel

MEYEL) NMporpamma GreatCut ycTaHaBnMBaeTCs Ha KOMMAbIOTEP.

Setup Status

Instal]Sield
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MEYEE] 3aBepLumnthb ycTaHoBKy WenykoM Ha kHorke Finish.

< Back ] Finish Cancel

MMEYEF! He 3anyckas nporpammy GreatCut, oTKpbITh (haiin .ecf, NPUNOXeHHbIN K NMCbMY
C @aHHbIMM Mo NnLeH3un. Heobxoanmas uHopmaLms 6yaeT aBToMaTUyeckm
nobaeneHa B GreatCut, n ee He npuaeTca BHOCUTb NOBTOPHO.

e RCE-OMLINE =directdovonload @enrosystems u=
W - eileen.chen@gee.comm. by

El=

== GreatCut 3 - Receipt and License code

[ HEAE | |_]GC16P-1867.ecf (273 B)

GCC> Great Gut

1. Please print this eMail.
2. License data for GreatCut 3

The following license code will be activated by copying or saving the att:
use.

For a possibly necessary manual input, here the license data (green) again

Company / Name: GCC

eMail: eileen_chen{@gcc.com. tw
Code: GCl1eP:

Number of Licenses: 1

Serial No.: GC16P-1867

IS Live Update: — u\

License installed successfully.

| |

YcTaHOBKa
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MEYEE Ecnu nuueHsnio ycTaHoBUTL HE yAANoCh, NOMA 3arnoMHAKT BPYUHYHO.
Bcst HyxHas MHAOPMaLMA HAaXOAUTCS B 3NEKTPOHHOM COOBLLIEHNN.

License data:

(558

Note:

Please fill out the fields of the license dats exactly as you
recelved it.

Company { name:
[

eldadl:

|keira lee @grc com.tr
Code:
|EGCC-
Swrstern tnformeation PIN:

| |3666223328-0-9-1-57-MARKET-KEIRAZ

0K | Comcel |

FHEE RCE-ONLINE =directdounlosd @evrosystems =

FHHEME: 2015/2/25
WS eileen chen@gec com .ty
ElF:
=5:  GreatCut 3 - Receipt and License code

{{RE | |GC16P-1867.ocf (273 B)

The following license code will be activated by copying or saving the attached file to the computer and starting it via double click. Thus the
activation is done fully automatic and GreatCut 3 is ready to use.

For a possibly necessary manual input, here the license data (green) again in plain text:

Company / Name: GCC

eMail: eileen.chen@gce.com. tw

Code: GC16P- )
Number of Licenses: 1

Serial No.: GC16P-1867

MEYEY NMporpamma GreatCut rotoea k pa6oTe.

GreatCut 3

GreatCut 3
Version 16.0

Copyright ¢ EuroSYSTEMS 1991-2014

2.6.2 YcrtaHoBKa Sure Cuts A Lot (npunobGpeTaeTcs JONONTHUTENbBLHO)

2.6.2.1 ABTOMaTM4ecCKasi ycTaHOBKa

MTEYE] BcrasuTh ycTaHoBOYHBINM Avck DVD B yCTPONCTBO YTEHWS| KOMNAKT-AVCKOB.
Mporpamma coBmecTtuma ¢ Windows 7 1 Bbiwe, Macintosh OSX 10.6 u Bbliwwe.
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[MTEY¥. [1ns sanycka ycTaHoBkm BbIGpaTh Sure Cuts A Lot.

MEYE [ns npopomkeHust HaxaTb kHomky Next.

15! Setup - Sure Cuts A Lot 4

L] @ =]

Welcome to the Sure Cuts A Lot 4
Setup Wizard

This will install Sure Cuts A Lot Pro 4.005 on your computer.

Tt is recommended that you dose all other applications before

continuing.

%}1@9 GU‘ Gb;

Click Mext to continue, or Cancel to exit Setup.

MEYE VcranosuTh hnaxok | accept the agreement (MpuHMMato cornatuenune)

n HaxkaTb Next.

i5! Setup - Sure Cuts A Lot 4

License Agreement
Please read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

Craft Edge Inc
End User License Agreement T

Please read this License Agreement carefully before proceeding. This Agreement
licenses Software to you [either an individual or single entity] from Craft Edge and
contains warrant and liability disdaimers. By instaling, copying or otherwise using
this Software, you are confirming that you have read and understand this
Agreement and agree to be bound by the terms of this Agreement. If you do not
agree with the terms of this Agreement, you should not install or use this
Software.

()1 do not accept the agreement

<Back | Next>‘Q Cancel |

45 Setup - Sure Cuts A Lot 4

Information
Please read the following important information before continuing.

When you are ready to continue with Setup, dick Next.

(Craft Edge
Sure Cuts A Lot 4.0 Read Me ¥

1. General Information L
Thank you for choosing Sure Cuts A Lot. Sure Cuts A Lotis an extremely easy 3
lprogram to cut virtually any shape with your electronic cutting machine. Cut
TrueType fonts, SVG files, images, & even draw your shapes giving you endless
Ppossibilities!

- Works with your installed TrueType & OpeniType fonts on your computer

- Works with Bosskut Gazelle, Black Cat Cougar /Lynx, Craftwell eCraft, Pazzles
Inpsiration, Silhouette SD/CAMEO Portrait, Silver Bullet, USCutter, & more.

- Import various files formats, induding SVG & POF

- Drawing tools to draw and edit sahpes

- Weld overlapping letters and shapes together

< Back ][ Next>ﬂ Cancel

MTEYEE MpuHATL NPeanoXeHHyY Mo YMOMYaHMIo Nanky yCTaHOBKM UK BbIGPaTh Apyryto
nanky Ans ycTaHoBKM U HaxaTb Next.

5/ Setup - Sure Cuts A Lot 4

Select Destination Location
Where should Sure Cuts A Lot 4 be installed?

I Setup will install Sure Cuts A Lot 4 into the following folder.
Program Files (x86)

aft Edg e Cuts A Lot 4]

At least 50.9 MB of free digk space is required.

To continue, dick Mext. If you would like to select a different folder, dick Browse.

Browse...

< Back ][ Mext = Q Cancel

AEMNOBAS
NHNUNATNBA

www.delinit.by

YcTtaHoOBKa
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MG 0ns cospaHus 3Hayka nporpaMmbl Ha paboyem cTone, YCTaHoBUTL driaxok Create
a desktop icon. YUToOblI NO ymonyaHuio OTKpbIBaTh hannbl C paclumpeHmem scutd
nporpammon Sure Cuts A Lot, yctaHoBUTL (pnaxok Associated scut4 extension.
3anycTuTb yCTaHOBKY, HaxaB Next.

15 Setup - Sure Cuts A Lot 4

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing Sure Cuts A
Lot 4, then dick Next.

Additional icons:

File extensions:

Assodate "scut4” extension

[ <Back ][lgsw | [ cancel

18) Setup - Sure Cuts A Lot 4 [ = [l = [ || [j5! setup - Sure Cuts A Lot4

Ready to Install
Setup is now ready to begin installing Sure Cuts A Lot 4 on your computer.

Installing
Please wait while Setup installs Sure Cuts A Lot 4 on your computer,

Click Install to continue with the installation, or dick Back if you want to review or Extracting fles...
change any settings. C:\Program Files (x86)\Craft Edge'Sure Cuts A Lot 4\Hints\style.css
Destination location: -
C:\Program Files (x85)\Craft Edge\Sure Cuts A Lot 4 L S——

Additional tasks:
File extensions:
Assodiate "scut4” extension

4 [

< Back Install j Cancel

He cnepyeT yctaHasnueaTh drnaxok Install USB Driver (YcTaHOBUTL ApaiiBep
USB). YctaHoButb chnaxok Launch Sure Cuts A Lot (3anyctutb Sure Cuts A Lot)
N 3aBepLUNTb YCTAHOBKY KHOMKOW Finish.

15 Setup - Sure Cuts A Lot 4 [ @ | &=

Completing the Sure Cuts A Lot 4
Setup Wizard

K Setup has finished installing Sure Cuts A Lot 4 on your
computer. The application may be launched by selecting the

I U:{)Q,G» . f. installed icons.
% A\“()YJ# Click Finish to exit Setup.
[7] install USB Driver

Launch Sure Cuts A Lot
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MEE 3anyctuTs nporpammy Sure Cuts A Lot.

Vanion 4006
Croymaht 2014 ol Edmedaz = v v e e, |
All Righty Emtid

B [ns aktuBaumn nporpammbl Sure Cuts A Lot HaxaTb Activate... MpeaapuTensHo
cneayeT y6eaMTLCA B HanNMuumM JocTyna k IHTepHery.

Sure Cuts A Lot 4 Demo Mode

“Sure Cuts A Lot 47 will run in Demo Mode until the software is activated
with a purchased License key.

In Demo Mode:

- The software will cut horizontal lines through your design as a
DEMO watermark.

- You can browse and purchase designs from the eshape Store,
but will not be able to download to use them.

‘You can purchase a license at
hittpeituaew crafted ge comdpurchaze feal

[hanae..

Ok ]

MEYEL Vkasats umsi B rpacde Name u BBecTu B none Serial (CepwiiHblit HOMEp) koA, 13
25 cumBOMnoOB, YKasaHHbIM Ha obnoxke aucka DVD. 3aBepwnTb akTuBauumto

kHonkon OK.

Activate Sure Cuts A Lot 4... (==

Please enter wour Mame and Serial

Mame: [aCc

Serial: [i 1083-92243]

[ Activate mamually Cancel 84

If wom are wnable to activate, check the Letivate manvally optinn, and wisit
hitp it crafted ge comiactivation to obtadn your Activation code.

hittpetfaewew crafted ge comiactivation/seal

Activation...

'0' Thank you for activating the software,
-

If you need to move the software to a new computer, you can choose
to Deactivate under the Help menu (Requires an Internet cennection).
Uninstalling the software frem a computer does not automatically
deactivate it.

YcTtaHoOBKa
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MEYEE] Mporpamma Sure Cuts A Lot rotoea k paboTe.

+ | Sore s A Lot et ==
Fie ldt Cbies Puth Loyw Page Uiechh Tt View Cumw iedow My

Iyl B 8 EE

MpumeyaHune
v' Ecnu ons BbiBOAa M300paxkeHui ncnonb3yeTcsa NnpodHas Bepcus
(He BBeaeH koY Ans aktueaumm nporpammbl Sure Cuts A Lot, kak onucaHo
BbILLE), NSIOTTEP NPOPEXET HA MaTepuane ABe NULIHME NHMK. [1o oTnpaBku
dannoB Ha pe3Ky Heobxoaumo ybeauTbes, 4To nuueHsunsa Sure Cuts A Lot
aKTMBUPOBaHa.

2.6.2.2 AKTnBaums NnporpaMMHoOro o6ecnevyeHusi Bpy4Hyro

Ecnu Ha komMnbloTepe, NOAKMIOYEHHOM K NAOTTEPY, OTCYTCTBYET AoCcTyn K IHTepHeTy, aAns
3aBepLUEHNS aKTMBaL MK U paboTbl C NPOrpamMmmMon MOXHO BbibpaTb Activate manually

1 BBECTU KoL akTuBaumn. [ina atoro cnefyeT HaMTM KOMMbOTEpP € AOCTYNoM K IHTepHeTy
W 3apaHee nonyYnTb Ko akTuBauuu, cneagys UHCTPYKLUN HUXeE.
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YcTaHoBuTh chnaxok Activate manually, 4To6bl BoIBECTY Ha akpaH nons Site Code
n Activation Code. B none Site Code yxe ecTb faHHble, KOTOPblE HEMb3s
N3MEHUTD.

Activate Sure Cuts A Lot 4... [=2a]

Please enter your Name, Serial and Activation Code.

Nane: [k
Hertal: [G9212-01
Bite Code: |62920-43822-24190-41812

Activation Code: I

[V] Activate manually Cancel ] [ (0):4

If wou are unable to activate, check the Activate manvally option, and visit
http:fhuesew crafted ge comdactivation to abtedn wour Activation code.

Tittpeffuaew cradted ge comdactivation/eal

[TEYF. Ha komnbloTepe ¢ AOCTYNOM K VIHTEPHETY OTKPbITL Be6-CTpaHuLLy
http://www.craftedge.com/activation/surecutsalot . BBectn nms, cepuinHbln Homep
(krtou nporpammHoro obecneveHnst ¢ 0bnoxkn aucka DVD) n kog canta (Site
Code).

[MTEYE Mo wenuky Ha kHonke Generate Activation Code (TeHepupoBaTh koA akTMBaLMK)
B none Activation Code nosaBuUTca Ko akTMBaLUN.

Activate "Sure Cuts A Lot"

1
|
|
i
Important: You only need to do the following if you are having trouble activating from I
within "Sure Cuts A Lot" or do not have an Internet connection on the computer you are ;
trying to activate on. |

|

I

I

You must activate in order to use the full version of the software. Generally, you will just
need to choose Activate.. from the Help menu in Sure Cuts A Lot and enter your name and |
serial number. The software will try to activate automatically and you can disregard this
web page. Do not use this web page if you have not installed the software yet or have not
purchased.

If you view the About box in Sure Cuts A Lot and it shows your name and serial number,
the software is activated ok.

If you have problems activating automatically, you must use this web page and generate E
an Activation Code. The Name and Serial information is obtained from your purchase
confirmation e-mail. The Site Code is obtained by running the program and choosing E
"Activate..” and checking the "Activate Manually” option.

Name k |
Please enter your full name ;

Serial 71184-045 10
Must enter with the dashes (example: 12345-12345-12345-12345- ;

12345)

Site Code | 20000000 I000X-000X ‘
I

| Generate Activation Code |

After entering in your Name, Serial, and the Site Code, click the Generate Activation Code |
button to create your Activation Code. Copy and paste the value back into the "Activation” |
dialog box in the application to activate your copy. |

If you experience problems generating your Activation Code, please see our FAQ. I

MTEIE Kon akTvBaLmn HEOBXOAMMO CKOMMPOBATL W BCTABUTL B IMArNOrOBOE OKHO
aktmBauum Sure Cuts A Lot, 3atem noatBepanTb kHonkon OK,
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2.6.2.3 lNoBTOpHan yctaHoBKa Sure Cuts A Lot

B cnyyae 3ameHbl KOMNblOTEPaA MOXET NOTpeboBaTbCs AeakTMBALMA NPpOrpaMmbl
Sure Cuts A Lot c noBTOpHOM yCTaHOBKOW Ha HOBOM YCTPOWNCTBE.

[nsa atoro sbinonHUTL Deactivate... n3 meHo Help n noatBepanTb encTBME KHOMKOW Yes.
3aTtem nporpamMmmMy yCTaHaBfIMBaKOT Ha HOBOM KOMIMbIOTEPE U aKTUBUPYIOT C NOMOLLIbIO
TOro Xe Kopaa.

7 Sure Cuts A Lot 4: Untitled
File Edit Object Path Layer Page Effects Text View Cutter Window
About Sure Cuts A Lot 4.
Help F1
Online Forums
Online Video Tutorials...
Install Driver...
Support 3
Register Product
Check for Updates
Deactivate... I
a
W —
ﬁ Deactivate 3

l- o Are you sure you want to deactivate the software?

Deactivating will allow you to re-install on a different computer.
(Requires an Internet connection)

Yes Mo
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‘ Paspgen 3. 9kcnnyartauus

3.1 NaHenb ynpaBneHus

3.11 Cxema naHenwu ynpasneHusi

~ R
POWER  OWOFF LINE  PALIS FI:EF'EAT DATA CLEAR CUT TEST ORIGIN EETO O
\ : v,
Puc. 3-1
AnemeHT DYHKLMSA
LED-MHONKATOP OnoBeLLeHne 0 COCTOAHUN (MHONKATOP FOPUT: NUTaHWE BKMOYEHO; NHAMKATOP
MATAHUA POWER He ropuT: NMUTaHWe OTKYEHO)
MHONKATOP OLUMBKW | OnogelueHne 06 owmnbke (MHANKATOP rOpUT: OLWMOKa; MHOMKATOP He FOpuT:
ERROR Hopma).
ON/OFF LINE MepekntoyeHe pexxMMoB U OCTAHOBKM 3adaHust (MHOMKATOp ropuT: paboTa;

WHAVKaTOP He ropuT: oxuaaHue). B pexvme paboTbl 4OCTYMHBI TOMBKO KHOMKM
ON/OFF LINE n PAUSE. B pexvmMe oxXugaHust MOXHO perynnpoBaTtb HaCTPOWKK
yepes 10 VLCD.

PAUSE lMpuocTaHoBka 1 BO30OHOBMNEHUE PE3KMU.

REPEAT lMoBTOp NocnegHen paboThbl.

DATA CLEAR Ouunctka bydpepa namaTu.

CUT TEST lMpoBepka pe3a Ha pasnuyHbIX MaTepuanax.

ORIGIN SET HacTpolika HOBOro NosioXXeHNsa UCXOOHON METKMU.

4 knaBMLLKN CO CmeHa NonoXeHusi KapeTku, BbIGOp PYHKLMN 1 M3MEHEHUE HACTPOEK.
cTpenkamm

3.1.2 NepeHacTponKa UICXOAHOWN TOYKMU

NMpumeyaHue.

v' Tepepn aktuBaumen yHKLMN yoeamTech, YTO YCTPOMCTBO HAXOAUTCH
B peX1Me OXuAaaHuS.
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ITEYE] MepemecTute KapeTky B HOBOE NONOXEHME.

MEYF) Haxxmute kHonky ORIGIN SET, 4Tobbl 3aaTh HOBYIO MCXOZHYHO TOUKY.
3.1.3 TecToBbIN pe3

NMpumeyaHue.

v' Yb6eauTechb, YTO YCTPOMCTBO HAXOAUTCS B PEXMME OXUOAHUS.

v' Tepepn Ha4anom peskn pekoMeHOYeM HECKOSIbKO pa3 BbIMOHUTL
TECTOBbIN pe3, Noka He ByaeT NoNyYeHO HY>XXHOE KavyecCTBO.

[ITEYE] Mocne cHsTUA pasmepoB nepeBecTy YCTPOICTBO B PEXMUM OXMUOAHNS KHOMKOIA
ON/OFF LINE.

MMEYF] NepensuHyTh KapeTKy B HY)XHOE MONOXEHVE.

MMEYE HaxaTtb kHonky CUT TEST.

3.1.4 [NoBTOP

MpumeyaHue.
v’ YbeguTecb, YTO YCTPOMCTBO HAXOOUTCS B PEXUME OXMAAHMS.

MTEYE] NepesecTtt ycTpoiicTBO B pexum oxuaanust kHonkoit ON/OFF LINE.

M HaxaTb kHonky REPEAT 1 3anycTuTb NoBTOpHOE onpeaeneHune paboyen 30Hbl,
Ha4yMHasa ¢ MECTOMNONOXEHNSA KapeTkn. [lonyckaeTcsi nepemMecTUTb KapeTky
B HY)XHO€E MOSoXeHne, 3a4aTb HOBYH UCXOOHYHO TOYKY U MOCNe 3TOro
aKTMBMpPOBaTb AaHHY (PYHKLMIO.
3.1.5 lNoeTop 3agaHusa AAS
DyYHKLUMA NO3BONSIET aBTOMATUYECKN NOBTOPATh 3agaHnsa n3 AAS 6e3 oTnpaskm
C KOMMbloTepa.

[MTEYE] Mocne 3aBepluienns nepeoro 3aganns AAS HaxaTb «Repeat» Ha naHenu
yrpaBreHust Anst akTMBaLMU yHKLMM.

MpumeyaHue.

v' BHuMaHue: pyHKUumMA 0ObIYHO NpUMEHSieTCA ANg pexuma Gymaru
Single. Nepea HaxxaTneMm kKHoMkn Repeat ydeantbes, UTO 3arpyxeH
HOBbIV MaTepuan n B Ka4eCTBe UCXOQHOM TOYKU 3aiaHa nepBas
NPMBOAOYHANA MeTKa.
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3.2VLCD

VLCD — komMmnbloTepHada nporpamma Anis UsMeHeHusi napameTpoB (PyHKLMI pesa.
3.21 YcTtaHOBKa
MTEYE] 015 ycTaHoBkuM ckonupoBsaTh dhaiin VLCD.exe 3 nankv Accessories

Ha yctaHoBo4YHOM DVD-gucke Ha nokasibHbI KOMMNbIOTEP.

MEYF. 3anycTuT VLCD ABOMHBLIM LEMNYKOM Ha 3Hauke NporpaMMbi.

NMpumeyvaHwme.

v' Tlepepg 3anyckom nporpammbl y6eauTbesl, YTO YCTPOMCTBO HAXOAMTCS
B PeXrMe OXUAaHWS.

v/ B ycTpoWicTBe Haxoautcs MaTepuan.

m BbibpaTb NOpT NogKMYEeHUs K KOMMblOTEpPY (puc. 3-2).
Mpun ncnonb3osaHun kabena USB 13 packpbiBatoLierocsi MeHo BolbpaTb Ha3BaHue
Mmoaenu. [pu ucnonb3oBaHuKn Kabensa nocriegoBaTernibHOrO MHTepdenca BbIbpaTb
COM1 unn COM2. Y6eouTbCs, YTO K HY>XHOMY MOPTY He MOAKIYEHbl Apyrue
ycTponucTaa.

MBI HaxaTb kHonky Connect, 3anycTB 06MeH AaHHLIMU MeXIY KOMMbIOTEPOM
n NNoTTepom. B cnyvae ycnewHoro nogknio4YeH1st Ha aKkpaHe NosiBUTCS
MHdopMauusa o mogenu, sepcumn sBctpoeHHoro MO 1 HacTpanBaembix
napameTpax (puc. 3-3).

W.mm | & vicozvaoao2 S5
y 4 A Y > -
| «|\ Connect Mod?l: |Expert 1124 LX i xfodfal:Expert 124 LX
xpert I 24 LX Version: lersion:3.04-14
tting | Adjust Setting | Adjust |
Paper Length (X) 0 mm Paper Length (X) 24837 mm
Paper Width (Y) 0 mm Paper Width (Y) 141625 mm
Blade Force 0 g Blade Holder Blade Force » g Blade Holder |Plastic  ~
[« 1 i
Blade Offset Blade Offset 0 - |mm
Media Type Media Type Roll
Media Weight Media Weight Light ~
Auto Unroll Auto Unroll Disable ~
Vector Quality Vector Quality Fine -
Vector Smooth Vector Smooth  |Disable -
Unit mm/g Unit mmig -
| | Update | Read Parameters |
Puc. 3-2 Puc. 3-3
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3.2.2 ®yHkumn VLCD

Hwxe nepeuncnenbl pyHkumm Expert Il gns ynpaenexus yepes VLCD:
3amep paboyen obnactu

Ycunue pesa

[epxaTenb HOXa

[MnoTHOCTbL MaTepuana

CwmelleHne Hoxa

CwmelgeHune AAS

ABTOMaTMyeckasi pa3amoTka

O6HoBneHne

m |Poll Size (3amep paboueii obnacTm)|

[nsa 3amepa n otobpaxeHns . 3
N VLCD3 V2.04-02 =5
3HayeHnn X/Y. @
Expert Il 24 LX - Model:Expert Il 24 LX
| : J 4 Version:3.04-14

B maHHOM crnyyae makcumarnbHasda Setting \ﬂdjustl
AnvHa pesa coctasngaeT 25 000 mm, Paper Length (X) 25000 mm

Paper Width (Y) 158.975 mm
paccTtoaHne mexay nsyma Hanbonee

Blade Force 3B g Blade Holder |Plastic -
yaaneHHbIMN Npu>XMMHbIMU ﬂ J ﬂ
ponukamu — 158,975 mm (puc. 3-4). Blade Offset [0 <|mm

Media Type Roll

Media Weight Light -

Auto Unroll Disable -

Vector Quality Fine -

Vector Smooth  |Disable ~

Unit mmlg -

Update ‘ Read Parameters |
Pwuc. 3-4

m |Blade Force (ycunve pesa) |
Perynuposka ycunusa pesa B gnanasoHa ot 0 go 350 (no ymonyanuio = 35).

Mpumeyanue. lNpu rpacdonocTpoeHnn Nepom ycunme pesa yCTaHOBUTb HA MUHUMATrbHOE
3Ha4eHue. ITo No3BoONseT u3bexaTb CTePTbIX IMHUIA N NPOANAET CPOK Cryxbbl nepa.
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m |Blade Holder (nepxatens Hoxa)
Bbibop aepxatenst Hoxka — nNnacTMaccoBoro (Mo YMOYaHUI0) UM MeTanMM4eckoro.

m Media Weight (nnotHocTs MaTepuana)
Bbi6op 04HOro 13 ABYX BApUaHTOB: TSXKEMbIA UMW NErkMi (MO YMOMYaHMUIo).

m |Blade Offset (cmeLLeHMe HOXa)|
PerynupoBka cMmeLLeHnsa Hoxa ansa obecneveHust kayectBa pesku. 8 sapmaHTtoB: 0,000;
0,175; 0,250 (no ymonyanuo); 0,275; 0,300; 0,500; 0,750 1 1,000.

m |AAS Offset (cmelleHve AAS)|

HacTtponka n nameHenue cmeweHna AAS.
MogpobHee cMm. «5.3. TecTupoBaHue neyaTny.

£} VILCD3 v2.04-02 %

[Expert I 24 LX - Model:Expert Il 24 LX

Version:3.04-14

Seﬂing .ﬂdj ust ‘

S5TEP1
Draw a square for testing

Length (X} 500.0 mm

Scaling Test

Width (Y) 500.0 mm

STEP2
Measure and enter the actual output

Length (X) |500.0 mm
Width (Y) [500.0  mm

AASII Offset Function

AASI Offset Update

m |Auto Unroll (aBToMaTuyeckas paamotka)|

MNepeknoyeHe Mexay NMMCTOBLIMU U PYNIOHHLIMU MaTepuanamu (Mo YMOMn4YaHuio
BKITHOYEHO).

m |Update (06HOBNEHME)]
[N NPUMEHEHNSI N3MEHEHHbIX HAaCTPOeK MroTTepa HaxaTb kHonky Update.
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3.2.3 Copoc Ao 3aBOACKMX HACTPOEK NO YMOJNYaHUIO
B nporpamme VLCD npegycmoTpeH cbpoc Bcex NnapaMeTpoB MEHIO 40 3aBOACKMX HACTPOEK.

[MTEYE] Boiitn B pexxum nepeknioverust nopta USB, nepekntoumne pesxum: On/Off line( 1) >
Pause (2) > Origin Set (3).

oo M e ° °

PAUSE

[TEYE 3anyLueH pexum OUUCTKU 1 BOCCTAHOBMEHWS AaHHbIX MO YMOYaHMIO.
Haxatb Data clear (6), noarBepanTtb kHonkown Origin Set (7).

B ke e LY ® [EIEEE
[OFFNE  PAUSE REPEAT  DATACLEAR  CUTTEST  ORIGIN SET

MMEY Mpouecc BocCTaHOBNEHMS HACTOEK NO YMOMYaHuWio 3aBepLueH. MnoTtrep
nepesarpyaeTcsi, O3TOMY HUKaKMUE KHOMKU He JeiCTBYIOT.

MEYEE Tenepb NNoTTEP MOXHO CHOBA BKIKOYUTD.
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3.3 3arpy3uuk cdaunosn

3.3.1 YcTaHOBKa

v WHctpymeHT File Uploader npegHasHadeH ansa 3arpy3sku pannos ¢ OTnpaBKon
3aaHnsA HanNpsIMyto.

v [porpamma nogaepxusaet TOJIbKO dainnsl popmata HPGL, cosgaHHble Yepes
Apansep pexylero nrotrepa GCC.

v [ns yctaHoBku ckonvpoBaTtb ¢ann Uploader.exe n3 nanku Accessories
YCTaHOBOYHOro KomnakT-gucka Expert |l Ha nokanbHbIN XECTKUN OUCK.
v 3anyctutb VLCD [BOMHbIM LLENTYKOM Ha 3Ha4Ke nporpaMmmsbl (puc. 3-5).

. BCC File Tploader ' Setup Form
Cam Part Sefting

Select a Download File [~ FRepeat

Baud Rate : sl

3 3 )

Dta Bits | ® hd

[COM1 v | Port setup Repeat Counts Paiy: e 3]
=1 )

Process 0 1 = Stop Bits : [1 -

Loading M Flow Cantrol {Haidware =
o = n

Select a Port

|FiIeName Browse Fepeat Delay

Start || Cancel Exit |

0k Cancel
Puc. 3-5 Puc. 3-6

3.3.2 dyHKummM 3arpysumka dannoB

m |Port setup (HacTpoiika nopta) |
V' ®yHKUmMs akTMBUpyeTca npu Boibopa COM nopta aons nepegayv AaHHbIX.
v" Haxatb kHonky Port setup. OTkpoeTcs OKHO HACTpPOWMkM NapameTpoB (puc. 3-6).

m Repeat (MosTop)|
v' [nsa akTMBauumn yctaHoBUTb chrnaxok Repeat.
v" Repeat Delay — 3agepxka mexay 3agaHnusMun, eguHuua: cekyHaa.
v" Repeat Counts — kon1M4ecTBO NOBTOPOB 3a4aHus.
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3.4 lNepepaya AaHHbIX

MepeaaTb faHHbIE C KOMMbOTEPA Ha PEXYLLUMIA NNOTTEP MOXHO ABYMS crocobamu:
BapuaHT 1. Mpu npaBunbHO HACTPOEHHbIX NapaMeTpax MOXHO NepeaaBaTh AaHHble
13 NporpaMmbl NPSIMO Ha peXyLune NroTTepsbl.

BapwuaHT 2. [Mpaktnyeckn Bce nporpammbl nogaepxueatrot amynsaumio komang HP-GL n HP-
GL/2. Ecnm c¢ann B ¢dopmate HP-GL wnn HP-GL/2, owwunbku npu BbiBOAE
Ha pexyLleM nnoTTepe UCKMOYEHDI.

3.5 Hactpouka gpansepa neyatu Expert Il
3.5.1 Hactponka gpanBepa neyatu Expert Il > Bknagka Option

* File Function. ®yHKuuna no3BonsieT COXpaHsaTb paHee 3aaHHble napamMeTpbl CKOPOCTH,
ycunusi, cMeLLeHmnsa n kadectaa. [pu nosTopstowmxca paboTax 3T0 NO3BONAET
COXPaHUTb CaMble pacrnpoCTpPaHEeHHbIE HACTPOMKN 1 3arpyxaTtb UX No Mepe
HeobxoamMmMocCTun

» Custom Media. Pasgen cogepXxnt CnMCoK HeaaBHO CO34aHHbIX U MCMOSb30BaHHbIX
dannos ¢ napameTpammn HacTponku. [Ana ynobctea paboTbl MOXHO COXpaHATbL Gonee
50 cpannos.

* Default. B pasgene cogepxaTcs aTanoHHbIe HACTPOWKU ANA NPOBEPEHHbBIX MaTepuaros,
obecneumnBatoLLme Hamnyywne pesynbTatbl pe3kn. PekomeHgoBaHHbIe napameTpbl MOryT
HY>K4aTbCsA B KOPPEKTUPOBKE B 3aBMCUMOCTM OT NOCTaBLLMKa MaTepuaros.

* SAVE. CoxpaHsieT TekyLume HaCTpOMKM apanBepa nevatu B pann B ykazaHHOM nanke
komnbtoTepa. (CoxpaHeHHble harnbl C napaMmeTpamMmmn NoOMeYatoTCa pacluMpeHmemM cepum
Expert II)

* LOAD. 3arpyxaeT paHee coxpaHeHHble napameTpbl ApariBepa neyaTu.

* ORIGINAL. 3arpyxaeT ncxogHole 3aBockve napamMeTpbl ApanBepa nevatu.

* SAVE TO DEFAULT. CoxpaHsieT Tekylume napameTpbl ApanBepa nevaTtn Kak MCXoaHble
napameTpbl N0 YMONYaHMIO.

* DELETE. YaanseT BblbpaHHbIn dhann u3 pasgena Custom Media. HacTtpoiiku B pasgoene
Default yganute HEBO3MOXXHO. BHMMaHMe: yHKUMA yaanseT TONbKO CMCOK, NOKa3aHHbIN
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B pa3gene Custom Media, He 3aTparnBas dann Ha XXecTKkom Aucke. Yoanutb dann
C XKECTKOro Ancka MOXHO TOJTbKO BPYYHYHO Yepes OrnepaumoHHy0 CUCTEMY.

Die Cut

DYHKLNIO BbICEYKN aKTUBUPYHOT BMecTe ¢ pyHKumen Kiss Cut (Hagceuka),

4yTO6bI MaTepman nocre peskn He nagan n He cobupancs nog kapetkon. B pexxume Die cut
npopesaeTcd Noanoxka matepunana, B pexunme Kiss Cut npopesaeTtcs TONbKO BEPXHUIN CION,
HO He noanoxka. CoOTBETCTBEHHO, HA BEPXHEM CIOE OCTalTCs TONbKO HebGonbLune
dparmeHTbl NOAMNOXKM, @ Ha NUCTax NOASIOXKN BOCNPON3BOANTCA BECb MakeT

(puc. 3-7 n 3-8).

| Hox

BepxHuir cnown

Mopnoxka BuHmn

9 ¥

Hapceuka Bbiceuka

JlInHua pesa

Pwuc. 3-7

Bbiceuka
TSR

Hapceyka

Puc. 3-8
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Ons aktmeaumm pyHkuum Die Cut nepentn B meHto Option, yctaHoBuTb donaxok Die Cut
N BBECTU HYXHble napameTpsbl Length (OnunHa) n Force (Ycunue) ansa BbICEYKN N HAOCEYKM.

MoaTtBepamTb KHoNkon OK (puc. 3-9).

Setting
Pen Speed 18

A
Pen Force 50 o}
D

Offset

ol

cmé s

0250 mm

I

|Draft

Image Scaling:
e 500 /4 500 mm

| 2

i 500 /4 500 rmm

A |

[~ Usze Plotter Setting
[ Back to Home

Quality

e 1=

File: Function -

Save

Load

Original

Save To Default

Delete

Customn Media :

Drefault :

Wingl Ex

* [MprmeydaHue.

,D,J'IVIHa JINHNN pe3a and

Bbiceykn coctaBndeTt oT 0

no 2000 mm, ons Hagceykn —

-DieCut -
Length 1.00 T
FDICEJBD g

| Kisz Cut

Length ]1 .00 i
Forze ]40 g

e

Puc. 3-9

ot 0 go 100 mm.

Mo okoH4YaHuM 3agaHus, korga dnaxok Die Cut cHoBa ByaeT CHAT, MOXXHO OTperynupoBaTb
CTaHOapTHYK CKOPOCTb Nnepa, ycunue npuxaTtus nepa n CMeLLeHne B pasgerne ceepxy

(cm. puc 3-10).

OPﬁUTiPa_per
-Setting File Function -
Fen Speed 18 comis S |
-ﬂ —d Load J
Fen Force 50 g Origindl J
BRI 7]
Offset 0950 Save To Default J
L] J _.ﬂ Delete J
Quaity  [Drat | (Bl MpumeyaHue.
L Imane fealion. 1. CHavyana HeobxogMmo 3agaTtb BbICOTY
e 500 /4 500 mm
2l Ju 2| HOXa [AOns  npope3aHuMsi BEPXHEro Crosi
AT 500 /4 500 mm
K ‘i iy N noasioXku. llocrne aToro oTperynupoBaTb
e e = ycunue pesa ons nosfiydeHns onTuMarbHbIX
efault :
™ Back to Home Vil p63yJ'IbTaTOB.
2. MNMocne aktuaumm pyHkumm Die Cut oHa
I Die Cut Oyoet npuMMeHeHa KO BCEM JIMHUAM
e T T il obbekTa.
e i e 14 .:;:
Puc. 3-10
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3.6 PekomeHaoBaHHbIe HAaCTPOUKM ANS pa3nMyHbIX MaTepuanoB
I'Iapalvleprl HUXE UCNOJIb3YKOTCA ONd MaTepunanoB U3 Ta6J'IMLl,bI, CepTMCbI/ILI,I/IpOBaHHbIX GCC.

Marepuan Hakneiikv nog 3akas / Haknewnkn Ha BUTPMHHI EKOp ToHupoBaHue
Ha CTeHbl aBTOMOOUNN BUTPUH

Hox KpacHbIn KpacHbIN KpacHbIN KpacHbIN / XXenTbIi

OnnHa ne3sus, Mm 0,28 0,27 0,25 0,09

Ycunue, rc 105 85 95 70

CkopocTb, cMm/c 72 60 65 72

CwmelleHne, MM 0,25 0,25 0,25 0,25

RX, Jaguar, Puma

RX, Jaguar, Puma

RX, Jaguar, Puma

RX, Jaguar, Puma

PekomeHOoBaHHas

mozenb EX, AR EX, AR EX, AR EX, AR
MaTtepunan Tpadapet CeeTooTpakatoLlas dnok KapTtoH

nreHka

Hox KpacHbIN / 3eneHbIn 3€eneHbln 3eneHbIn 3eneHbIn
[OnvHa ne3suda, Mm 0,3 0,5 0,3 0,3
Ycunue, rc 180 380 135 165
CkopocTb, cMm/c 15 3 30 30
CwmelleHne, MM 0,25/0,5 0,5 0,5 0,5

RX, Jaguar, Puma

RX, Jaguar, Puma

RX, Jaguar, Puma

RX, Jaguar, Puma

PekomeHngoBaHHas
MoJenb EX, AR EX EX, AR EX, AR
MaTtepunan MarHuTbl ToHMpoBOYHas CTtpasbl Macka ans
3awmTa NEeCKOCTPYMNKU
Hox 3€eneHbIn 3€eneHblIn 3€ereHbIn CUHUN
[OnnHa ne3pusi, Mm 0,8 0,3 0,8 0,27
Ycunue, rc 580 320 190 85
CkopocTb, cm/c 3 3 15 60
CwmelleHne, Mm 0,5 0,5 0,5 0,25
RX, Jaguar, Puma RX, Jaguar, Puma

PekomeHpoBaHHas RX, Jaguar RX, Jaguar, Puma
Mozernb EX EX, AR
MaTtepunan Menkun Tekct

(BMHUI)
Hox YepHbIN
[OnnHa ne3sus, Mm 0,27

Tonctbin: 150

Ycunue, rc

TOHKMI: 90
CkopocTb, cMm/c 9
CwmelleHne, Mm 0,175

PekomeHgoBaHHas
Monenb

RX, Jaguar, Puma

D

AENOBAS
NHNUNATNBA

www.delinit.by
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Pazpen 4. BbasoBoe TexHMYecKoe oOCIyXMBaHue

B aTom pasgene paccMoTpeHO 6a30Boe TeXHUYECKOe 06CNyXUBaHUe pexyLlero
nnoTTepa, BKNYas o4ncTky. Bce npouenypbl, He BoweALwme B NepeyeHb HUXe,
BbIMOJTHAKTCA TONbLKO KBanupuumMpoBaHHbIM CEPBUCHbLIM CMeLuanucToM.

4.1 OuncTKa pexywiero nnorrepa

[ns nogaepkaHust BbICOKUX 3KCMyaTaUMOHHBIX XapakTepUCTUK peXyLLEero nnotrepa
N obecneyeHmns kKa4eCTBEHHbIX Pe3ynbTaToB YCTPOWCTBO TpebyeT TaTenbHOW perynsipHom

OYUCTKHN.

Mepbl NPegoCTOPOXHOCTU MPU OYUCTKE:

< Mepen 04YUCTKOWN pPeXyLNMA NNOTTEP OTKIOYUTL OT PO3ETKU
3neKTpoceTw.

< 3anpewaeTca UCNOSb30BaTb ANS OYMMCTKM pacTBOpUTENH,
abpas3uBHble YUCTSILLUE CpenCcTBa U arpecCUBHbIE MoloLue
coctaBbl. OHM MOryT NoBpeanTb NOBEPXHOCTb PEeXyLUuero
nnoTTepa u ABNXYLLUMECS 4YacTu.

PekomMmeHOoBaHHbIE NpoLeaypbl:

< OCTOpPOXHO NPOTEPETb NOBEPXHOCTb PEXYLLEro nrnoTrepa 6€3BopCcoBOM TKaHbHO. [pu
Heo6Xo0OUMOCTUN OYMUCTUTL TKaHbK, CMOYEHHOW B BOAE nnu cnupTe. MNpoTepeTb pexyLumi
nNNoTTep, yaanve ocTaTkn 3arpsasHeHnin. OctaTku BoAbl NPOCYLINTL MAMKON 6e3B0opCcoBOM
TKaHbHO.

% [MpoTepeTb HaNpaBNALLY KapeTKu OT Mblfv U rPA3un.

< Yganutb rpasb U OCTaTkU Matepuana us-noa kopnyca npuXMMHOro ponmnka ¢ NOMOLLbHO
nblrecoca.

% O4nCcTUTb OMOPHYHIO NNACTUHY, AAaTYMKK Bymarn N NPMXXNMMHbIE POSINKM TKaHbIO,
CMO4YeHHoM B BoAe nnu cnupTte. OctaTkn BOAbl NPOCYLLNTL MArkoM 6e3BopcoBoO
TKaHbIO.

< AHanorm4yHbIM cnocobom OYMUCTUTL OT MbINN U rpasun CTOIZKy.

BasoBoe TexHUYeckoe 0bCNyKMBaHMe 4-1
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4.2 OuncTKa peweTtyaroro bapabaHa

R/

% Pexywun nnotrep OTKNIOYNTb, KAPETKY OTOABUHYTb OT O4MLL@aeMon obnacTu.

R/

< TMoAHATb NPWXMMHbIE POSNINKM U OTOABMHYTL OT pelueTyaToro 6apabaHa.

R/

% KecTKou LLETKOM (MOXHO 3yOGHOM) OUYMCTUTL NOBEPXHOCTL BapabaHa oT nbinun. MNpu

HeobXxoaMMOCTM B NpoLeCcce OYMCTKM NpoBopaymBaTh 6GapabaH Bpy4Hyto (puc. 4-1).

Sbe——

e

® 0 0 0 0 0 b 0 000 DK

/

Puc. 4-1

4.3 OyncTKka NPMXNUMHbBbIX POJTINKOB

Ecnv npvXMMHbIE PONMKN HYXXOAKTCS B OYUCTKE, YAanaTb 3arpsi3HeHns1 ¢ 06pe3nHeHHON
4yacTu pPormKoB crieayeT 6e3BOPCOBON TKaHbO UK TyndepoM. YUToGbl NPUKMMHBIE PONUKK
He NPOoBOpaYMBanvCb NpPU OYUCTKE, MPUOEPXKUBATL PONUKN NanbLEM.

BbeBLlumecs n CTonkmne 3arpasHeHns yaanaTb 6€3BopCcOBOM TKaHbIO UK Tyndepom,
CMOYEHHbIMUN B CNUpTe.

BasoBoe TexHUYeckoe 0bCNyKMBaHMe 4-2
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Paspen 5. ABTOmMatuyeckoe BbipaBHMBaHMUe

AAS Il (Cuctema aBTOoOMaTmn4yeckoro BolpaBHuBaHus |l) goctynHa Toneko B Mogensx Expert

[I LX. MNMonb3osatenu nnotrepoB Expert Il 24 n 52 moryt nponyctutb 3TOT pasgern.
BHumanwne! 3101 pasgen npeacraBnseT cobom BBOAHYH MHCTpyKumio K AASII. MNMowarosble
WMHCTPYKUMK npuBeaeHbl B cnegyowmx pasgenax: 07_A-4 Moagynbe CorelDRAW, 07_A-5
Mogyns lllustrator, 07_A-6 Mogynb GreatCut.

5.1 O6wasa nHopmauyus
Pexywwme nnottepbl Expert |l ykomnnekroBaHbl CTaHAAPTHOW CUCTEMOM aBTOMATUYECKOro
BblpaBHMBaHus (AAS Il), koTopas pacno3HaeT NPUBOAOYHbIE METKN Ha OTrnevaTKkax,

rapaHTnpya TO4HOCTb pe3a.

BHumaHue
B [3beratb ropnsoHTanbHoro oceelleHns mogyns AAS nobbiM MCTOYHUKOM CBETa.

- BAMNPELLAETCHA

ABTOMaTM4yeckoe BblpaBHMBaHNeE 5-1
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52 Cuctema KOHTypHOM pe3ku AAS

MckntounTtenbHaa TOYHOCTb paboTbl cuctembl AAS obecneunBaeTcsa cneumnanbHbIMK

KannbpoBOYHbIMKU Npoueaypamu. [Ana paboTtel ¢ cuctemon AAS Heob6xoaMMOo yMeTb
3arpyxaTb matepuan. (cMm. «2.4. 3arpyska matepuana.)

5.2.1 lMpumeyaHue No NPUBOAOYHLIM MEeTKam

lMNepBas npmBoadoOYHAs MeTKa OOSHKHA OTnmnvaTbCs, 4yTOObI €e pacno3HaBarna cucrtemMa

AAS. Ha aBTOMaTu4eckoe cYMTbiBAHWE METOK BINAIOT criegytolimne dakTopsbl:

Twn matepunana

PacnonoxeHne NpnBOAOYHbIX METOK

[AnanasoH cunTbiBaHUS ONs pacno3HaBaHUA NPUBOLOYHbBIX METOK
lMonoxeHne NpMBOAOYHBIX METOK U MaTepuana

Mp1BOAOYHBIE METKW AOMKHbI ObITh:

co3fgaHbl B nporpamme ang peskm tuna GreatCut unm moayna GCC ans
CorelDRAW;

YepHOro LBeTa (BaXXHO Ka4eCTBO nevaTn NpUBOAOYHbIX METOK: HEBEPHbIE
uBeTa, NnpobnemMbl NPMBOAKK, pasmbiTUE, padMasbiBaHUe MOryT yXyALWUTb
pesynbTaTtbl Pe3Ku)

Length: gnuHa meTok

- [Owana3soH: oT 5 0o 50 mm

- OnTtumanbHo: 25 Mm

Thickness: TonwmnHa NMHUKU METOK

- [OmanasoH: oT 1 0o 2 mm

-  OnTtumanbHO: 1 MM

Margin: pacctosiHne mexay MeTkammn n n3obpaxeHnamm

- [Hwana3soH: ot 0 go 50 mm

- OnTMmanbHO: 5 Mm

PexyLwmin nnoTtrep He pacno3HaeT MeTKU, eCcrn:

lMepepn pacno3HaBaHWEM KapeTKy nroTTepa He NoABENN K BHELLHEN
rpaHvLie NepBon METKM (30HY aBTOMAaTMUYECKOro pacno3HaBaHUs NepBown
NPUBOAOYHON METKM CM. Ha puc. 5-7.).

CpegHsist TonwmHa 6onee 0,8 mm.

Mcnonb3yeTca npo3payvHbli maTepuan.

PucyHok He MOHOXpPOMHbIN. OTneYyaTaHHble Ha LBETHOM MOBEPXHOCTU
METKWN HEe CYUTBLIBAOTCA.

[MoBepxHOCTb MaTepuara ucnadkaHa unu namdara.
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5.2.2 AAS Il ansa Expert Il

B AAS Il ecTb Tpu cxembl paboTbl ¢ meTkamu: 4-Point Positioning (no 4 Toukam), Segmental
Positioning (no cermenTtam), Multiple Copies (co3gaHue konui). lNepen neyaTbio MakeToB Ha
CTPYWHOM NpUHTEPE Heobxoanmo J0B6aBUTbL K MakeTy NPUBOAOYHbLIE METKN, CO30aHHbIE B
nporpamme onga pesku tmna SignPal, GreatCut nnu mogyna GCC gna CorelDRAW. Pexyuwjue
ninommepbl GCC He pabomarom ¢ pucyHkamMu U Memkamu, cOeslaHHbIMU OM PyKU.
MoppobHee 0 HacTporike NPUBOAOYHBLIX METOK B MporpaMmme pesku cm. «MpunoxeHune A-4:
MHcTpykumsa no nporpammHomy moayrnto CorelDrawy, «MpunoxeHue A-5: NHCTpyKLMs no
nporpammHomMy moaynto lllustratory, «MpunoxeHne A-6: Moaynb GreatCut».

1. lMo3uumoHupoBaHue no 4 Toykam
basoBas cxema aBTOMaTUYECKOro pacno3HaBaHNsA NPMBOAOYHbLIX METOK B AAS Il 1
KOHTYPHOW pe3Kkn n3obpakeHnn BHYTpU 3TUX METOK.
m  Komanpa: Esc.D1;(XDist);(YDist):
m  KomnoHoBKa: 4 NpMBOAOYHbIE METKMN NO YETbIPEM YriiamM BOKPYr MakeTa.

B

2. nOSVILIMOHVIpOBaHMe no cermMmeHTam

K 4yeTblpeM ncxogHbIM TodkaMm 406aBNATCA NPOMEXYTOYHbIE NPUBOAOYHbIE METKN MO
ocsaM X 'Y ansa 60nbLon TOYHOCTU pe3Kn, OCOBEHHO KPYMHbIX M300paXXeHn.
m  Komanpa: Esc.D2;(XDist);(YDist);(XStep);(YStep):
s KomnoHoBKa:
MpomexyTodHoe paccTosiHue no ocu X: o1 200 go 600 mm, no ymonyanuo 300 mm
[MpomexyTodHoe paccTtosiHne no ocu Y: ot 200 go 600 mm, no ymonyanuio 300 mm

3. Co3paHue konun
dyHKLMA ncnonb3dyeTcs Anga AyénmpoBaHusa n3obpaxeHuin, N03BONASA Bbipe3aTb cpasy
HecKonbko ak3emMnnspoBs. JaTtumk AAS Il aBToMatnyeckn oTcKkaHMpyeT NPMBOLOYHbBIE METKM
AN18 KaXKaoro otaenbHoro nsobpaxeHusi, obecneyns TOYHOCTb pesa.
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[ Komanpa: Esc.D3;(XCopies);(YCopies);(Space):
[ KomnoHoBKa:

5.3 MNpobHaa neuatb

lMepen BbINOSTHEHMEM KOHTYPHOM pe3ku ¢ cuctemon AAS pekomeHayeTcs pacnevatatb
TEeCTOBbIN (hawns ¢ yctaHoBoYHoro ancka DVD, 4yTo6bl o6ecnevnTb TOYHOCTb pesa Ha

Expert 1.

Ons AASII npegycmoTpeHo ABa TECTOBbIX dpanna:

1. AAS II_X Y Offset Caberation_A4.eps (popmat A4)

2. AAS II_X Y Offset_Caberation_600_600.eps (N0 ymonyaHuto, pekoMmeHOoBaH
ANs TeCTUPOBAHNSA)

B Pacne4vartaTb TecToBOe n3obpaxeHune. (PekomeHaoBaH NPUHTEP C BbICOKOM
TOYHOCTbIO NeyaTwn)

B 3arpy3uTb nsobpaxenune B Expert |l n otnpaButb dann Ha pesky ans
TeCTUpOBaHUSA

B Ecnv HeoBxoanMOo BHECTU KOPPEKTUPOBKM, OTPEOAKTUPOBATb BEMUYNHY
CMELLEHMS, KaK ONMUCaHO HUXeE:
m 3amMepuTb BEMNYMHY CMeLLeHUs oTneYyaTaHHON NIMHUN N JIMHUN pe3a.
m BeecTtun 3HayeHne AAS Offset B pasgene MISC ¢ y4eToM nonyYeHHbIX
3HayeHun, 3atem HaxaTtb Enter
m [1OBTOPHO NpoTecTnpoBaTth pesky

m  BenuunHy cmeweHus no ocam X n'Y gns AAS |l onpegenstoT crnegyowmm
obpasowm:

"opu3oHTanbHasa nuHUS — X, BepTukanbHas nnHna — Y (NULOoM K
pexyLiemy nnoTrepy)

m Ecnn Hy)XXHO CMeCTUTb NIMHUIO pe3a 1 oTnevYaTaHHY NMHUIO NO
HanpaBfiEHMIO K UICXOOQHOW MeTKe, yKasblBaloT OTpULaTernibHoe 3Ha4yeHme
cMmeLlleHus. Ecnv Hy>KHO CMeCTUTb NIMHUIO OT UCXOAHOW METKU, BBOAST
NOSTIOXUTENbHOE 3HAYEHNE CMeLLEeHUs (CM. pUC. HUXKe). ATO OTHOCUTCSA

ABTOMaTM4yeckoe BblpaBHMBaHNeE 5-4
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Kocam X un'Y.

-

X (+ Value)
Y (- Value)

X (+ Value)

I
|
1
1
T
t
1
¥ (+ Value) :
1

L

WMcxogHan Touka

NuHua pesa

—

X (+ Value)
Y (- Value)

X (+ Value)
Y [+ Value)

L S S|

WcxogHan Toyka

MpumeyaHue:
[ |

X (- Value)
Y (- Value)

X (- Value)
Y (+ Value)

TNuHuR newatn

X (- Value)
Y (- Value)

X (- value)
¥ (+ Value)

NuHna neyatn

X (+ Value)
Y (- Value)

X (+ Value)

Y (+ Value)

L

WMcxogHas Touka

—

X (+ Value)
Y (- Value)

X (+ Value)
¥ (+ Value)

[

WcxopgHan Touka

« Hanpaenexwe noga4n

|
1
i X (- Value)
1 ¥ (- Value)
t
.
|
1
1

X (- Value)
Y {+ Value)

\ TNuHuA nevatn

NvHuA pesa

X (- Value)
¥ (- Value}

X (- Value)
Y (+ Value)

\_—

IHuA nevatn

Mepen nameHeHnem HacTpoek AAS Il BbINONHAT MacwTabupoBaHue

no WwnpuHe " annHe.

[na TectoBoro |/|306pa>|<eHM$| cMeLlleHne HoXa He 3a4aHo.

Ero HacTpanBakoT B 3aBUCUMOCTU OT Bbl6paHHOFO HOXa.

B C Bonpocamu obpawaTbCs K HaM UM K MECTHOMY OUCTPUBLIOTOPY.

5.4 [OonycTtumoe cmelleHue NpMBOoAOYHbIX METOK

YT106bl CccTEMa pacno3Hana NPUBOAOYHbIE METKM, HeobXoaMMo crneanTb
3a NpPaBUNbHOCTbLIO 3arpy3kn matepuana (Mo NPUBOAOYHOW NMHEKE HA OMOPHON NMacTUHE).

|_|pl/l OTKINOHEeHUAX, BbIXOOALLNX 3a I'IpI/IBe,D,eHHbII7I anana3oH, METKM pacCro3HaHbl HE 6yﬂyT.

ABTOMaTM4ecKoe BbIp

aBHMBaHUe
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OuanasoH 4AWHBI NPUBOAOYHBIX )
2-a MmeTKa
meToK: 5-50 mm

L (anMHa npMBOAOYHON METKM)

S (oTHNOHEHWE NPUBOAOYHOK METKM) + 1-a meTka

- - Y e - - - - -

— AwanazoH I_,SSS L.
OTKNOHEHUA: 7 2

AWanasoH ANUMHbI NPUBOJOYHBIX METOK: 5 MM < L < 50 mm

5.5 KoHTypHas pe3ka

[na TOYHOCTU KOHTYPHOW pe3ku ¢ pyHKumMen AAS BbINOMHUTL CrieayoLwme warmu:

MEYE Cosnanue rpacdmku
m Co3paTh n3o6paxeHune, KOTOPOe HYKHO OTreYaTaThb 1 Bbipe3aThb Yepea nporpaMmmy.

&, BABY

o IN CAR

m Co3aaTtb KOHTYp pesa BOKpPYr n3obpaxeHusl.

& IN CAR

CogeT 1. OcTaBnATb MECTO MeXAY M306paKeHNEM N KOHTYPHOW NIMHUEN.
Cosert 2. Co3gaBaTtb KOHTYp B OTAENbHOM CIoe U NpucBanBaTb My APYron LBET.
m [106aB/Tb NPUBOAOYHbIE METKMN BOKPYr N300paXKeHus.

NMpumeyanue.
MoxxHo Bocnonb3oBaTbea pyHkumen Multiple Copies. OHa aBTOMaTU4ECKU
KonupyeT n3obpaxeHne 1 NPUBOAOYHbLIE METKM.

ABTOMaTUYecKoe BblpaBHMBaHNeE 5-6
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m PasmecTUTb NpMBOAOYHbLIE METKU
m MakeT B AAS:

10 mm{0.3% in)
30 mm(1.18in) 10 rmim|0.39 in) Track of Pinch Rollar
10 mm|0.39 in)
5 mmi{0.2 in)
(omm|  2nd Mok AAS |l Layout Instruction 3 Mark
Standard media verification:
e—— | Oracle white-color vinyl (651)
25 mm Smm{0.2 in) J/ Grafityp white-color vinyl
{098 1n) 1 5V white-color vinyl
20 mm r
(0.79 in) Mark size

/[ Length: 25 mm|0.98 in)
| Thickness: | mm{0.04 in)

margin between mark & graph: 5 mm(0.2 in)
¥ Distonce [betwesen Ind & 3 mers):
{ Maximum: 400 mm(23.62 in)
J/ Minimum: 70 mm|2.74 in) (depends on graphic desgn]

¥ Distance [between 15t & 2nd marks);
[ Madmum: 1770 mm|é%.6% in) (depends on medio & cutter)
J Minimum: 70 mm(2.74 In) [depends on graphic design)

Repeatability: less than 0.3 mm(0.01 in)

WORKABLE AREA

[light grey blocks)

fh Mark
Tst Mark

Crigin

Auto-detecting area Track of Pinch Roller ey e 30 mm{1.181n)

|y riangkel

* CDyHKLlI/IFI aBTOpacro3HaBaHUA Ha 1'7I MeTKE OXBaTblBae€T CEPYHO 30HY.

B0mm{3.15in)

(undher Paper Soving Mode/
width expandead moda or
Both unexpanded mode)

S0mm{1.97 in)

lundier Paper Soving Mode)/

Belh aspanded mode|

m Pekomenayemble nonsa B 30 MM crieBa 1 cnpasa OT NMcTa matepuarna.

m PekomeHgoBaHbl nonsa ot BepxHen KpoMkm nucta ot 20 o 30 MM, OT HUXHEN
KpOMKM — He MeHee 50 MM BO nsbexaHue nageHust NMcTa 1 Ha criydam oLwmnbKn

B pasMepax martepuvana.

IIEIg] OrtnevaTtatb rpaduky
m OTnevyarartb Ha NpMHTEPE N306paxkeHne N MeTKMU.

(macwtab = 100 %) B

] an/I neyaTtu Ha pyJioHe nNpuaep>xXmBatbCA cne,qyrou_\eﬁ opuneHTauunn:

ABTOMaTUYecKoe BblpaBHMBaHNeE 5-7
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M 3arpysuTb oTNeYaTok B pexyLymii NNoTTep
m VcxoHas MeTka [IofKHa OTNNYaThLCS OT OCTaNbHbIX MPUBOAOYHBLIX METOK.
Heo6x0anMMo NpoBepuTL NPaBULHOCTL HaMNpaBMeHNs nogaqw.

MEEE Beuipesatb kKOHTYP
m Yepes nporpamMmmy AaTb KOMaHzy BbIMONHWUTL 3aaHNe Ha Pe3ky.

5.6 CoBeTtbl no AAS

YT06bI pe3ynbTaTbl KOHTYPHOWN pe3ku Obinuv nyylle, NpUAepKUBaTbCA CrneayoLwmx
npasun.

m  PaboTtaTb C NPOCTbIMU MCTOYHMKAMM OCBELLEHUS, HE OCBELLATb NOTTEP COOKY.

m [lepepg 3anyckom cuctembl AAS N3MeHUTb MakcuMarnbHbIi popmaT
Bymaru B cBovicTBax gpansepa Expert Il.
[ITEYE] B nanke Printer & Fax Ha komnbloTepe HaiiTn mogens Expert Il.

m OTkpbITb OKHO Properties (Conctsa) u BbibpaTh Bknagky Paper (bymara).
M3MeHUTb MaKkcUManbHbIi pasmep Gymarm no ocu X Ha 1200 mm.

m  CkopocCTb pesku yctaHoBuUTb B ananasoHe 200—400 mm/c.

m  [lpocneanTtb, 4TOObI MPUXKXMMHbBIE POSIMKN HE 3aKpblBanun NpUBOLAOYHbIE METKMW.

m [lpu pacnosHaBaHMM NPUBOOOYHbLIX METOK YOeaMTbCH, YTO MaTepuan He 3arHyT.

ABTOMaTM4yeckoe BblpaBHMBaHNeE 5-8
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Pasgen 6. lNowuck u yctpaHeHMe HeMcnpaBHOCTEN

B oToM pasgene paccMOTpeHbl pacnpocTpaHeHHble npobnembl B npouecce
akcnnyaTauun nnotTtepa. [leped TeM Kak 3HaKOMUTbCA C COAEPXMMbIM pasgena,
yGeamTech, Y4To Balla NporpaMMHasi cpefia COBMECTMMA C PEXYLLUM MIIOTTEPOM.

MpumeyaHue.

Mepen Tem Kak CBA3bIBATLCA C NOKaNbHbIM AMAepoM, yoeanTbes, 4To npobrnema B pexyLlem
nnoTrepe, a He B 0OMeHe AaHHbIMM MeXAy KOMMbTEPOM U PEXYLUMM NAOTTEPOM U HEe B
OTKase koMnbloTepa NMbo nporpammMHoOro obecneyeHus.

-

\ & lNoyemy He pabomaem pexywuli nnommep?

6.1 NMo4yemy Expert Il He paboTaeT?

Ecnu pexywmin nnottep He paboTaeT, CHavana NnpoBepuTb criegytoLlee:

MpaBunNbHO N NOAKMNOYEH Kabenb NUTaHnA?
MpaBunbHO N NOAKMNOYEH Kabernb NUTaHUS K UCTOUYHUKY MUTaHUA?
lMonoxeHne cMNoBOro BhIKIOYaTENs NpaBunbHoe?

PeweHusa: Ecnu ceseTognoaHbI MHANKATOP NUTAHUA FTOPUT, PEXYLLMW NAOTTEP UCMPABEH.

OTKNMOUYNTB M NOBTOPHO BKIIOYNUTE pexyLumi nnottep. NpoBepuTb, cCoxpaHunach nim
npobnema.

Ecnu cBeTOoAMOOHbIN UHAMKATOP MUTAHUS HE FTOPUT, CBSXKUTECH C NOKamNbHbIM
AVNepoM Ans pelleHust npobrnembl.

6.2 CBeTOBbIE MHAMKATOPDI

CBeToBble MHAMKATOPbI HA NAaHeNM yrnpaBneHns NOMOryT BbIIBUTb HEKOTOPbIE NPobnembl
C aKcrnnyaTaumen.

Ecnu pexyLumii nnotrep npekpatun paboTy Unmn BHe3anHo 3amurany CBeTOBble NHAMKATOPbI,
03HAKOMUTBLCH C OMUCAHUSMU CUTHANOB HIKE U C HEOOXOANUMbBIMUN AEUCTBUSMMN:

MOWCK M yCTpaHeHME HeMCNpPaBHOCTEN A-2
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6.2.1 NpeaynpeanTenbHblie MHAUKATOPDbI

Ecnn muraet nigukatop ERROR, BbinonHuTh cneayowme gencteus. Npu yctpaHeHun
npobnembl MHAMKATOP aBTOMaTUYECKM NpekpawaeT Muratb. OTKNOYNTL UHOMKATOP
ERROR Ttakxe moxHo kHonkor ON/OFF LINE.

ON/OFF DATA | CUT

MpeaynpeanTenbHbie MHAUKATOPbI ERROR LINE REPEAT CLEAR | TEST
1 O6pesaH makeT : i o [ ] O O
2 OwwnbKa KomaHabl HPGL/2 :'¢E [ ) O o O
3 MOAHAT pblyar AN HET MaTepuanos >_¢E o O O O
4 MoBTOp HEBO3MOKEH :—¢E O o O O
OwwubKa nepesaym AaHHbIX :ﬁ}i O O o O
6 OwnbKa gaTymKa WNPUHBI :‘¢E O O O .
7 Martepuan, 6apabaH, npusog no ocm X o O O ) O

XX = Muraet ® =&k O = otkn.

MpeaynpexaeHue 1 O6pesaH makeT

YkasblBaeT, YTO MakeT Gonblie obnacTtu pesa.

UT06bI pewmnTb Npobnemy:

1. 3arpy3utb 6onee LWMPOKUIA UNN SAVHHBIA MaTepuan.

2. lNepemecTUTb NPMXUMHbIE PONNKK, yBENNYMB 061acTb pesa.

3. YMeHbwuTb MakeT macwTtabupoBaHmeM. CHOBa OTNpaBUTb MakeT C KOMMNbIOTepa
Ha pexyLinn nnoTrep.

MpeaynpexaeHune 2 Ownbka komanasl HPGL/2

Ecnu pexywmin nnotrep He pacno3HaeT komaHabl HP-GL/2 unn HP-GL, npoBepuTb
npaBunbHOCTb NpuMeHeHnsa komaHg HP-GL/2 nnn HP-GL k pexywemy nnottepy. CHoBa
OTNPaBUTb MakeT C KOMMNbIOTEPA HA PEXYLLMI NIIOTTEP.

Ecnn npobnema He pelleHa, cBs3aTbCs C rlokanbHbIM OUIEPOM.

MpeaynpexaeHue 3 MNogHAT pblyar Uy HeT maTepuana
Mepen Havanom peskn ybeguTbCs, YTO pblyar OnyLieH, a MaTtepuan 3arpyxeH.

MOWCK M yCTpaHEHME HEMUCNPABHOCTEN A-2
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MpeaynpexaeHue 4 MNoBTOp pe3kn HEBO3MOXEH

EcTb oBa BapumaHTa.

1. B Oydhepe HeT gaHHbIX: HeOBXOAMMO CHOBa OTNPaBUTbL 3aJaHue C KOMNbloTepa.

2. bydgep nepenonHeH: He0o6xoaMMO CHOBa OTNPaBUTbL 3afaHue C KOMMboTepa.

B o6ounx cnyvasx coobueHne ob owmnbke oTkntovaeTca Haxatmem kHornkn ON/OFF LINE.

MpeaynpexaeHue 5 Owmnbka nepegayn gaHHbIX

[MpoBepuTb, NPaBUBHO N NOAKITIOYEH K PEXYLLEMY NOTTEPY U KOMMbIOTEPY Kaberb
nocnegosaTenbHoro nHTepdgerica (USB).

Ecnu ga, npoBepuTb NpaBUibHOCTb HAaCTpOek HTepdenca. HacTporkmn nepegadn JaHHbIX B
KOMMNbloTEepe AOSMKHbI OblTb TEMU Xe, Y4TO Ha pexyLlem nnotrepe (npumep: 9600bps, no
parity, 8 bits, 1 stop bit). NMocne aToro BepHyTbCs B pabounii pexum kHonkon ON/OFF LINE.

MpeaynpexaeHune 6 Ownbka gaTumka WMPKUHbI

MpoBepuTb, HAXOASTCS N NPWXMMHbIE PONMKWN HaA pewleTyaTbiM 6apabaHom, 1 cHoBa
3arpysutb matepuarn.

NMpumeyaHne.

UTtobbl nerko onpenensatb TN OWMOKM, peKOMEHLYETCA NPUKNEnNTb ¢ BoKoBOWM
CTOPOHbI pPeXYLLEro nNnoTTepa Haknenky ¢ npeaynpexaeHnammn (M3 kKopooku

C AONOSMHUTENBbHBIMU KOMMNOHEHTAMN).

6.2.2 UHgukaTopbl OWKOOK

[Mpn BO3HUKHOBEHUN MEXaHMYECKUX HeNonagokK B npouecce paboTbl 3aropaeTcs
ceetoanogHbin nHankatop ERROR. [ns peweHna npobremsbl BbINONHUTL NepevYncrieHHble
HWXKe warn. Ecnu pexxyLwmnn nnoTrep no-npexHemy He paboTaeT, CBA3aTbCs C NIOKarbHbIM
Annepom n coobmnTb 06 nHAMKaTope OLWMBOK.

ON/OFF DATA CuUT
MHaunkaTopbl owmnbok ERROR REPEAT
LINE CLEAR | TEST
1 Owwubka SRAM . O O O O
2 | Owmnbka DRAM - O O O O
3 | Matepuan, 6apa6aH, npusog X o O O @ O
4 Marepuan, 6apabaH, npusog Y o O O O o
: i = Muraet ® =B« O =orkn.
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Ownoku 1 mn 2

CBszaTbca ¢ nokanbHbiM agnnepom anga sameHbl SRAM nnu DRAM.

Owwnbka 3 NMposeputb maTtepuan, 6apabaHn, npmeog no ocu X (Nnpusoa 6apabaHa)

B coobuieHunmn ykasbiBaeTcs, 4To npobriema MoxeT 6biTb Mo ocu X.

MpoBepuTb PYHKLUMOHMPOBaHe GapabaHoB 1 3arpy3ky Matepuana. lNocrne 3Toro BKMOUYUTb
nUTaHVe 1 NepesarpysnTb PEXYLLUA NoTTep.

Owwnbka 4 NMpoeeputb matepuan, 6apabaH, npmeog no ocu Y (NpUBOA KapeTKn)

B coobweHumn YKa3blBae€TCA, YTO KapeTke MOXEeT YTO-TO MeLllaTb Ha OCU Y.

Yaanute nomexy n yéeamTbes, YTO KapeTka nepemelyaetca cesoboaHo. Nocne aToro
BKMOUYUTb NUTaHME M NepesarpysnTb PeXyLLmi nnoTrep.

MOWCK M yCTpaHeHME HeMCNpPaBHOCTEN A-2
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6.3 CHMXXeHMe KayecTBa pe3Ku

MpumeyaHmne. O4yeHb BaXXHO OOCNYXMBaTh PeXyLMn NAoTTep
exxefHeBHO. [1ns TOYHOCTW 1 KayecTBa pe3ku pelleTyaTbin 6bapabaH
N NPVXXUMHbBIE POSINKM HYXXOAIOTCA B PEryNIAPHON OYUCTKE.

MpaBunEHO N YCTAHOBNEH HOX M HAENHO NN
3aKpenneH aepxarens Howa?

I

|

| Het
Aa |

¥

Hox Tynow unu Cwm. paapen 2.4
CHONOTLIA? «YCTaHOBKA HOXaw
|
Aa l Her
1 ¥
3aMeHuTb Yeunwe ycTaHoBNEHO
HOX pepHo? (Younume pesa
HOBEIM no ymor-aniio 80r)
|
Na : HeTt
L ¥
CmeLleHue HCTpYMeHTa Otperynupoears ycunue pesa anAa
HACTPOEHO BepHO? ONTMMANBHOND AABNEHUA HOKA.
J Cwm. pazgen 4.3. «Ycounue pesa
Na } Her W PErynMpoBKa CMELLIEHUA»
|
1 L 4
Hox aarpaaHeH? OrperynuposaTte
cMeLLIEHHWE MHCTDYMEHTa
:
Da : Hert
L *
Waeneds u 3a TexHW4ecKon NoanepKKon
OYUCTUTL HOX obpawaTeca kK gunepy

MOWCK 1 yCTpaHeHWe HeucnpaBHoCTeN A-2



GCC..

Expert Il. PykoBoacTtso

TexHUn4yeckue xapakrepuctukm cepumn Expert li

Homep mogenu: EXII-24 | EXII-24LX EXII-552 | EXII-52LX
WnpuHa pesa, o 600 mm 1320 mm
LWLnpuHa maTtepunana, oo 719 Mm 1470 Mm
TonwwuHa matepuana 0,8 mm

Ycunue pesa, oo 350 rc

CKOpoCTb pesa, 0 705 mm/c (noga yrrnom 45°) 635 mm/c (nog yrnom 45°)
dunsnyeckoe paspeLleHne 0,009 mm 0,012 mm
OKpaHHoe paspelueHne 0,025 mm

TOYHOCTb NEpeMeELLEHNS +0,254 nnn +0,1% xopa, no 6onbLlen BenNnynHe
MoBTOPsIEMOCTL 0,1 Mm

OTtcnexvnBaHune 3m

Bydep namaTtu 1 MB / 500 KB (npu ncnons3osaHun AAS)
NHTepdencol USB 2.0 (nonHockopocTHou), RS-232

Twun komaHg HPGL, HPGL/2

HacTtponka ncxogHom To4Km Ja

MaHenb ynpaBneHusi 6 ceeTtoamonos / 10 KHOMOK

[nameTp HOXa 2,5 Mm

Mabaputel (B x W xT), mm

233 x 880 x 255 1065 x 1632 x 620

Macca HeTTO

11 Kkr 53 kr

Crtounka

[ononHuTensHo CTaH,D,apT

Cuctema aBTOMaTM4€CKOro
BblpaBHMBaHus (AAS 1)

[na mogenen Expert Il LX

McTouHmk ANEeKTPOonnTaHnA

100-240 B nepemeHHoro Toka, 50/60 'y (aBTONEpekntoyeHne)

OHepronoTpebneHue He 6onee 288 BT
Ycnosus Temnepatypa ot +15 °C go +30 °C
skcnnyatauun | BniaxHocTb OT125% o 75 %

® CosmectumocTtb ¢ OC Windows 7 1 Bbiwe, MAC OS X 10.6 u Bbiwe. (* MNpwn
npuobpeTteHunn cepuiiHoro Homepa MO Sure Cuts A Lot, paboTtatowiero ¢ Mac OS.)

® CI'IeLI,I/ICbVIKaLl,I/II/I N TEXHUYECKNE XapaKTEPUCTUKN MOTYT OTIIMHaTbCA B 3aBUCMMOCTU OT

maTtepuana. [ns onTumanbHbIX pe3yribTaToB peKoMeHAyeTCsi MPoBOANUTL Haanexallee

cucTeMaTtmyeckoe TexobenyxusaHme ycTponcTaa.
® GCC ocraBnseT 3a cobon NpaBoO Ha UBMEHEHMNE TEXHNYECKMX XapakTepucTmk 6e3

npeaBapuUTENbHOrO yBEAOMIIEHMS.
® [laHHble npuBeeHbl ona matepuana Avery MPI 3000, cepTtudmunposaHHoro GCC.

® [lpuBeaeHHble Bbille TEXHUYECKNE XapaKTePUCTUKN AENCTBUTENbHbI TONbKO Npu paboTe ¢

MaTepuanamu, ceptudunumnpoaHHsiMn GCC.
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TexHU4YeCKMe XapaKTepUCTUKN HOXEWN

[Ons pesku Tonctoro payopecL,eHTHOro U CBETOOTPaXKatoLEero BUHMAA.
Takske ana paboT U3 CTaHAaPTHOTO BUHWAA C MEIKUMU AeTaNiIAMM.

202003480G

45°, KpacHas HacaaKa (5 WTyK B ynakoske), cmeleHune 0,25 mm,
AvameTp nessua 2,5 mm.

S —————

[lna pesKun CBEeTOOTPaXKaloLWEro BUHWAA, KAPTOHA, NECKOCTPYNHbIX
MmaTepuanos, GOKa, OCTPbIX Kpaes TpadpapeTa.

290088080G
60°, 3eneHan HacagKa (2 WTyKKn B ynakoske), cmeweHne 0,50 mm,
AnameTp nessua 2,5 mm.

L ————————

[ns pe3skn TOHKUX NeCKOCTPYMHbIX MacoK 1 wabaoHos. Ocobasn
KOHCTPYKLMA M OCTPbIM YroN 3aTOYKM 419 KOHTYPOB C MasibiMU paguycamm.

265017550G
XapaKTepuUCTUKM HoxKa: 60°, cMHAA HacagKa, cmelleHune 0,25 mm,
anameTp 2,5 mm.

T ————

LNnAa pe3kr MenKoro TeKCTa U CNOXKHbIX AETaHEVI. OCprIVI HOX
C MUHUMaA/IbHbIM CMELLEHNEM.

265017560G
XapaKkTepucTnkm Hoxka: 50°, yuepHaa Hacagka, cmeweHune 0,175 mm,
anameTp nessua 2,5 mm.

—

LNAa TOHKUX N XPYNKUX MaTepuanos, BKIOYAA BUTPUHHbIE TOHUPOBOYHbIE
N1E€HKMN.

265017530G
XapaKTepuUCTUKM HOXKa: 25°, 3kentaa HacagKa, cmeweHme 0,25 mm,
AnameTp nessua 2,5 mm.

TexHnyeckune XapPaKTePUCTUKA HOXKel A-2
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OB6 MHCTpPYMEHTE

O6Lwmin TepMnH, 0603HaYaOLLNIN HOX ON1s1 Pe3KU NNCTOB, Nepo Ans
rpaconocTpoeHns n cBeToaMOAHbIN Npuuen (4ONOMHUTENbHO) A5 HaBeAEeHUA
Ha Touky npusaskn. CMELWEHWE — paccTosiHue, Ha KOTOpoe CABUHYTO fie3Bue
HOXa OTHOCUTENBbHO LIEHTParibHOW NIMHUN HOXa.

«——— HoOx

<+«— LlleHTpanbHas nuHus

|
|
Jle3Bue —_— |
HOXa l
- -
|
|
cMellueHue
BbineTt HoXxa
TonwmHa
mMaTepuana
BbineT Hoxa (t1)
e ——
TonwmHa 6ymarn-
OCHoBbI (t 2) 5 -
B e \ A

BbineT, To eCcTb BbiCOTa, Ha KOTOPYHO BbICTynaeT ne3sue Hoxa =t1 + 12/ 2. [Ana
yno0bCcTBa MOXHO cunTaTh, 4TO 31O OT 0,3 o 0,5 MM OT Kpasa gepxartens.

TexHn4YecKkne XxapaKTepuUCTMKn HOXKel A-2
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UHcTpyKkumua no BeiBoay ns CorelDRAW

Hwxe onucaHa npoueaypa BbiBoaa danna ns CorelDRAW.

UHCTpYKUMM Ang nonb3oBaTtens

1. OTkpbiTb CorelDRAW, 3akoHunTb pegaktnpoBaHme Bcex hannoB Ang BbiBOAA U
BbIOpaTb cpasy BCce U3obpaxxeHus.

2. Komangon Outline Pen 3agaTtb KOHTYp A58 pesku.

B CorelDEAR X4 - [Grnphiet] TR
[£] Bt Yww Layed  fruye Btk Bdmeps e [abke Tk Hwdow  Help "
TERe ®ak b i D@ e ¥ see-F 0 OB A OH: @ L Rl b
x| B9 A5 mm 138173 mm [ 3 o 451 o A B = :
i 196,00 mm | ¥ 41138 mm 2l M. ol = . 1 E] H
wBAHm | 87 | (00 % & alon PEasen || ~0o ~
= | 195,01 ety LR ECT Y 0.0 |% 2| 195.01 mm I oo
¥ cresafiosd P AN e
s L 715 e T L SO N P I A (o P 2 IR o 25 e R 1 S i s v < S P b FE A T P o o Bl
@& iy
&1 |
£ | & ]
a5 -
= : :
% ﬁ'. £
ot
g o

[ Oothine P A ]
& outuecobr, Dawrz W

ey
=
1}
b
;
&,

v X

Wo
Hazline
12
Ipt
In
Bt
16
WU

"B

s Caler

{80557, 165.804 ) Chek, an obpect twice for

Pagin 1

At Teoct: Arigd Black (Plack) (ENU) on Lier |

ol ol chrjeste; Staft+chok multi-seincts; AR+oick degs; Curich ssbects 2 group

o oy

& e
0 s rsrien

3. YcTaHoBUTL 3Ha4veHue wupuHbl nepa Ha 0,001 mm 1 noaTeBepanTb kHornkon OK.

Outline Pen
Colar:
width: B )
IT’\ imillimeters Vi
Style:
| “]

Edit Style. ..

Miter Limit: 5o B
Corners Line caps
© M\ O =
O M @)
O ;a O =

]

Arrows

[thions 4 ] [Optiogs = ]

Calligraphy

Stretch: Mib shape;

Default

[l eehind fil
[ 5cale with image

[ o

H Cancel H Help

BbiBog, n3 CorelDRAW
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GCC... Expert Il. PykoBoacTtso

4. Komangon File > Print (®ann > NevyaTb) oTNpaBuTb hann Ha pexyLumin nnoTrep.

8| Core]DRAW X4 - [Graphic]

| Bdit  Wiew Leyouwt Anenge  Effects  Bitmaps  Tet Table  Took  Window  Help

(Aa m cot b | P -@ [ | see-£iH M 4 iH & v & & e
& New Eom Template
i E‘E open. ! Ctuo El (=] oo | Units:|milmeters | «®0dmm 2 %
B Cle [ m
B Cpeal EI
= s Merg
o H Swveds CtsShifes  om B e e e T i L [
[E SR Seve As Template ~ s
% Revert g =)
¥, AomimInee 5 @
Q. gt Import Chils] =
- 3y Export CHIE %
4 g ExportFor Oifize
W sl v E
D‘\u Frint ChrltP &
CU T Printblerge v o
O (& Primt Preview g
@, = Pent Setup || E
=] &s Propars For Servics Busau. H
[ ¢ Fublish ToPDF. §
Gy PoblihPese IoConepthar @ §
Publish To The Wzb »
2 £
@,  Dowment roperi, =
&) Qpen Recent > L g
"..1 ATWF4 o
T = g
: a
]
x

4 1cft  » » [E| Pagel

»
3
Bg
¥
=|

e &
WX

(-150.889, 408,705 ) Next click fior DragfScale; Secand click far Rotate/Skew; Dbl-clicking tool selects all objects; Shift+click multi-selects; Alt-+click digs

5. BbibpaTb YyCTAHOBMNEHHYO MOAENb.

Print X

General |Lay0ut |I Separations || Prepress " Misc || 1z Mo Issuesl
Destination
Mame: | Haguar Properties. ..
Type: Jaguar Iv 153 Lse PRD
Status: Ready
Where: GCCUSBO:
Comment: Printtafile  (H)
Print range Copies
(& Current document () Documents Mumber of copies: IZI
OCgrrent page Selection
2 | CHCEE o
Print style: |CoreIDRAW Defaults v| ’ Save As.., ]
4| 4[| H|Page1 w
Print Preview ] [ Print ] [ Cancel ] [ Apply ] [ Help ]

BoiBog 13 CorelDRAW A-3
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6. Ha Bknagke Layout ansa onumm Reposition images to BbibpaTb BapuaHTt: — Bottom left corner

(BblpaBHMBaHME NO NIEBOMY HUXKHEMY Yy,

BHumaHue: M306pa)|(eHMe AOJTXKHO HaXoAUTbCA B HNXXHEM JieBOM yriy.

Print

X

Imaqge position and size
) As in document

O Fit to page
@ Reposition images ka:

[¥] Settings For Page 1:

Position: Size:

| General La‘}’ﬂl@eparations !! Prepress !l Misc |! 3 Mo Issues |

Center of page

Center of page
Top cenker
Left center
Right center

Bottom center

%3591 m ¥ -~ | (133,18
vi (169071 [ F

41.14m.|.

Top left corner
op right cormer

[CIPrint tiled pages

Eottom left corner
Bottom right cormer
Custom

| | | 7o 0T Pags AT

[ Bleed limit:
Imposition layout: |F\s in docurment (Full Page) _V| [ Edit...
Page 1 b
[ Prink Prewisw ] [ Print ] [ Cancel ] [ Apply ] [ Help ]
7. BepHyTbcs Ha Bknagky General n npoBepuTb, YTOObI N306paXxeHne ObINo B HUKHEM
nesom yrny. Haxatb Print (MeyaTb) n NoNy4nTb NpekpacHO Bbipe3aHHOE U3aernme.
Print X
General |.Lay0ut_ii -Separations.!! l-:‘repress i|.Misc -|! M Mo Issues-|
Drestination
Mame: :Iagu.ar IV 183 v| Properties...
Type: Jaguar Iv 1583 Use PP
Skatus: Ready
Where: GICUSED:
Comment: Prink to file E]
Print range Copies
() Current document ) Documents Mumber of copies: 11 ¢|
O Current page Selection
Pages: | | @ ! E Collate
Print style: |Custom {Current settings not saved) l‘flil ’ Save As... ]
Page 1 M
Print Preview ] [ Print w ’ Cancel ] [ Apply ] [ Help ]

BbiBog, n3 CorelDRAW
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UHcTpykuna no mogynio CorelDRAW

Mporpamma yctaHoBkn AASII VBA paboTtaeT ¢ CorelDRAW Bepcun 13, 14, 15, 16, 17, 18
YcTaHOBKa
YctaHoBka nporpammHoro moayns AAS anaCorelDRAW onucaHa B ware 8 pasgena 2.7.1.2

«YCcTaHoBKa apanBepar.

3anyck nporpammHoro moaynsa CorelDRAW AAS

3anyctuTtb CorelDRAW ansi peaakTMpoBaHus rpadukv U BbIAENUTb Cpasy BCe
N306paKEHUs AN OTNPAaBKK Ha NIOTTep.

m 3anyctutb Makpoc komangon Tools>Macros—>Run Macro. B meHo Macros in BblAenntb
onuuio Global Macros (GCCAASII_Draw13.gms) n Haxatb Run (BbinonHuTtb).

Run Macro

Macro name:

Canicel

Step Into

g

Edit

Create

Delete

Macroz in: | Globalbacros (GOCL AT Draw . gis) - ]

Degcription:
GCC's A ASTT Contour cutting Swstern VBA -

Moaynb CoreDRAW A-3
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[MMEYE LLlenkHyTb Ha kHonke Apply (MpUMEHUTB) 1 yKasaTb TVM NPUBOJOYHBLIX METOK —
Mo pa3Mepy CTpaHWLbl UK Mo 06bekTy.

AAS T Reg. Mark Setting v2.09-01 &

¥ Add Registration Mark by page size
-

{* 4-Point Position
Length 25 mm (5-50)

Thickness 1 mm (1-2)
Margin 0 mm (0-50)

" Segmental Positioning

¥ Ste
P| 500 mm (200 - 600)

5P| 500 (200 - 500)

-

Mo. of X Copies | (1-50
Mo. of ¥ Copies | 4 (1-50)
I™ Copies with outline

Apply | Cancel ‘

[MEYX! Tenepb MoxHO pacneyaTbiBaTh (aiin ¢ NPUBOAOYHLIMU METKAMMU.

MpumeyaHue. Npu wenyke Ha n3obpaxeHun No ymMonyaHuio BelbupaeTcsa onuns
Add Registration Mark by Object (JlobaBnaTb NPMBOAOYHBIE METKN NO 0OBLEKTY).
Mpun wenyke Ha nycton obnactu cTpaHuLbl N0 yMOMYaHUio BblbpaeTca onums
Add Registration Mark by page size.

Onsa moaynsa AAS MOXHO 106aBUTb 3HAYOK ObICTPOro 3anycka

BbinonHute Tools - Options >  Workspace - Customization > Commands
- Macros > GCCModule.GCC_AAS_Plug_In n HaxaTb OK.

o

Commands

«| [#h] | Genert | Shoeut Keys [ Apprasance
1| Tookp Helg:

Cuarreatly Available Ore

LY CorelDRAW X7 (64-Bit) - Untitled-1
File Edit Miew Layout Arrange Effects Bitmap

O F B = i - 5 |
ﬁ 85" =[]
|Letter MEEETE gg H]E
L§$ Welcome Screerf P Hitled-1
Fl N - -
{‘ W0 'a R SR
| |
o) o) re i,

Moaynb CoreDRAW A-3
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Job6aBneHne NPMBOAOYHbLIX METOK MO CTpaHuue

Ecnu yctaHoBuTb conaxok Add Registration Mark by page size n HaxaTb Apply nporpamma

aBTOMaTUYeCKM CO3aacT NpPUBOAOYHbIE METKM (puc. A3-1).

NMpumeyaHue.

-
AAS I Reg. Mark Setting v1.02-01

==

1. OnuHa B npegenax oT 5 0o 25 M,
¥ Add Registration Mark by page size
B 3aBMCMMOCTU OT paamepa CTpaHULb. R
" 4-Point Position
2. Npu pobasneHun NPUBOAOYHbBIX METOK MO (ngtn [ 7
CTpaHuue, Kak nokasaHo Hmxke, HE JOINMYCKAETCH Thdness [ nm
BHECEHMEe nameHeHun B pasgen Origin Bo nsbexaHue Margn [ mm
CMelLlleHns MeTok (cM. puc. A3-2). & ceomental Positoring
X5tep| 3np —
Options X I Y Step 300
g | | Ruers
- VBA Nudge " Multiple Copies
L. Save
g---inerTRACE Nudge: p.o1] - Supernudge: 2 = x0.010in )
_pr:i-lm Units: inches Micro nudge:  0.010in/ 2 No. of X Copies I 1
Toolbox [¥] Same units for Duplicate distance, Nudge and Rulers Ma. of ¥ Copies I 1
[=)- Customization
- Command Bz Units [ Copies with outline
- Commands Horizontal:
_..Dn(u;i:t‘mpa‘me Wertical: inches
" senarsa.\ 3 Same units for Horizontal and Vertical rulers AIJDIY Cancel
.- Page Size
Layout Origin Tick divisions:
g---;i:lgruund Horizontal: 0.0 = inches 8 | pertick ~
--gu\ddelmes Vertical: 0.0 = inches [#] Show fractions
z:\iﬂ 7] Show Rulers Puc. A3-1
o Bxport ToHTML
i-GIoba\ | -
— Puc. A3-2
[ QK ][ Cancel ][ Help ]

npl/l nepemMeLllieHnmn I/I306pa)KeHVIFI nporpamMmma co3gaeT 4 MeTKM Ha yrinax CTpaHunubl, Kak

NOKa3aHO HWXe.

Puc. A3-3

Moaynb CoreDRAW A-3
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Paboyasa obnactb

Mo3BonsieT peAakTMpoBaTh U Bbipe3aTb M306paXxeHns 3a rpaHnuaMy NPUBOAOYHbLIX METOK MpU
ycrioBun oGaBneHnst MeTOK Mo CTpaHuue.

[Ons maTtepunanoB A4 paboyas o6nacTb Ha 2,5 MM 3axoauT 3a NPMBOAOYHLIE METKM C NPaBoOn
N NIeBON CTOPOH, Ha 4,5 MM — 3a BEpXHIO0 MeTKy. PekomeHJoBaHHOE pacCTosiHue

00 HWXKHEro Kpas Matepuarna — He MeHee 25 MM BO usbexaHne nageHnsa nucrta u Ha cryyvyan
owmnbkn B pasmepax matepumana.

[Ons maTtepuanoB bopmaTa A3 paboyvasa obnactb Ha 10 MM 3axoanT 3a NPUBOLOYHbIE METKM
C NNeBOW CTOPOHBI, Ha 9 MM — C NPaBon CTOPOHBI, HA 11 MM — 3a BEPXHIOKO METKY.
PekomeHOoBaHHOE pacCTosiHWE 0 HUXHEro Kpas Mmatepuana — He MeHee 25 Mm

BO n3bexaHve nageHus nucta U Ha crny4van ownbkn B pasmepax matepuana.

Print X
General |Co|or | Composite | Layout | Prepress | 1 Nolssues|
Destination
Printer: [\\gpprinterZ\4F_§-ﬂE_3={-FH_KYGCERA F5-2025D KX vl i Preferences...
Page: [Match orientation (Landscape) v] Use PPD ; L Left side L
Status: Default printer; Ready
Location: 192.168.100.246
Comment: [ Print to file 5 = ( :
i 3 . e | ) = E
Print range Copies TDD Sldel | d ¥ & L % Buttom SIdE:
@ Current document () Documents Number of copies: 1 = ; ! o :
() Current page Selection ! ! ; ( ) _\' \i R
1 ' - 7 g2 =
Pages: 1 Iﬂ Collate | R | &
fren 1.0 =) Rightside | g
[ Print as bitmap: 300 dpi 0 Igln\
Print style: [CoreIDRAW Defaults VI ’ Save As... ]
Page 1 &
o] i) (o) (i)

MpumeyaHune. [1na pa3smMoTkM pynoHa BbibpaTh pexunm Edge npu HacTporike
dopmaTa matepuana. Npu pabote B pexxume Single nucT matepuana Hernb3g
nepemMecTuTb Hasaf, a 3HaunT, (PpoHTanbHbIV AaT4MK Bymarun ero He pacrnosHaeT.

Moaynb CoreDRAW A-3
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Nob6aBneHne NPUBOAOYHBLIX METOK MO OO BLEKTY

Mpwn yctaHoBke chnaxka «Add Registration Mark by Object»Ha BbIbop fOCTYNHO Tpu
BapuaHTa NpUBOAOYHbIX METOK.

4-Point Positioning (no 4 Toukam)

® Length: annHa meTok
- [wanasoH: ot 5 go 50 mm

AAS T Reg. Mark Setting v1.02-01

r - OnTtumanbHo: 25 Mmm

¥ Add Registration Mark by Object ®  Thickness: TonwuHa NMHUN METOK

> nanasoH: ot 1 2 MM
(' 4-point Position OvanasoH: oT 1 oo

Length a5 mm

Thickness Il—”"m ([ ] Margm: paccToaHmne mexay MeTkamiu u I/1306pa)|(eHI/IF|MM

- OntumanbHO: 1 MM

Margin |—,:, mm - [OwanasoH: ot 0 oo 50 mm

- OnTtumanbHO: 5 Mm

\ 4

(" Segmental Positioning

X Step 500 —

I Segmental Positioning (no cermeHTam)
b StED 500
mm
I ® X Step: paccTosiHMe NPOMEXYTOYHOIO NMOMOXEHUs Mo ocn X
(" Multiple Copies ® Y Step: PaccTosiHMe NpoMEXYTOYHOrO MOMOXEHUS Mo ocn X
1 No. of X Copies [ > [wmana3oH: ot 200 Ao 600 MM
No. of Y Copies | 4 2> OnTtumaneHo: MeHee 500 MM
[ Copies with outline
| Multiple Copies (Co3aaHue konum)
Appl Cancel . y
PRl Ance ‘ ® No. of X Copies: kKonMyecTBO Konuii no ocn X
- ® No. of Y Copies: konmyecTtBo konuii no ocu Y
Puc. A3-4 > [uanasoH: oT 1 go 50 (4em Gornblie Konuii, Tem

Donblue BpeEMEHM HY)KHO Ha nepefavy AaHHbIX).
-  KonwnyecTtso konuin X * konndecTso konuin Y = obLuee
KONMMYECTBO KOMUIA N306paxkeHns

®  Copies with outline: ons oTobpaxeHns KOHTYpoB
n3obpaxeHus

NMpumeyaHue. 3HayeHus, ykasaHHble B pasgene 4-Point Positioning (gnuHa,
TOMLWMHA, Nonst), 4ENCTBUTESbHbI Takke C yCTaHOBMEHHbIMU donaxkamm Segmental
Positioning n Multiple Copies.

Moaynb CoreDRAW A-3
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Mo3nunoHnpoBaHume No 4 Toykam

AAS T Reg. Mark Setting v1.02-01 5

4-Point Positioning

[~ Add Registration Mark by page siz

i

® Length: gnuHa meTtok

- ) ) .
[v add Registration Mark by Object > ,El,manasoH: oT 5 no 50 MM

& apg "
4-Foint Position - OnTtumanbHo: 25 Mm
Length | 25 mm "®  Thickness: TonwmHa NUHUN METOK
Thickness I 1 mm
- [OwanasoH: oT 1 40 2 MM
Margin I 0 mm

-  OntnmanbHo: 1 MM
" Segmental Positioning

® [lonsa: PaccTosiHve Mexay MeTkaMun U N3oBpaxxeHusiMm
Xstep| 500
i = - [OumanasoH: ot 0 go 50 mm
¥ Stepl
I 500 mm >  OntMmanbHo: 5 MM

™ Multiple Copies

Mo, of X Copies I 1
i Mo, of ¥ Copies I 1

| ™ Copies with outline

Apply Cancel Puc. A3-5

[Mporpamma co3gacT 4 MeTKM, Kak Noka3aHO Ha PUCYHKE HUXKeE.

A ¥ 4 Bit led _

Fle Edit Wiew Leyowt Object Eests Bitmeps Ted  Tsble Tock  Window  Help &
(S -1 B ®-c- H @R W B[P wweTe- @ F-

m X () B 8Mmn | o (] e b e i) | 01 me 3] ged0mm kg

G000 mm 2l
;| Wekcomes( B | ntiied2

B, 50 mm

e

ba g

*

cAh# o002

o

¢

BHA 1ot ¢ HEB| Pagel 5 & i
» 4 N

(37801, 105452) (3] M & None & I om0 w0 K00 0,500

Puc. A3-6
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GCC... Expert Il. PykoBoacTtso

NMpumeyaHue.

1. [ns 3KoHOMMM MaTepurana npu No3nLMOHMPOBaHMUN MO 4 TOYKaM OOMyCKaeTCsl MEHATb
He TOSIbKO Nosis 00bekTa, HO U ASIMHY NPUBOOOYHBIX METOK (HE MeHee 5 MMm).
PekomeHgauum ansa pasnuyHbix oopmaTtoB cM. B Tabnuue 1. Yem meHbLle pasmep, Tem
MEHbLUNM AO0SPKHO BbITb paccTosiHne mexay 00 bekToM 1 NPUBOLOYHON METKOM
(cm. pacyeTbl HUXe).

s Puc. A3-8

T T

25mm Smm
dopmart cTpaHuubl, B MM | PekoMmeHayemas AnvHa MeTku, B MM
AB (105 x 148) 5
A5 (148 x 210) 8
A4 (210 x 297) 11
A3 (297 x 420) 16
A2 (420 x 594) 23
A1 (594 x 841) n 6onee | 25%

Tabnuua 1
*25 MM — pekoMeHOOoBaHHas ANMHA NPUBOAOYHON METKM

2. Pa3|v|ep NnpnBOAOYHLIX METOK BJIMAET Ha TOYHOCTb pacCrno3HaBaHUA, NO3TOMY He crieayeT
aenartb UX CIMWKOM MENKNMn

3. MNpun nameHeHumn oopmaTta Gymarm Heob6xoaMmo ykasaTb HOBbIE 3HAYEHUN s
NPUBOJOYHBIX METOK, MHAYe MPUMEHSIIOTCH TEKYLLIME HACTPOWKM.

Moaynb CorelDRAW A-3
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nO3VILIMOHVIpOBaHVIe no cermMmeHTam

-
AAS T Reg. Mark Setting w1.02-01

E

[T add Registration Mark by page size

V¥ Add Registration Mark by Object

" 4-point Position

Thickness 1

Length I 95 mm
Margin I 0 mm

* Segmental Positioning

xstep[ 200

¥sep[ 00 o

™ Multiple Copies

Mo. of X Copies I 1
Mo. of ¥ Copies I 1

™ Copies with outline

Apply |

Cancel

[1ns BbICOKOTOYHOWM pe3kn pekoMmeHayeTcs BblbpaTb pexmm
Segmental Positioning, noBbicnB TOYHOCTb 06pabOTKK
AJIMHHBIX N KpYNHOOPMAaTHbIX M300paXKeHUNn.

Mo3uumMoHMpoBaHME MO CermeHTam

e X Step: paccTosHMe NPOMEXYTOYHOIo NOSIOXKEHUSA MO ocn X

e Y Step: paccTosHMe NPOMEXYTOYHOIo NOSIOXKEHUSA MO ocn X
-  [OwnanasoH: ot 200 go 600 mm

-  OntumarnbHo: meHee 500 Mm

Puc. A3-9

I'Iporpamma CO30acCT METKM, KaK NOoKa3aHO Ha PUCYHKE HUNXE.

1

fe  Edit View Leyout Object Effegts  Bitmaps
- H &R ek

(S - S o ®-

| custem b X

ST 15 3000 m

nmﬂmm T m

Tet Table Tooks Window Help ol

-8 = lo.cerMmeHTamM

i) Welcome 5 A Untitled-1  Untitled-2
|

Al

P

P

o

Rl o

L ads

C

LN T
w0 ¥ we@ ‘f‘
gye -E] &y S E_ &
Luéﬂ%ﬁ.é% o

SB 4 1ei1 b W B Pagel

» 4 DM

(174517, 30398 [E

=y SR B per =1/ o WEImm e
| M0 G Ueite| millimeters w5 01 U, 50 mm (G
*

V&

B @ X None & M0 M ¥ 100 0.500 pe

Puc. A3-10

Mpn KonnpoBaHUM 06BHLEKTOB BONbLUNX pasmepoBs (asMHa nnbo wupuHa 6onee 200 mm)
¢ pyHkumnen Multiple Copies K HUM NpUMeHSeTCs NO3ULMOHUPOBaHUE NO CErMEHTaM —
ansa 6onee TOMHOro pacrno3HaBaHWst NPUBOAOYHbLIX METOK.

Moaynb CorelDRAW
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Co3pnaHue Konumn
MepekntovaTens Multiple Copies noBbilaeT TOYHOCTL pe3a B crydasx, korga u3 marepmana
HeobX0ANMMO MNONYYUTb HECKOSBKO 3K3EMMIISIPOB OAHOMO N300paXeHns.

r
AAS T Reg. Mark Setting v1.02-01 e

" Add Registration Mark by page size
v Add Registration Mark by Object

" 4-point Position

Length I 75 mm

| Thckness [ Co3spaHue Konui
Margi . o
g [ e No. of X Copies: konunyecTtBo Konui no ocn X
l " Segmental Positioning

e No. of Y Copies: konuyectso konuu no ocn Y

"StEF'l 500 mm
| "'Steﬂ'l 500 mm

& Multiple Copies

Mo. of X Copies Iq__
No. of ¥ Copies [ obLLee KONMYECTBO KOMUIN N306paxeHns
[ Copies with outline

> [OmanasoH: oT 1 go 50 (4em 6onbLue Konun, Tem

OonblLUe BpEMEHN HY)XHO Ha nepefayy AaHHbIX).

> KonuyecTtBo Konun X * konnyecTso konun Y =

v

e Copies with outline : gna otobpaxxeHnsa KOHTYpoB

Apply | Cancel n3obpaxeHnst

Puc. A3-11

Mporpamma co3fgacT pe3ynbTaT, Kak MoKa3aHo Ha PUCYHKE HUXKE.

Fe Edit  View Lsyout Object Effegts Pitmaps Tet  Table Tooks  Window Help oL
S = I < G ®- - H & oun || &@ ] wpTe- @ E -

[ rx i o) BW000mm EW | o
l=n o PR 1 Py ey FAR =

i) Welcome 5 & Untitled-2  Untitled-1 = -
Gl

B[y Beq  Units] millimeters =) < B1mm

¢y P

o

ocb Y

(= o g e e B o

Liiads

Bt ¢ 101 * HE Pagel vy

r o M.

[ 20538, 1547 [H]

Puc. A3-12

& €01 Y0 K00 0.500 pe
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KoHTypHasa pe3ka yepe3 CorelDraw

MEYE] MomectuTs B nnottep GCC 6ymary ¢ NpUBOAOYHLIMI MeTKaMu, oTneYaTaHHbIMY

Ha NpuUHTepe.
MMEY®. BuinonHuts Files > Print.

¥ CorelDRAW X7 (54-Bit) - Untitled-4
Edit  View Object
New... Ctr+N

m
"

Layout Effects Bitmaps Tet JIable Tools Window

H & ot - | 8 =
0[] [ o nits[milimeters =] 4 01 mm £

Untitled-3 Untitled-4

Help
2%

W E

SnapTo -

% 50 mm
4, 50 mm

MNew from Template...

n & R

Open... C0 | R

Open Recent b led2

H,

Text Properties

Close v i o i a i v i s " i

Close Al

Ctrl+§
Ctrl+Shift+3

Save.

Save As..

goo @

Save as Template..

AcguireImage ,
Search Content

Import... Crl+1
Export... Ctrl+E
Export For »
Send To ,

o %

Publish to PDF
Publish Page to ConceptShare...

2B

cui+p |
Print Merge r

Print.

]

Print Preview...

Collect For Outpt...

5

=
g

Document Properties...

Exit Alt+F4

7 @&

EMH 4 101 F WO

v

(133011,453.218) [B]

Bagel | 4

NMpumeyaHue.

[ns CorelDraw Bepcuun X5 n BbilL€e BbINOSTHATL ONMUCAHHbIE HUXKE Luaru.

.

i

- & M @

Character -
[ A1 seripts 3
O Arial .
A = u,
o ot ]| - <3
A R - [x 5
ab o X, o @ AB
oo o @ow
A, S,0 @0 B0 A
fi k st s =
Bo¥o foBo
A Paragraph
B 00mm [ 0E00mm 3
E- 00mm & L]

- T

sapadolg o) £

4 [l com0 v k100 0.500 pt

Puc. A3-13

[ITEYE] Ha sxnagke «Color» B none Color conversions performed by: (BbINonHWTS
npeobpasoBaHue LBETa B:) yka3aTb MOAeNb nniotrepa (cm. puc. A3-14).

- 2 R D Y *|| Ohject Manager » & X
= Layer:
\3. Layer 1 B
a =
i | O [_] Page 1
s Print =] G #M Curdis
Q, o . e e % — @l Clone Layer
S | General | Color | Composite | Layout | Prepress | (2 Mo Issues| 8 = — S Mark Layer
ool ]
] @ Print composite
b & () Print separations
0,
= (& Use document color settings
e o O Use calor proof settings
S Color conyersions performed by: E R
=
= o 8 = — ¢l Layer L
& ik [ Rectangle
1 Correct colors using color profils: | {Document) sRGB [EC61986-2.1 ~| B (] Master Page
< = T * @ SMl Cudss
v Preserve RGE numbers = i
Al Rendering intert: |Relative colorimatric v —@® O
: 4 The color settings and preview available in this dislog box are sst for the Windows Graphic
" W el U serred e Ganaval Fab
&,
& & [ Print Praview ] [ Print ] [ Cancel ] [ Apply J [ Help
4
i
Ll
g
i i
BB WA 10f1 » Page 1 [E3 | e
(-128.179, 316.087) » &

Dacument color profiles: RGB: sRGE IECA1986-2.1; CMYK: Japan Color 2001 Coated; Grayscale: Dot Gain 15% #

WX

=/« NN O B [ [

Puc. A3-14
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GCC... Expert Il. PykoBoacTtso

[TEY®] Ha sknagke Layout ans onumm Reposition images to BbiGpaTh BapuaHT Bottom left

corner (BblpaBHMBaHME NO NIEBOMY HWXHEMY YrIy).

Eile Edit ¥iew Leyout Arenge  Effects  Bitmaps Text Teble Tools Window Help =8|
e B b0 PR D E [ v swe - E o

fleio0mm  val - = Bsomm va
) O (] ([ | v s | o[E] | SESE

S‘E\ D‘ 1?0 200 250 3?5

A s W . milmetes | Obyect Manager » &

B (| Page 1 =
— i

— 1 @ Clone Loyex
] | General || Color | Composite | Layout | prepress | [ Mo Issues | B ® = Dl Mark Layer
] Image position and size
7 ) Asin document
(Eitto page
Triclude mistks and calibra
o (&) Reposition images to:

(7] Settings for Page 1:

] Position: Sige: Seale Factar:

] % [L2l4tw &l wa (117201 v (& [100 (v &
] i }r_sgs‘nz =2 1z Luaa\ >4 [0 % 1 8 == ¢l Layer 1
o [ Rectangls

1 [CIPrint tiled pages Tilin ks Bl I_| Master Page

* @ ¢l Cuves

] o A * G ¢+l Dsivp

=0 ~ @@ O

=E [ Bleed limit:

Imposition layout: |As in document (Full Page) V| [ Edit... J

3— [ pncpreven | [i¥) [P ][ concel J[ amb J[ e ]

O ARFo,AE PO 00O (F)

ol
W4 1oft  » M B[] Pagel ik i | #@e
(-128.179, 316.087) »

Document color profiles: RGE: sRGE IECA1966-2,1; CMYK: Japan Color 2001 Coated; Grayscals: Dot Gain 15% P

E?'G‘m
LB
=l

Puc. A3-15

HaxaTb KHoMKy Print.
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UHcTpykumusa no moayno lllustrator

YctaHoBwmk AASII VBA pabotaet ¢ Adobe lllustrator Bepcun CS4, CS5, CS6, CC.
YcTaHoOBKa
YcTtaHoBka nporpammHoro moaynst AAS ans Adobe lllustrator onncana B ware 8 pasgena 2.7.1.2

«YcTaHoBKa ApanBepay.

HacTpounka npuHTepa

[MTEYE] OTkpbiB OKHO NPUHTEPOB Yepes MaHernb ynpaBneHus, LWenkHyTb NPaBoii KHOMKOW
MbILLM Ha NpuHTEpe 1 BbibpaTb Printer Properties. OTkpoeTcs ananoroBoe OKHO CBOMCTB
npuHTEpa.

P — ]

%- |rp;3 » Control Panel » Hardware and Sound » Devices and Printers »

Add a device Add a printer See what's printing Manage default printers Print server properties Remove device

4 Devices (2)

MARKET-EILEEM USB OPTICAL
MOUSE

4 Printers and Faxes (9)

| Y o F

[ / /

ed ‘
— jg-:/ =~ d | e

E o= See what's printing
PR AP EERA Adobe PDF Bullzip PDF i-Craft Microsoft XPS | R St ae defanilt primier
_SHPAR _KYOCERA Printer Document Writer
AR-MMSOPCLE  F5-2025D KX on Printing preferences
on gpprinter2 gpprinter2 [ Printer properties

s
Create shortcut

Troubleshoot

Remove device

Properties
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MMEY®) V6eanTues, uto Ha Bknaake Advanced ([lononHNUTensHO) CHAT donaxok Enable
advanced printing features (BkntounTb AONONHUTENBHbLIE BO3MOXHOCTM NeyaTh).

. —
sty RXI-1325 Properties |5

Pen | Paper | AAS Installer
General Sharing | Ports Advanced Color Management | Securty | Cptions

@ Always available

':::' Availlable from 12:00 AM : To 12400 AM
Pricrity: 1 :
Driver S "l ’ Mew Driver...

i@ Spool print documents so program finishes printing faster

(70 Start printing after last page is spocled
@ Start printing immediately

() Print directly to the printer

[ Hold mismatched documents
[ Print spooled documents first

[ Keep printed documents

[ Enable advanced printing features

[ Printing Defaults... ]’ Print Processor... ” Separator Page...

ok J[ Cancel J[ ooy
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UHCcTpYKUMKU Anga nonb3oBaTtens

ITEYE] OtkpuiTs lllustrator.

MEY®] OTpenakTupoBaTh M306paxeHne, CO3AAB KOHTYPHYIO 06BOIKY.
(Mpumeyanwue. LLnpuHy nmHum yctaHosuTb Ha 0,001 mm).

e
Mew from Template...
cpen...

Open Recent Files
Browse in Bridge...
Close

Savr

Save Az

Savea Copy..

Save a5 Template.,
Save far Web.

Save Selected Shoes..
Revert

Place_

Save for Micrasoft Office...
Export...

Scrips ExpurtDocsAsFlash
Flex Sking

Dacument Setup... Bt Cerle P
Dacument Color Mode
File Info.. 8k Shifte Cirle |

ImageTracing
SaveDocsasPDF
SavrlocsAsVG

Prinit. Cr-P l AMST Plug In I
Ext Clel=}

Other Scipt..
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MBI BuinennTs HyXHbIE MPUBOAOYHBIE METKM.

MMEYEE 3neck 4OCTYNHLI TpY TMNA NPUBOAOYHLIX MeTok: 4-Point Positioning (no 4 Toukam),
Segmental Positioning (no cermeHTam), Multiple Copies (co3gaHue konui).

Make by Page size

' 4-Point Poisitioning |

Length{mm): Zl 0-50)
Thickness(mm): (1~3)
Margin{mm): 0 e

Segmental Poisitioning |

¥ Stepmm):  EEURN (s00~600)
Ystepmm):  EEUREE (900~600)

Multiple Copies |

No. of X Copies: (1~50)
No. of ¥ Copies: {150)

Copies with outiine

Exequte ——————————
’7 Apply Cancel

MpumeyaHue.
3HayeHus, ykasaHHble ans 4-Point Positioning (gnvHa, TonuwmHa, nongd), Takke
AencTBUTENbHbI NOCcIe YyCTaHoBKN donaxkoB Segmental Positioning n Multiple Copies.
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MMEYAE NonTteepanTh NPUBOAOYHLIE METKY (Aanee B MPUMEPEe PacCMOTPEHO
NO3NLIMOHNPOBAHME MO 4 TouKaMm).

LLlenkHyB Ha NycToi obnacTv cTpanuLbl, BbIGpaTh Document Setup (HacTpoiika
[OKYMeHTa).
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MEYE) HaxaTb krHonky Edit Artboards (PeaakTupoBaTh MOHTaXHbIE 0bnacTh).
Document Setu

Bleed and View Options

Units: | Points v Edit Arthoards

Top Bottom eff Right R
Bleed: = L% = ) pt I p = [ pt 8

Show Images In Qutline Mode
Highlight Substituted Fonts
Highlight Substituted Glyphs

Transparency
Grid Size; Medium -
Grid Colors; [ Light

Simulate Colored Paper

Preset: [Medium Resolutio.. = Custom...
Type Options
v Use Typographer”

Language: English: USA 4
Double Quotes: ¥ Single Quotes:

Paosition
Superscript:

Subscript: [F
Small Caps:

Export:

MEYE) BuinonHute Presets — Fit Artboard to Artwork bounds (MogorHaTe MOHTaXHY0 06nacTb
no BbIGpaHHON UnnCTpaunn).

File Edit Object Type

Artboard Presats: Letter

$H 55 M cor

Fit to Artwork Bounds \

v Letter

Legal
Tabloid

A4
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MMEYET) Mocne wara 9 HaBecTV MblLb HAa NaHENb MHCTPYMEHTOB CrieBa U BbIGpaTh
WHCTPYMEHT BbiaerneHus Selection Tool.

File Edit Object Type
Artboard Presets: = Custom

$FEM contour.ai* @ 100% (CMYK/Preview) =

T'F Transform

|=, Align

By Pathfinder

MMEYEE] Pexxum penakTupoBaHus CHOBa aKTUBEH.

Edit Typ Effec

Fy Fathfinder
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MEYEF. Pacnevatath daiin ¢ N1HMel KOHTYpa U NPUBOAOYHLIMU METKaMM.

Al File Edit Object Type - \ Hep  [@ WE~

Ctrl+N
. .

Mew from Template... Shift+ Ctrl+M
Open... Ctrl+0

New...

Open Recent Files »

Browse in Bridge... Alt+Ctrl+0

Close Ctrl+W

Save Ctrl+5
Save As... Shift+ Ctrl+5
Save a Copy... Alt+Ctrl+5

Save as Template...
Save for Web... Alt+Shift+ Ctrl+5
Save Selected Slices...

Revert F12
Place...

Save for Microsoft Office...

Export...

Scripts »
Document Setup... Alt+Crl+P
Document Color Mode 3
File Info... Alt+5Shift+Ctrl+1

Print... Ctrl+P

Exit Ctrl+Q

MEYEE MomecTus otneyatok B NNOTTEP, OCNABUTL NPWXXUMHBIE POMWKA U MOABECTU KapeTKy
K NPUBOZOYHBLIM MeTKaM.

MEYELY] OtnpaBuThb cbaiin Ha nnoTTep.
Edit Object Type Select Window Help [ Hig
MNew... .
Mew from Template... Shift+ Ctrl+ M - -
Open... Ctrl+ 0O

Open Recent Files 4
Browse in Bridge... Alt+Ctrl+ 0

Close Ctrl+W
Save Ctrl+5
Save As... Shift+Ctrl+5
Save a Copy... Alt+Cirl+5
Save as Template...

Save for Web... Alt+Shift+Ctrl+5
Save Selected Slices...

Revert F12

Place...

Save for Microsoft Office...

Export...

Scripts

Document Setup... Alt+Ctrl+P
Document Color Mode 2
FileInfo... Alt+Shift+Ctrl+1

Print... Ctrl+P

Exit Ctrl+Q
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MEYEE BuiGpas nnoTTep, NOMecTUTb 06LEKT B TEBOM HIDKHEM YITIy.

Print Preset: Custom

Printer: | RXII

General
Copies: [

Artboards:

Ignore Artboards % Skip Blank Artboards

Media Size: Defined by Driver -

Orientation:

Op

Print Layers: Visible & Printable Layers
F'Ia-:erruant:

Scaling: Do Mot Scale

Scale:

Done Print Cancel

MEYELE Pa6ota 3aBepLueHa.
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ﬂ06aBﬂeHMe nPMBOAOOYHbLIX METOK NO CTpaHuuUe
YT106bl CO3AaTb METKU NPMBOAKM NO pasMepy CTpaHWULbl, CrneayeT BblAENUTb OO bEKT,

BbINOMNHUTL KOMaHAy Scripts n3 meHio File n Beibpate AASI_Plug_In.

Select Effect View Window Help 2 [ H4

Ctrl+M
:

Ml .ai* @ 74% (CMYK/Preview) =

Edit Object Type
Mew...
Mew from Template... Shift+ Ctrl+M

Open... Ctrl+ O

Open Recent Files 3
Browse in Bridge... Alt+ Ctrl+ O

Ctrl+W
Ctrl+5
Shift+ Ctrl+ S
Alt+Ctrl+S

Close

Save
Save As...

Save a Copy...
Save as Template...
Save for Web...

Alt+Shift+Ctrl+5

Save Selected Slices...

Revert F12

Place...

Save for Microsoft Office...

Export...

: I-‘ l Scripts 1

ExportDocsAsFlash
Document Setup... Alt+ Ctrl+P ERE i '
Deocument Coler Mode 3 ImageTracing
File Info... Alt+Shift+Ctri+1 SavebocAsEDE
SaveDocsAsSVG
Print... Ctrl+P _AASTL Plug_In
Ei e Other Script... Ctrl+F12
YctaHosuB pnaxok Make by page size, LWenkHyTb
Ha kHonke Apply (MpumeHuTs). B YeTbipex yrnax ¥ Make by Page size
CTpaHMUbl aBTOMaTU4E€CKM CO30a0TCA METKA ¥ 4+ont Faisinoning |
Pe-Fa Yrat Tyge evdl iPal 'me. mudve HE 1/ [ Hh

Length{mm): ZEZ (0-s0)
Thidnessom): [N (1.9)
Margir(mm): _ (0~50)

Segmental Poisitioning |

xStep(mm):  ETINEN (200~600)
YStep@mm):  ETISEN (200~600)

Exeaute —————————
’7 Apply Cancel

MpumeyaHue.
AnuHa meTkn coctasnsieT ot 10 go 50 MM, B 3aBUCMMOCTM OT pasmepa CTpaHULbI.
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GCC... Expert Il. PykoBoacTtso

Paboyasa obnactb

Mo3BonsieT peAakTMpoBaTh U Bbipe3aTb M306paXxeHns 3a rpaHnuaMy NPUBOAOYHbLIX METOK MpU
ycrioBun oGaBneHnst MeTOK Mo CTpaHuue.

[Ons maTtepunanoB A4 paboyas o6nacTb Ha 2,5 MM 3axoauT 3a NPMBOAOYHLIE METKM C NPaBoOn
N NIeBON CTOPOH, Ha 4,5 MM — 3a BEPXHIOI0 MeTKy. PekomeHOoBaHHOE paccTosiHue 0
HWXXHEro Kpas matepuana — He MeHee 25 MM BO u3bexaHue nageHns nucrta u Ha cryyvyan
owmnbkn B pasmepax matepmana.

[Ons maTtepuanoB oopmaTa A3 paboyvasa obnactb Ha 10 MM 3axoanT 3a NPUBOAOYHbIE METKM
C NNeBOWN CTOPOHbI, HA 9 MM — C NPaBon CTOPOHBI, HA 11 MM — 3a BEPXHIOK METKY.
PekomeHOoBaHHOE pacCTosiHWE 0 HUXHEro Kpas Mmatepuana — He MeHee 25 Mm

BO n3bexaHve nageHus nucta U Ha crny4van ownbkn B pasmepax matepuana.

Print Preset: |Cust0m "l

Brinter: | JaguarTv-101 >

PFD:

General

Marks and Bleed Copies: iate [CIReverse Crder
e ®al [JIgnore Artboards
Graphics -
Color Managenment Rarge | | E
Adwanced
Surnmary Media

Size: DEeﬁnEu:J by Drriver v |

wat: s e s | 0@ BE

Options

Left side Placement: % |opt | ¥: Jopt |
(® Do Mot Scale
fogside Bottom sid® | (it o page  (483.8058%)
() Custom Scale: W |:| B H:
Origin RIGICSIE ;
o O Tile Overlap:
wim 8 sl ]
4 4 {10f1(L) b bl ) | |
Print Layers: |Visible & Printable Layers \'l
[ Print | [ Cancel | [ Done |

NMpumeyanue. [Ina pa3amoTku pyroHa BbibpaTb pexunm Edge npm HacTponke dopmaTta
maTepuana. Npu pabote B pexmme Single nuct matepuana Henb3s NepemMecTuTb
Ha3agd, a 3HaunT, PpoHTanNbHbIN AaTymK Bymaru ero He pacrnosHaeT.
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Nob6aBneHne NPUBOAOYHBLIX METOK MO OO BLEKTY

Mpwn nob6aBneHnn NPUBOAOYHbLIX METOK N0 06BLEKTY Ha BbIGOP AOCTYMHO TpU BapuaHTa.

Bbliaenve nsobpaxeHune, KOTOpoe Hy>KHO 0603Ha4YMTb METKaMK, BbINOMHUTL KOMaHAy Scripts
n3 meHto File n Boi6pate AASII_Plug_In.

Select Effect View

Ctrl+N
Mew from Template... Shift+ Ctrl+ M
Open... Ctrl+ 0

File = Edit

Object  Type

New...

Open Recent Files 3
Browse in Bridge... Alt+Ctrl+ 0

Ctrl+W
Ctrl+5
Shift+Ctrl+5
Alt+Ctrl+5

Close
Save

Save As...

Save a Copy...
Save as Template...

Save for Web...

Alt+Shift+ Crl+5

Save Selected Slices...

F12

Revert

Place...

Save for Microsoft Office...
Export...

GreatCut 3

Scripts ExportDocsAsFlash
i 3

Document Setup... Alt+Ctrl+P Flex Skins
Document Celor Mode > ImageTracing
File Info.. AltsShiftCtrl+1 Saieac e

SaveDocsAsSVG
i aER _AASIL_Plug_In
== S Other Script... Ctrl+F12

dnaxok Make by page size cnefyeTt CHATb, a 3aTeM yKasaTb HY>XHbIW TUM NPUBOLAOYHbIX
METOK.

Make by Fage size

' 4-Point Poisitioning |

gt w0
Thickness{mm): 12
Margin{mm): _ (0n~50)

Segmental Peisitioning |

xstepGund: - EITNI (200~G00)
Yatep(m): NN (200~500)
Multiple Copies |

e (1~50)
Ne. of Y Copies: (1~50)

Caopies with outline

Exeaute ——————
’7 Apply Cancel
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TpVI TUNna NnpuBoAOYHbLIX METOK

Mo3nunoHnpoBaHuMe No 4 ToYKam

2 TAASI. Reg_Markc 10-01 N S

M 4-Point Positioning

¥ 4-Point Poisitioning | ® |ength: gnvHa meTok

- [wana3soH: ot 5 go 50 mm
-  OnTtumarnbHo: 25 Mm

eratom: I (co~s0)

icessm): (1~2) ® Thickness: ToNwWMHa NVHUN METOK
Mergniom): - I (0~50) > [Ouana3soH: oT 1 40 2 MM
Segmental Poisitioning | -2 OntmaneHoO: 1 MM

® Margin: pacctosiHue Mexay MeTkamu 1
1oiml G 20-50) n3obpaxxeHNnaMn
o N omo~600) > [Ownanason: ot 0 go 50 MM
e — - OnTtumanbHO: 5 MM

Mo. of X Copies:
Mo. of ¥ Copies:

Copies with autline

Exeaute ———
|7 Apply Cancel

I'Iporpamma co34acT 4 MeTKM, Kak NokasaHo Ha PUCYHKE HWXKE.

b

Moayneb lllustrator A-4



GCC... Expert Il. PykoBoacTtso

NMpumeyaHue.

1. [ns 3KoHOMMM MaTepurana npu No3nLMOHMPOBaHMUN MO 4 TOYKaM OOMyCKaeTCsl MEHATb
He TOSIbKO Nosis 00bekTa, HO U ASIMHY NPUBOOOYHBIX METOK (HE MeHee 5 MMm).
PekomeHgauum ansa pasnuyHbix oopmaTtoB cM. B Tabnuue 1. Yem meHbLle pasmep, Tem

MEHbLUNM A0SKHO ObITb paccTosiHne Mexay 06 beKTOM U NPUBOLOYHON METKOW (CM.
pacyeTbl HUXe).

J

25mm 5mm
dopmat cTpaHuLibl, B MM PekoMeHayemas annHa MeTku, B MM
A6 (105 x 148) 5
A5 (148 x 210) 8
A4 (210 x 297) 11
A3 (297 x 420) 16
A2 (420 x 594) 23
A1 (594 x 841) n 6onee 25%

Tabnuua 1
*25 MM — pekoMeHOoBaHHas AnvHa NPUBOAOYHON METKM

2. Pasmep NnpnBOAOYHLIX METOK BJIMAET Ha TOYHOCTb pacCno3HaBaHUA, NO3TOMY He crieayeT
aenartb UX CIMWKOM MENKNMn

3. lNpun n3ameHeHumn oopmaTta Gymarm Heob6xoaMmo ykasaTb HOBbIE 3HAYEHUS 4N
NPUBOJOYHBIX METOK, MHAYe MPUMEHSIIOTCH TEKYLLIME HACTPOWKM.
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Mo3numoHnpoBaHue No cermMeHTam
[1ns BLICOKOTOYHOWM pe3kn pekoMeHayeTcs BblbpaTb pexmum Segmental Positioning, nosbicus
TOYHOCTb 06PabOTKM ANNHHBIX Y KPYMHOOPMAaTHbIX N300paKeHUN.

' Make by Page size
4Point Poisitoning | Segmental Positioning
gt R o0 ® X Step: pacctosiHMe NPOMEXYTOYHOrO NOSTOXKEHUS
Thickness(um): [ (1.7 no ocu X
marginGo): R (o~s0) ® Y Step: paccTtosiHue NPOMEXYTOYHOrO NOSIOXKEHUS
no ocm X
- [Ownana3soH: ot 200 go 600 mm

-  OntumanbHo: meHee 500 Mmm

¥ Segmental Peisitioning |

¥Stepmm):  ESIN (200~600)
Ystepmm):  ETINNN (o00~600)

Exeaute ———————
’7 Apply Cancel

I'Iporpamma CO30acCT METKM, KaK NMNoKa3aHO Ha PUCYHKE HNXE. Mo cermeHTam
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Co3paHue Konuun
MepekntovaTens Multiple Copies noBbilwaeT TOYHOCTb pe3a B cryvasx, korga u3 matepuana
Heob6xoaMMO MOMYYMUTb HECKOIIbKO 3K3EMMNSAPOB O4HOIO N300paXKeHUs.

(75 AAST_Reg Mark S v210-01 [

Make by Page size

4-Point Poisitioning |

Length(mm):  ECJNNN (10-50)
Thidness(mm): (1~2)
Margin({mm): _ {0~50)

Multiple Copies
® No. of X Copies: KonmyecTBo konuu rno ocn X
® No. of Y Copies: konuyectBo konuu rno ocn 'Y
SeamentaFasitonns { - [Owana3soH: ot 1 go 50 (4em Gornblue Konui,
xsteprm):  CINEN (200~500) Tem GornbLue BpeMEHU HYyXXHO Ha nepegady
¥ Step(mm): 500 [N ,D,aHHbIX).
 Multiple Copies | -  KonunyectBo konun X * konudecTtso konun Y
= obLee KoNnM4ecTBo Konuin n3obpaxxeHns

Mo. of X Copies: _ {L~50) . . .
®” Copies with outline : Ans oTobpaxeHUs KOHTYPOB

No. of ¥ Copies: _ {1~50)

Copies with outiine

n3obpaxxeHus
® Margin: paccTosHne mexgy MeTkamu; OOSMKHO

Exeoqute ———
( Apply Cancel ObITb 0 N = 20; oTpruaTenbHble 3HAaYEHUS He

[onyckatTcst

A

Mporpamma co3aacT pe3ynbTaT, Kak MoKa3aHo Ha PUCYHKE HUXKE.

Moayneb lllustrator A-4



GCC... Expert Il. PykoBoactso

UHcTpyKumua no nogknrovyaemomy moayno GreatCut

PykoBoacTBO nonb3oBatens nporpaMmHoro moayns GreatCut gocTtynHO Ha yCTaHOBOYHOM
DVD-gucke GCC.

Cuctema GCC AASII

Hwxe npuBeaeHa nowaroas MHCTPyKLUMs no pabote ¢ dyHkumen AAS B nporpamme GreatCut
yepe3 CorelDRAW un Adobe lllustrator.

PenaktnpoBaHue nsobpaxeHun B CorelDRAW

Mo3nunoHnpoBaHume No 4 Toykam
MTEYE] Cosnath HoBelii haiin B CorelDRAW. HaxaTb Ha 3Hauok Create contour (Co3aaTh
KOHTYp) Ha naHenu GreatCut — nosaBuTca aBTomatmyeckm nocrne 3anycka CorelDRAW.

;\! CorelDRAW X8 (64-Bit) - Untitled-1
File Edit Miew Layout Object Effects Bitmaps Text Table Tools Window Help

fH-@8 P B 5 BRI e 2% |- M IS8 2 swplov £ ] Launch -
%[148.506 mm | wa[231.1%4mm  |[1000 |% olmwm = | e o =
B V. 113961 mm §[13.2mm | 000 % & O[00 C = N sy IS =

AJEE e 4 P 05 4

Q“'AH_ Createcontcurll' == . == e o .
&L P T e e o e R s o OIS i i L A i o e i ETIEL O PR g et o S e o

X

N BUOG > OO0 GLH
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GCC... Expert Il. PykoBoactso

[ITEY®] HacTponTb napameTpbl KOHTYPa, BKMOYAs CMELLEHNE KOHTYpa, U NOATBEPANTL KHOMKOM
Calculate (Pacuer).

Contour Line X CMelLeHne KOHTypa —
Find Contour Litar paccTosHne Mexay 06bekTom
Masi | 7 |z y
ST gray el El - W NHUEN KOHTYpA.
< >
Backaground 5 R
recogrition Tolerance 0O e
Accuracy: Wy high [zlower] ~

[ ] Keep interior elements

Dizgtance and Line Guidance Extended...

Contour offset: m
Cancel
Carrer Marmal L

\ 4

K nsobpaxeHuam 6yayT nob6aBneHbl KOHTYPHbIE FIMHUN.

L\! CorelDRAW X8 (64-Bit) - Untitled-1
File Edit View Layout Object Effects Bitrnaps Text Table Tools Window Help

FEe~-dd Fy B 5~ B O[] 5% ~ B o B -7 SmapTo v {3} [ launch ~
%[148253mm | wn[236402mm | [100.0 |% [P = | - =
B V. 113309 mm § 178a05mm | 1000 % B O[00 oa g 5§ oo0rmm Dl &5

R, B E 2 4 e’ 05D 4
ﬁ»‘ - Untitleﬁ-1

N RIS S S . S ., . [yt TR s e AT e e Tt Bl

i R e

9

ONBOG » 000cx @o4
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GCC... Expert Il. PykoBoactso

CoBeT: 3aKkpyrieHHbI KOHTYP ANs BEKTOPHOro o6bekTa

®yHkuma Outline (KoHTyp) noBbiwaeT kKadecTBO 006paboTKn BEKTOPHBLIX OOBHEKTOB.
Ha ocTpbix yrnax saameTHa pasHuua mexay sapnaHtamm Normal (CtaHgapT) u Round
(Co ckpyrneHuem). CM. pucC. HUXe:

AN

CranpapTt Co ckpyrneHuem

1. KHonkown Create outline cozgatb BOKpYr TEKCTOBbIX 06BHEKTOB KOHTYpPbI HA cCBO60OAHO
3ajaBaeMOM PaCCTOSHUN.

Outline ‘[ B |
___________________________________________________ ICIffS&tZ Iz_uu mn-l [ Automatic welding
GreatCut3 x [~ Delete criginal
o e = - Copies: 1 . .
R T Eu’mbﬁ 5 P [~ Ignore inner objects
|
(" Outline " Do not modify comers [ 4%
{* Inling (" Cut corners —

iy
(" Qutline & Inline | fl'“\rlﬂuund COMMmers |

Target I

Delete objects -
smaller than: 200 mm |Tolerance (0] || DD ~

2. BoibpaTtb Round corners n ykasatb napametpbl Offset n Tolerance.
Offset — pacctosaHue mexay BHYTPEHHUM N BHELLUHUM KOHTYPOM MCXOOHOrO
obbekTa. B none Tolerance yka3zaHo, Ha KAKOM pacCTOSIHUM OT YrNTIOBOW TOYKM
CKpYrnsieTcs cpes.
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GCC... Expert Il. PykoBoactso

[ITEYE) HaxaTb 3Havok Settings Ha naHenu nHcTpymeHToB GreatCut.

E CorelDRAW X8 (64-Bit) - Untitled-1
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help
=20 B o~ B[ o] M E [ ek | Bl -
il297.0 v \ =7 | ®[50 v

A4 '%210.0:2 — [0 o |Ba| Do Units:| millimeters | &+ [01mm | 2 Q':S.D:x = Hlimy
(WL B B ER n e s |17

Untitled-1

! e : i . o . i . s . . s
137
Q#
(]
il ]
D o
G,
Q 2]
A
Vel
0o
2
Z,
S

]

3

oA ;
(-12.108, 218.893) D

MEYE HaxaTb kHonky crnipasa oT nons Jog marks.

Settings et
Eurosystems Software: -Gn_aatlD.rt 4 e
N\
Jog marks: |GCC{P~H.5 Iy ( ) |
N
Export Path: | |

Mame of layer for Jog Marks: |HEQITIEI|'|‘3 |

Mame of layer for Outline: |OLﬂ|iI'IE |

Qutput Parameters. ..

Show always contour and outline settings
During the cut process only transfer "Regmank™ and "Outline™ layer
Create new file while cutting [

Open output dialog while cutting [

o
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GCC... Expert Il. PykoBoactso

[TEYEE B okHe HacTpoiiku ykasaTb pa3mep, paccTosiHe 40 06bekTa v TONLMHY NIMHNIA
NPUBOAOYHBIX METOK U noaTBepanTb kHonkon OK.

Setup - Register Marks > TMo3numMoHnpoBaHue no 4 Toukam
® Size [InnHa meTok
Type | GCC (AAS I} o - [OwnanasoH: ot 5 0o 50 mm
-  OntumanbHO: 25 MM
®  Object Margin:
DAIign to working area
PaccTtosiHue mexay meTkamm
o 1 N306paxeHnsMM
- [JOwnana3soH: ot 0 oo 50 mm
Ling thickness 1.00 | mp Cutput marks (or by pressing Ctrl)
\{ - OntumanbHO: 5 MM
Max. X dis 00| mm

e [60000]mm  Target ayer [ — ® Line thickness: TonwwmHa nuHUK

@ Align to selection

Object Margin Cutzide corners

METOK
K Cancel - [OumanasoH: oT 1 00 2 MM
-  OnTtumarnbHoO: 1 MM

MMENE Y6enunthes, 4to yeTaHOBNEHLI BCe TpU donaxka Himke, n HaxaTb OK.
Settings *

Eurosystems Scftware: | GreatCut 4 e

Jog marks: | GCC (AAS 1) |

Export Path: | |

Mame of layer for Jog Marks: |HEQITIEI|'|‘3 |

Mame of layer for Outline: |0Ut|il'IE |

Qutput Parameters. ..

Show always contour and outline settings
During the cut process only transfer "Reagmank™ and "Outline™ layer

Create new file while cutting [/]

Open output dialog while cutting [

Cors
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GCC... Expert Il. PykoBoactso

Haxatb 3Hauok Set Jog Marks Ha naHenu nHctpymeHTtos GreatCut.

ﬂ CorelDRAW X8 (64-Bit) - Untitled-1
File  Edit View Layout Object Effects Bitmaps Text Table Tools Window Help

frH-da B O~ B LMy 2 - B swlov & F]tanch

_ O2970mm [+« e = |
Ad IO/zi00mm |+ = |:| (| |:|'1'J_-| [|u[| Units: | millirmeters o 01 mm | /5.0 mm

, |
Y

|
%

RS

bl

i

B OiES X GD

N BUOg9

[Mporpamma co3gacT 4 MeTKM, Kak NoKa3aHO Ha PUCYHKE HUXKeE.

ﬂ CorelDRAW X8 (64-Bit) - Untitled-1
File  Edit View Layout Object Effects Bitmaps Text Table Tools Window Help

fE-dda - B LM E 3% |- m B swhv & b -

A3 - % ;;ggm: = |:| O q11_-| [|u[| Units:| millimeters = 4@' 0.1 mm Y Ml = D;

| B /50mm v -

JEHE 2P DD A

A Untitled-1

>

i R A i

TR

e sy

PN BUE P OO0 X |G O ¢ |57
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GCC... Expert Il. PykoBoactso

NMpumeyaHue.

1. [nga akoHOMUK MaTtepuarna npu no3vLMOHNPOBAHUN MO 4 TOYKaM LOMNYCKAETCs MEHSATb He
TONbKO Nonga o6bekTa, HO U ANUHY NPUBOAOYHbLIX METOK (HE MeHee 5 Mmm). PekomeHngauum
AN pasnuyHbix opMaTtoB cM. B Tabnumue 1. Yem mMeHbLue pa3mep, TeM MEHbLUMM LOMKHO
ObITb paccTosiHMe Mexay O6bEKTOM M MPMBOAOYHOM METKON (CM. pacyeTbl HUXE).

|

/F'H | O6nacTtb
/ @\wﬂ- S T pesa

- s
L\ |

25mmqp 5mm
CDopmaT CTpaHuUbl, B MM PeKOMGH,D,yeMaﬂ ANNMHA MEeTKHU, B MM
A6 (105 x 148) 5
A5 (148 x 210) 8
A4 (210 x 297) 11
A3 (297 x 420) 16
A2 (420 x 594) 23
A1 (594 x 841) n bonee 25*

Tabnuuya 1
*25 MM — pekoMeHLOBaHHas AnNnHa NPUBOLOYHOM METKM

2. Pasmep NnpnBOAOYHLIX METOK BJIUAET Ha TOYHOCTb pacCrno3HaBaHUA, NO3TOMY He crieayeT
aenartb UX CIMWKOM MENKNMn

Mogaynb GreatCut A-6



GCC... Expert Il. PykoBoactso

BbiBopg
[ITEYE] BLiGpath 06bekT Lenmkom, BKoYas MPUBOAOYHBLIE METKM M NIMHWIO KOHTYPA, U HaxaTb
3Hayok Cut Ha naHenn nHctpymeHToB GreatCut.

E CorelDRAW X8 (84-Bit) - Untitled-1
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help

FfE-d 4 Fy B 5~ B [4] ] 57 |35% ~ W [ B T snaplo v {3} [F] Launch -
¥:[200.753 ven| 205,402 1000 |% : AT
B V. 156299 mm f 2s7405mm | [T000 |% = OL%0 2L S ) e TR 7] = o A

k| H o Iﬁ@ a’ O 0 A4
¢, & Untitled-1
N I R . O

it A A B e T o o

s

RS

oM BLY > OO0 GLH

[MTEYF) Cvictema aBTOMaATUYECKN aKTUBMPYETCA U 3amyCTUT UMMNOPT NPUBOJOYHBIX METOK
n NuHUKM KoHTypa B GreatCut.

[m] X

=l
1
Jake]

'I+_++w 295.40 mm x H: 237 41 mm, Objects: 1 +++ ‘ °!

<

200

| 1
Taaaa
5 33 33 g3 w3

Mogaynb GreatCut A-6



GCC..

Expert Il. PykoBoactso

[ITEYE 13 menio File BbiGpaTh komanay Output (BbiBop).

= GreatCut 4 - [(untitled - 1) *]

=

MBI B okHe BLIG

opa yctpouctea Output to device B none Mode/Tool ykaszaTtb C

New... Ctrl+N
| @ Open... Ctrl+L
Save Ctrl+5 =
Save As... Shift+ Ctrl+5 0 00 200 300 400 500 600 700
Send by Email... SR FETED SR S RO ] B I B L B R S U RS B o TR R S S T SRR S o . B o2 S (e S i B S AR S NEL S o T
Import... Ctrl+|
Export... Ctrl+E
™ Output... 5
Quit Ctrl+Q
] |
= |
il |
: !
. |
. I —|
o ]
8-
=4
=4 |
|
- |
| SRR "1,
x

put to device GCC iarv LA DI

ut with AAS.

? x

Output only tool-azzigned layers
I:‘ Keep reference point
[ Piot to fie
Enable tool tips

D Wait after segment

Save seftings

Output
Device: | GCC Jaguar V LX 61 R MNumber of outputs:
Number of copies:
ode: | Cut with A4S = z
Stack spacing:
& :
Output Profile: | Foil e Ueedbuinee B
Copies spacing:
Manage Profiles ...
arameter
AAS Offset origin X [mm] o.oo
AAS Offzet origin ™ [mm] 0.00
Pressure [g] 15
Speed [cm/g] 50
WMaterial width [mm] 20843
Length [mm] 32018
Number of outputs in X-direction 1
Number of outputs in Y-direction i
Distance between copies [mm] 10.00
Step count 4

YkasaTb ocTasrnbHble
napameTpbl: AAS Offset,
Pressure, Speed, Material
width v np.

Job wil be segmented!

Preview... Output

Read material

Sort Options
Accuracy: E Normal e
Origin: | New origin a |
Objects: | All objects ~
Test drive
Cancel

Mogaynb GreatCut



Expert Il. PykoBoactso

Output

Device: | GCC Jaguar V LX 61

Mode: | Cut with AAS

Output Profile: | Foil

Manage Profiles ...

Mumber of cutputs:
Number of copies:
Stack spacing:

Weed border:

Copies spacing: mm

Parameter

AAS Offzet origin X [mm]

AAS Offzet origin ' [mm]
Pressure [g]

Speed [cm/s]

Material width [mm]

Length [mm]

Number of cutputs in X-direction
Number of cutputs in Y-direction
Distance between copies [mm]
Step count

Value
0.00
0.00

15
50
208.43
32018

10.00

Preview...

Job will be segmented!

Output

Read material

MEYEE HaxaTtb Output — 06bekT 6yaeT oTnpaBneH Ha pexyLuwii nnoTtep GCC.

? X
Output only tool-assigned layers
D Keep reference point
[ Piot to file
Enable tool tips
|:| VWait after segment
Save zettings
Sort bafore output
Actual Setting:
Sort Options
Accuracy: | Normal ~
COrigin: | Mew origin i
Objects: | All objects L
Test drive
Cancel

Mogaynb GreatCut



GCC... Expert Il. PykoBoactso

Mpumeyanune. PasHmua mexagy napameTtpamm Number of outputs, Number of copies n Step
count B okHe Output.

Output

Device: GCC Jaguar V LX 61 h Number of outputs: Output only tool-assigned layers

|:| Keep reference point
[J Piot to file
Enable tool tips

Number of copies:

4
| Y]
Mode: | Cut with AAS ~ TR ﬂmm
Weed border: mm

mm

Output Profile: | Foil

Copies spacing: [ watt after segment
Manage Profiles ... e
Parameter Walue Sort before output
AAS Offset erigin X [mm] 0.00 o
AAS Offset origin % [mm] 0.00 Actual Setting: nj
Pressure [g] 15 It %4
Speed [cmiz] 50
Waterial width [mm] 208.43 S
Length [mm] 320.18 et Shntors
Number of outputs in X-direction 1
Number of outputs in Y-direction 1
i £en copies [mm] 10.00
| Step count 1
Accuracy: | Normal W
Qrigin: | New origin w
Objects: | All objects R
Job will be segmented Test drive
Preview... Output Read material Cancel

1. 3HadeHne napameTpa Number of outputs — 2: kBagpaTt 1 TpeyronbHuK
Bblpe3atoTcs 1 pas, a 3atem 0be curypbl BoipesatoTcst 1 pas B crieaytoLlen
no3nuun.

2. 3Ha4veHne napameTtpa Number of copies — 2: kBagpaT 1 TPeyrofibHUK Bblpe3atoTcs
2 pasa B TOM e Mno3unLmun.

3. BHaveHne napameTpa Step count — 2: kBagpaT Bblpe3aeTcd 2 pasa B O4HOM
no3nunn, TPEYronibHUK Bbipe3aeTcs 2 pa3a B OAHOM NO3ULMMN.
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GCC... Expert Il. PykoBoactso

PacwupeHHaa HacTpouka

Mo3uumoHnpoBaHMe No cermMeHTam
[1ns BLICOKOTOYHOM pe3kn pekomeHayeTcs BblbpaTb pexnum Segmental Positioning, noBbicus
TOYHOCTb 06PabOTKN ANMNHHBIX U KPYNMHOMOPMATHLIX N306paKeHUI.

[na HacTponku NMHUK pesa U Co3aaHnNs NPUBOAOYHbLIX METOK NOBTOPUTL LLArM U3 pasgerna
lMo3numnoHupoBaHue no 4 Toykam. B okHe HacTponku ykasaTb pa3mep, paccTosiHue OT MeTOoK
00 06bekTa, TOSMLWUHY JIMHUI NPUBOAOYHBLIX METOK, PACCTOSHUE MexXay MeTKaMu

n noaTeepanTb kHonkon OK.

MMEYE] HaxaTb sHauok Settings Ha naHenu nHcTpymenToB GreatCut.

ﬂ CorelDRAW X8 (64-Bit) - Untitled-1
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help

*r-d g - B WM [ |- W B0 s £ F L -

_|El2970mm [+« . = =7 | ] ®/somm |- -
Ad iO2100mm |- = |:| [ q_"h |:|n[| Units: | millimeters 0r | 0.1 mm = D;

N BB Y4 P e O 4
- Untit|e_d-1 _ _ Settings

Ty O T Bl SR W e e B e o e i :

.

w

.

||J..l.

ts,
I-r
Q
O
A
O

L
©)

L

O,
A
ko)

W
1000

W

N B U

» A
(-13.108, 218.893)  » aD
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GCC... Expert Il. PykoBoactso

MMEY®) HaxaTb kHonky cnipasa oT nons Jog marks.

Settings by
Eurosystems Software: | GreatCut 4 w

Jogmarks: | GCC (AAS ) | O
Expott Path: | |

Name of layer for Jog Marks: |F~!egmark |

Name of layer for Outline: |0Ut|il'IE |

CQutput Parameters...

Show always contour and outline settings
During the cut process only transfer "Regmark” and "Outline” layer
Create new file while cutting []

Open output dialog while cutting []

=

MY B okHe HacTpoiiku ykasaTb pa3mep, paccTosiHve 40 06bekTa v TONLLMHY NIMHWIA
NPUBOAOYHbIX METOK 1 NoaTBepanTb kHomnkon OK.

Setup - Register Marks >

Type |GCC (AASI) w
|_|O3I/IL|,I/IOHI/IpOBaHI/Ie no cermeHTam

(S} Sl e ® Max. x Distance: paccTosiHune

O Align to working area MPOMEXYTOYHOTO MOMOXEHUS

Size 25.00 | mm no ocn X

Object Margin i Outside corners
[OnanasoH: ot 200 go 500 mm

» ® Max. y Distance: paccroaHue

Line thickness

mm Output marks (or by pressing Ctrl}

2=
=
=

Max. X distance

Max. ¥ distance Target layer | ] v| NPOMEXYTOHYHOro NoJioKeHus
no ocn X
0K C |
= i JunanasoH: oT 200 Ao 500 mMm
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GCC... Expert Il. PykoBoactso

MEYE V6enmthbes, 4TO ycTaHOBNEHBI BCE TPU donaxka Hike, n HaxaTb OK.
Settings x

Eurosystems Software: -Great_D.rt 4 w

Jogmarks: |GCC (AAS 1I) |

Export Path: | |

Mame of layer for Jog Marks: |HEQITIE""‘I |

Mame of layer for Outline: |0Lft|il'le |

Output Parameters. ..

Show always contour and outline settings
During the cut process only transfer "Regmark™ and "Outlineg™ layer

Create new file while cutting

Open output dialog while cutting [

Cores

MEYEE Haxatb sHavok Set Jog Marks Ha naHenm uHcTpymenTos GreatCut.

ﬂ CorelDRAW X8 (64-Bit) - Untitled-1
File  Edit View Layout Object Effects Bitmaps Text Table Tools Window Help

fH-d8 B O~ W EME e - W SB[ sebr O F L -
2970 -~ ... N =7 | Bf50 -~
A4 - % 3100 m: T |:| O q11_-| [|u[| Units:| millimeters = <0r 0.1 mm ) q_: <0 mx azn Dk

ol e 0D 4

R |
Set Jog Marks |

i fish i

[u]

S e e

ONBOG > 000X GOo4
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GCC... Expert Il. PykoBoactso

I'Iporpamma CO30acCT METKM, KaK NoKa3aHO Ha PUCYHKE HUNXeE.

E CorelDRAW X8 (64-Bit) - D:\GCC-Cutter\GreatCut 4\Untitled-1.cdr
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help

i R * I B - B [0 E i v W R BT SvepTo v O3

LI ot fa € 2 “TMosyumMoHNpoOBaHNE MO cerMeHTam
B 4P DDA

g, & Untitled-1.cdr
- o

N ....‘/ B T A 01 D 1 S

™

A A A e B

0

SN BLG > 000X GOoH

[ns otnpasku dparna Ha pexywmin nnotrep GCC nosTopuTh Warn 13 pasgena BeiBoA.

Co3paHue Konun

MTEY] [1ns HacTpoiiky NMHMK pe3a 1 co3aaHNs MPUBOAOYHLIX METOK MOBTOPUTS LAy 3
pasgena MoanmumoHnpoBaHue no 4 Toukam.
Setup - Register Marks >

Type |GCC (AAS I -

@ Align to selection

— —_ ~_ [pu paboTte ¢ yHKUMen

: Multiple Copies npumeHsitoTca
y) Outside corners

|81 mm Output marks (or by pressing Ctrl)
Max. ¥ digtance S00.00 | mm

Max. ¥ distance 500.00 | mm Target layer |f_ v|

Size

Object Margin
: napamMmeTpbl, YKa3aHHbl€ B 3TOM

pasgene.
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GCC... Expert Il. PykoBoactso

[MEY®] HaxaTb 3Hauok Set Jog Marks Ha naHenm uHcTpymeHToB GreatCut: 6yayT cosgaHbi
4 MeTKW, KaK Ha PUCYHKE HIXe.

ﬂ CorelDRAW X8 (64-Bit) - Untitled-1
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help

fEH-ddo - W ORI 2% |- W SB[ sl & [ Lunch -

_| Ol2970mm [~ - .. [ = |
A4 02100 mm |~ = |:| O q_"h |]n|:| Units:| millimeters Qv 0.1 mm =!| B[50 mm azm,

\,Fff'ﬁ f° & O 2505 A4
»{h Untitl_e_:f-‘l .

i e SRS et Sl

I o e

BOF > 000 X |G O

LN

ﬂ CorelDRAW X8 (64-Bit) - Untitled-1
File Edit View Layout Object Effects Bitmaps Text Table Toocls Window Help

Fr-do B Y- B LM E 3% - w2 E L swhe O v

= 0j|4200mm |~ - o = | a = T/5.0mm v
A3 02970 mm |- = |:| O q:h |]n[| Units: | millimeters a0r 0.1 mm - ®[50mm azn [1
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A Untitled-1
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GCC... Expert Il. PykoBoactso

Bbi6paTh 06BEKT LEENMKOM, BKMOYas NPUBOAOYHbBIE METKM W MIMHUIO KOHTYPa, U HaXxaTb
3Hayok Cut Ha naHenn nHctpymeHToB GreatCut.

E CorelDRAW X8 (64-Bit) - Untitled-1
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help

FhH-@0 BBk 5.0 B UM e [+ 8 B e & F s -
¥:[200.753 wat| 205,402 1000 |% ] I
Eg ¥: 155399:: ¥ [237.405 :: 1000 |% & O 0.0 8 L 2 I'I_‘__| L1_";| D % ] L‘_l % {Ij\ 52 @ X :qh.x

YR IR A i e

¢, A Untitled-1 [l
, Cut
ez oml w0 w0 7 R A i O

A e S e R e A

\li.l._]

S R e A

oN BOS > 000N GO

MR Cuictema aBTOMATUYECKM aKTUBMPYETCS U 3anyCTUT UMMOPT NPUBOAOYHBIX METOK
n NuHUKM KoHTypa B GreatCut.

i
c

|
[m]
X

50
L

=
w
S
7
b3
=

sakeT

>

<

|
_
i

|+ W 295,40 mm x H: 237.41 mm, Objects: 1 +++
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GCC... Expert Il. PykoBoactso

[MEYEE 13 menio File BbiGpaTh komanay Output (BbiBog).
== GreatCut 4 - [(untitled - 1) Ei -

M B Edit Design View Tools

MNew... Ctrl+M
Open... Ctrl+L
Save Ctrl+5
Save As... Shift+ Ctrl+5

Send by Email...

Import... Ctrl+I
Export... Ctrl+E
Print... Ctrl+P
Al =T Output... S
Quit Ctrl+Q

MEE B none Mode Bbibpath Cut with AAS, ykasaTb KONMYECTBO M3Aenuii No ocsiM X
1Y, paccTosiHue Mexay konusmu. KHonky Output He HaxxumMaTb.

QOutput to device GCC i
Output
| ) -
Device: ’GCC Craft v] Number of outputs: 1 Output only tool-assigned layers
| Number of copies: 1 Keep reference point
| Mode: [Cut with AAS -| _ [ Pint to fiie
4 Stack spacing: 5.00 mm
Enable tool tips
Output Profile: ’ Fail - ] D LR TS 2.00 /mm |:| Dizable sending of technology data
Copies spacing:  2.00 mm [ Wait after segment
[ Manage Profiles .. ] Segment spacing:  0.00 mm
Parameter Valug Sort before output
AAS Offset origin X [mm] 0.00
AAS Offset origin % [mm] 0.00 Actual Setting: IU
Pressure [g] 80 t
Speed [cmis] 29 [] search for best Sort Method
Material width [mm] 20843
Length fmmi] 32018 whiogs
Mumber of outputs N J-dire ction 2
Number of outputs in Y-direction 2
Distance between copies [mm] 0.00
Step count 1

Accuracy: | Normal

Qrigin: | New origin

II

Objects: Selected objects -

Job will be segmented! Test drive

Output Read material Cancel

BepHyTbcs B CorelDRAW. BeinonHuTs File > GreatCut > Multi-Copy.
A, B[E e 4 e O b A4

N A& Untitld Multi-Copy
el 4

ET= ] 150
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GCC... Expert Il. PykoBoactso

m Ykasatb napametpbl Number in X/Y (konnyectBo konuii no ocsim X n Y), pacctosiHne
Distance in X/Y (pacctosiHne mexay konuamu). Haxate OK. Y6eantbcs, 4To 3HaYeHue
Distance in X/Y coBnagaet ¢ yka3aHHbIM B Liare 6.

Pulti-Copy et
MNumberin X |2 24
Numberin Y |2 =
Distance in X |0.00 = mm
Distancein ¥ |0 = mm
Distance to object
Cancel

MpumeyvaHue. PaccTtosHne no ropusoHTanu u Beptukanu (Offset X & Y) 4omxHO 6bI1Tb = 20 MM
nnm = 0 mm. PekomenpyeTca yctaHaBnueaTb napameTp Distance in X/Y Ha 0 MM, 4TOGbI
He genaTb MPOMEXYTKOB MeXay KONUAMU A5 SKOHOMUWM MaTepuana.

MMEYE) Nporpamma coanacT Hackonbko Konuii 06bekTa ¢ MPUBOAOYHLIMU METKaMM, Kak
MOKa3aHO Ha PUCYHKe HIXe.

m CorelDRAW X8 (64-Bit) - C\Users\jim.you\Desktop'\Untitled-1.cdr
File  Edit View Layout Object Effects Bitmaps Text Table Tools Window Help

Fo-ddg &S~ OO (s [+ E B[S e © F e -
Sil1.120.0 == e . — | ®[50 =
AD MEEETT mr;m =2 0 oo Bl Units| millimeters ~ <@ 01mm | 2 q,‘: 0 mm = I

60 &0

.Ili'l I.

R e R

ONBOG » 000N GO
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Expert Il. PykoBoactso

MEYET) OtnevataTth konum n3oBpaxeHui,

nnotrep GCC.

LY corelDRAW X8 (54-Bit) - Untitlec

Edit View Layout Ob

5]

oE &0 T

gi]

SN~

New...
MNew fi
Open.
Open
Clase

Close

Save...

Save As...

Ctrl+N
rom Template...
" Ctrl+0

Recent »

All

Ctrl+s
Ctrl+Shift+S

Save as Template...

Acguire Image 3

Search Content

Impaort...
Export...

Ctri+l
Ctri+E

Export For 3
Send To [

Publish to PDF

Print...

Ctri+p

Print Merge 3

Print Preview...

Collect For Qutput...

Document Properties,.,

Exit

Alt+F4

mMaTepuan c oTne4yaTkaMu 3arpy3uTb B peXyLLUit

MEYEE] B okHe GreatCut HaxaTb kHonky Output.

F
Qutput to device GCC i

Output

Output Profie: i

Device: | GCC -Craft

Mode: [cm with AAS

[ Manage Profiles ... ]

Number of outputs:
Number of copies:
Stack spacing:

|:| Weed border:

Copies spacing:

Segment spacing:

5.00 mm
2.00 mm
2.00 mm

0.00 mm

Parameter

AAS Offset origin X [mm]

AAS Offzet origin Y [mm]
Presszure [g]

Speed [cmis]

Material width [mm]

Length [rmm]

MNumber of outputs in X-direction
Number of outputs in *Y-direction
Distance between copies [mm]
Step count

Value
0.00
0.00

20
21
208.43
32018

0.00

Preview...

Job will be segmented!

Output r|

Read material

Output only tool-assigned layers
Keep reference point
[T Piot to file
Enable tool tips
D Dizable =ending of technology data
|:| Wait after segment

Sort before output

Actual Setting:

n

[T] search for best Sort Method

Sort Options

Objects: Selected obiects -

Test drive

Cancel

Mogaynb GreatCut
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Expert Il. PykoBoactso

P

enakTupoBaHue nsoopaxeHum B Adobe lllustrator

Mo3nunoHnpoBaHMe No 4 ToYKam

MEYE] Cosnathb HoBbI dhaiin B A

File | Edit Object

Type

Mew...

MNew from Template...
Open...
Open Recent Files

Browse in Bridge...

Close

Save

Save As..

Save a Copy...

Save as Template...
Save Selected Slices...

Revert

Search Adobe Stock...
Place...

Export

Export Selection...
GreatCut 4

Package...
Scripts

Document Setup...
Document Color Mode

File Info...
Print...

Exit

dobe lllustrator.

5 = - O -

greatcutd user manual photo.ai* @ 85.56% (CMYK/GPU Preview) X

Ctrl+M
Shift+Ctrl+ N
Ctrl+O

Alt+Ctrl+ O

Ctrl+W
Ctrl+5
Shift+Ctrl+5
Alt+Ctrl+5

F12

Shift+Ctrl+P

Alt+Shift+Ctrl+P
>

Alt+Ctrl+P
-}
Alt+Shift+Ctrl+|

Ctrl+P

Ctrl+Q

/GPU Preview) X

Direct cutting
Contour

Multi-Copy

Set Jog Marks
Outline

Welding

Create Qutline-Layer
Export

Settings

ODnIl =g P& .

£ ®

2 Fell

5

&4

Mogaynb GreatCut
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GCC... Expert Il. PykoBoactso

MY HactpouTh napameTpbl KOHTYpa, BKMOYas CMeLLEeHNe KOHTYpa, U NOATBEPAUTL KHOMKOW
Calculate (Pacuyer).

o D =
| Fird Contour Color |
b awirnum gray scale 97 EA -

4 [ *

- Ch
B ackground Tal 0 o
recognition DEETEE =
P P
Accuracy: [R-fer_u high [zlower] "]

[ Keep interior elements CmeLleHme KOHTYypa —

Diztance and Line Guidance paccTosiHue Mexay o6bHLeKToM
Conbour offset: N NIMHNEN KOHTYpa.

Cormer [Nu:urmal T] /4\

A 4

File FEdit Object Type Select Effect View Window Help [ B E= v 4
2 0001mn v : Opacity: 100% Style: ¥ It~ Transom

greatcutd user manual photo.ai* @ 85.56% (CMYK/GPU Preview)

S
»
! %
T,
O,

N
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CoBeT: 3aKkpyrieHHbIn KOHTYP ANs BEKTOPHOro obbekTa

®yHkuma Outline (KoHTyp) noBbiwaeT kadecTBO 06paboTkn BEKTOPHBIX 06BbEKTOB. Ha
OCTpbIX Yrnax 3ameTHa pasHuua mexay sapuaHtamu Normal (CtangapT) u Round
(Co ckpyrneHvem). CM. pucC. HUXe:

<«

Cranpapt Co ckpyrneHuem

1. BeinonHutsb File > GreatCut > Outline, co3gaB BOKpyr TEKCTOBbLIX 06 bEKTOB
KOHTYpbl Ha cBOBOAHO 3a4aBaeMOM PacCTOAHUN.

Outline ‘&Iﬂ—hj
Offact. ]2_00 mn" [T Automatic welding
" Delete original
Copies: 1
L [ Ignore inner objects
GreatCut 4 > Cut
i - i i Dy t modi
e Alt+ Shifts Cirle P Direct cutting " Outline 0 not modify corners
Rerpt - Contour + Inline " Cut corners
Multi-Copy ™ Outline & Inline Ruund comers
Document Setup... Alt+Ctrl+P Set Jog Marks
Document Color Mode ¥ Buthne I I Target I
File Info... Alt+Shift+ Ctrl+] clete objects
e e EeiliE il Welding e |2.DU mnI Tulerance]lgl; |_j
Print... Ctrl+P Create Qutline-Layer
Exit Ctrl+Q Export Cancel
I @ e

2. BolbpaTb Round corners 1 ykasatb napameTpsbl Offset u Tolerance.
Offset — pacctoaHne mexay BHYTPEHHUM N BHELLHUM KOHTYPOM UCXOOHOro
obbekTa. B none Tolerance ykasaHo, Ha KakOM pacCTOSIHUM OT YIIOBOW TOYKM
CKpyrnsieTcs cpes.

ME Buinonnuts File > GreatCut > Settings.

Mogaynb GreatCut A-6



GCC..

Expert Il. PykoBoacTtso

N

.

.

0%,

¥R

Y
.

File

Edit Object Type
Mew...
MNew from Template...
Open...

Open Recent Files

Browse in Bridge...

Close

Save

Save As...

Save a Copy...
Save as Template...

Save Selected Slices...

Ctrl+MN
Shift+ Ctrl+M
Ctrl+0

>

Alt+Ctrl+ 0

WGPU Preview) X

Ctrl+W
Ctrl+5
Shift+Ctrl+S

Alt+Ctrl+5

Revert F12
Search Adobe Stock...
Place... Shift+Ctrl+P
Export »
Export Selection...
GreatCut 4 »
Package... Alt+ Shifts Ctrl+ P it ity
Ser . Contour
Multi-Copy
Document Setup... Alt+Ctrl+P Set Jog Marks
Document Color Mode ¥ :
Outline
File Info... Alt+Shift+ Ctrl+| Welding
Print... Ctrl+P Create Outline-Layer
Exit Ctri+Q s e
Settings

YL HaxaTtb kHonky crnipasa oT nons Jog marks.

Settings

Eurosystems Scftware: | GreatCut 4

)

Jogmarks: |GCC (AAS 1I)

o
Nt

(

Export Path: |

Mame of layer for Jog Marks: |HEQITIEI|'|‘3

Mame of layer for Outline: |0Ut|il'IE

Qutput Parameters. ..

Show always contour and outline settings

During the cut process only transfer "Reagmank™ and "Outline™ layer

Create new file while cutting [

Open output dialog while cutting [

Cancel

Mogaynb GreatCut
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Expert Il. PykoBoacTtso

MMEIE Vkasats pasmep, paccTosiHie 40 06beKTa 1 TOMLLMHY TMHUIA MPUBOAOYHBIX METOK 1
noaTeepamTb kHonkon OK.

Setup - Register Marks

Type |[GCC (AAS 1)

@ Align to selection

D Align to working area

-
L

-
|

Size mm

Object Margin mm Qutside corners

Line thickness 1.00 | mm Cutput marks (or by pressing Ctrl)
Max. X distance 600.00 | mm

Max. ¥ distance &

ke

0

HI

0.00| mm

Target layer | 1 v|

Cancel

4-Point Positioning
® Size [InnHa meToK
- [mnanasoH: ot 5 0o 50 mm
- OnTumanbHO: 25 Mm
Object Margin: PacctosiHue
Mexagy MeTkamum u
n3obpaxeHnsamm
- [OwnanasoH: ot 0 4o 50 mm
- OnTumanbHO: 5 Mm
Line thickness: TonwmHa NnuHUK
METOK
- [wnanasoH: ot 1 0o 2 Mm
- OntumaneHo: 1 MM

Y6eanThbea, YTO yCTaHOBMEHbI BCe Tpy doriaxka Huxe, 1 HaxaTb OK.

Settings

Eurosystems Software:

Jog marks

Export Path:

Mame of layer for Jog Marks

Mame of layer for Qutline

GreatCut 4

*

. |GCC as

. |Hegmark

. |Out|ine

Output Parameters. ..

During the cut process only transfer "Regmark” and "Outline” layer

Create new file while cutting

Show always contour and outline settings

Open output dislog while cutting []

Cancel

Mogaynb GreatCut
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GCC... Expert Il. PykoBoacTtso

B Buinonnuts File > GreatCut > Set Jog Marks.

File

Edit

Object

Ctrl+N
MNew from Template... Shift+Ctrl+ N
Open... [« PN /GPU Preview) X

MNew...

Open Recent Files »
Browse in Bridge... Alt+Ctrl+0

Close Ctrl+W
Save Ctrl+5
Save As... Shift+Ctrl+5
= - Save a Copy... Alt+Ctrl+5
= Save as Template...
= " Save Selected Slices...
X Revert F12
= ] Search Adobe Stock...
Place.. Shift+Ctrl+P
Z. Export »
E='EL Export Selection...
_b GreatCut 4 3
¥ Package... Alt+Shifts Ctrl+P Rilce: cutmg
: Scripts b iZoeitoat
Multi-Copy
Document Setup... Alt+Ctrl+P Sl
Document Coler Mode » ST
File Infa... Alt+Shift+ Ctrl+| Welding
Print... Ctrl+P Create Outline-Layer
Bxit Cirl+0) part
Settings

File Edit Object Type Select FEffect View Window Help m m = ~ ’J

v v nm Uniform |2 v Opacity:  100%

greatcut4 user manual photo.ai* @ 85.56% (CMYK/GPU Preview) X
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BbiBopg

MTEYE] BLiGpath 06bekT Lenvkom, BKIoYast MPMBOAOYHBLIE METKM 1 JIMHUIO KOHTYpa,
1 BbinonHUTL File > GreatCut > Cut.

File =Edit Object Type Select Effect View

Ctrl+N
MNew from Template... Shift+ Ctrl+ N
Open... Ctrl+0

New...

Open Recent Files ¥
Browse in Bridge... Alt+Ctrl+0

Close Ctrl+W
Save Ctrl+S
Save As... Shift+Ctrl+5
Save a Copy... Alt+Ctrl+5

Save as Template...
Save Selected Slices...

Revert F12

Window Help

intor [l —— oo [

/GPU Preview) X

Search Adobe Stock...
Place... Shift+ Ctrl+P
E
Export b
Export Selection...
GreatCut 4 b
Pkacen Alt+ Shift+ Cerl+ P Hiecteiting
Tt = Contour
Multi-Copy
Document Setup... Alt+ Ctrl+P Setlog Marks
Document Color Mode » -
Outline
File Info... Alt+Shift+ Ctrl+| Welding
Print... Ctrl+P Create Outline-Layer
Exit Ctrl+Q Em
Settings

[MEY®] Cvictema aBTOMAaTUYECKM aKTUBMPYETCS U 3aMNyCTUT UMMOPT NPUBOAOYHBIX METOK

n NuHUKM KoHTypa B GreatCut.

|+ W 295 40 mmx H: 237 41 mm, Objects: 1 +++

Mogaynb GreatCut
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Expert Il. PykoBoacTtso

13 menio File BoibpaTh komanay Output (BbiBog).

st GreatCut 4 - [(untitled - 1) *]

‘i

New... Ctrl+M
Open... Ctrl+L i
Save Ctrl+5 =
Save As... Shift+Ctrl+5 ] 100 200 300
Send by Email... Lol Lo b b b b L
Import... Ctrl+1
Export... Ctrl+E
Print... Ctrl+P
Output... 5
Quit Ctrl+Q
o ]
81
o
. gg
81 =L [ e R

MEY B okHe BuiGopa ycTpoiicTea Output to device B none Mode/Tool ykasats Cut with AAS.

Uu

ut to device GCC Jaguar V

Output

Device: GCC Jaguar WV LX 61

~ | Mumber of outputs:

Number of copies:

T >

Output only tool-assigned layers
|:| Keep reference point
O Piot to file

Mode: | Cut with AAS | :
| Stack spacing:
Enable tool tips
3 W :
Output Profile: | Foil ] bl 22
) Copies spacing: [watt after segment
Manage Profiles ... e
Parameter Value Sort before output
AAS Offset origin X [mm] o.0o oo
AAS Offset origin Y [mm] 0.0o Actual Setting: m
Pressure [g] 15 i
Speed [cm/s] 50
Waterial width [mm] 205843 SnrtO —
Length [mmi] 32018 LT
Number of outputs in X-direction 1
Number of outputs in Y-direction 1
Distance between copies [mm] 10.00
Step count i
Accuracy: | Normal w
Origin: | Mew origin w
Objects: | All objects ~
Job wil be segmented! Test drive
Preview... Output Read material Cancel
Mogaynb GreatCut A-6



GCC... Expert Il. PykoBoacTtso

MEYEE HaxaTtb Output — o6bekT 6yaeT oTnpaBneH Ha pexyLuwii nnoTtep GCC.

0 o ? *
Output
Device: | GCC Jaguar WV L} 61 e Number of outputs: Output only tool-assigned layers
Number of copies: D Keep reference point
Mode: | Cut with AAS Piot to il
ks i Stack spacing: D e
Enable tool tips
Output Profile: | Foil LeEAbinn e
Copies spacing: mm |:| Wait after segment
Manage Profiles ... S
Parameter Value Sort before output
AAS Offzet origin X [mm] 0.00
AAS Offzet origin ' [mm] 0.00 Actual Setting:
Pressure [g] 15
Speed [cm/s] 50
Material width [mm] 20343 e
Length [mm] 33018 et Opbores
Number of cutputs in X-direction 1
Number of cutputs in Y-direction 1
Distance between copies [mm] 10.00
Step count 1
Accuracy: | Normal ~
COrigin: | Mew origin i
Objects: | All objects L
Job will be segmented! Test drive
Preview... Output Read material Cancel

Mogaynb GreatCut A-6
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Mpumeyanune. PasHmua mexagy napameTtpamm Number of outputs, Number of copies n Step
count B okHe Output.

Output

Device:  GCC Jaguar V LX 81 ~ Number of outputs: Dutput only tool-assigned layers

1
Number of copies: 1 |:| Keep reference point
0.00 {mm

Mode: | Cut with AAS ~ [IPiot to file

Stack spacing:
] Enabile tool tips

=

=

7 :
Output Profile: | Foil i Weed border: mm
Copiss spacing: mm ] wait after segment

Manage Profiles ...

Save seftings.
Parameter Value Sort before output
AAS Offset origin X [mm] 0.00 2
AAS Offset origin Y [mm] 0.00 Actual Setting: [U
Pressure [g] 15 I+ &
Speed [cmis] 50
Material width [mm] 208.43 T
Length [mm] 320.18 ot i
Number of outputs in X-direction 1
Number of outputs in v-direction 1
it en copies [mm] 10.00
I Step count 1
Accuracy: | Normal w
Origin: | New origin ~
Objects: | All objects e
Job wil be segmented! Test drive
Preview... Output Read material Cancel

1. 3HayeHune napameTtpa Number of outputs — 2: kBagpaTt v TpeyronbHuK
Bblpe3atoTcsa 1 pas, a 3ateM 06e urypbl Bolpe3atoTcs 1 pa3 B crieqytoLlem
no3numn.

2. 3Ha4veHne napameTtpa Number of copies — 2: kBagpaT 1 TPeYyrofibHUK Bblpe3atoTcs
2 pasa B TOM e No3nLmn.

3. 3HayeHne napameTpa Step count — 2: kBagpaT Bblpe3aeTcs 2 pas3a B 04HON
no3nLMmn, TPEeYronbHUK Bbipe3aeTcs 2 pasa B 0AHON NO3ULNN.

Mogaynb GreatCut A-6
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PacwupeHHaa HacTpouka

Mo3uumoHnpoBaHMe No cermMeHTam
[1ns BLICOKOTOYHOM pe3kn pekomeHayeTcs BblbpaTb pexum Segmental Positioning, noBbicus
TOYHOCTb 06PabOTKN ANMNHHBIX U KPYNMHOMOPMATHLIX N306paKeHUI.

[na HacTponKu NMHUK pesa U Co3aaHns NPUBOAOYHbLIX METOK NOBTOPUTL LLAru U3 pasgerna
lMo3nuunoHupoBaHue no 4 ToukaMm. B okHe HacTponkn ykasaTb pa3mMep, pacCcTosiHue OT METOK
00 06bekTa, TOSMLWMUHY JIMHUI NPUBOAOYHBLIX METOK, PACCTOSHUE MeXay MeTKaMu 1
noatTeepauTb kHonkon OK.

MEYE] Buinontuts File > GreatCut > Settings.

File Edit Object Type Select Effect View Window Help

Ctrl+M
New from Template... Shift+ Ctrl+N
Open... Ctrl+Q (/GPU Preview) X

Mew...

Open Recent Files »
Browse in Bridge... Alt+Ctrl+ O

Close Ctrl+W
Save Ctrl+S
Save As... Shift+Ctrl+5
Save a Copy... Alt+Ctrl+S

Save as Template...

Save Selected Slices...

Revert F12
..... Search Adobe Stock...

Place... Shift+Ctrl+P

Export »

Export Selection...

GreatCut 4 ¥

Poc kg Alt+ Shift+Ctrl+P Rii=ctcutiug

St . Contour
Multi-Copy

Document Setup... Alt+Ctrl+P Set Jog Marks

Document Color Mode > ;
Qutline

File Info... Alt+Shift+Ctrl+] Welding

Print... Ctrl+P Create Qutline-Layer

Exit Ctrl+Q ot
Settings

Mogaynb GreatCut A-6
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MMEY®) HaxaTb kHonky cnipasa oT nons Jog marks.

Settings ot
Eurosystems Software: | GreatCut 4 w ..
Jog marks: |GCC (AAS Il) O
Export Path: | |

Name of layer for Jog Marks: |HEEIITIEI|1C |

Name of layer for Outline: |0Lrt|ine |

Output Parameters. ..

Show always contour and outline settings
During the cut process only transfer "Regmark™ and "Outline™ layer
Create new file while cutting []

Open output dislog while cutting []

Coo

[MEYE VkazaTb pasmep, paccTosiHue [0 06bekTa U TOMLWMHY MUHUIA NPUBOAOYHBIX METOK
n nogTeepanTb kHonkon OK.

Setup - Register Marks *

Type | GCC (8ASI) w

(®) Align to =election

(") Align to working area nOSVILIVIOHVIpOBaHMe no
— — cerMmeHTam
Size mm
: ([ i :
b B | G e Max. x Distance: paccrosHue
Line thickness 1.00 | mm Output marks (or by pressing Ctrl} np0|v|e>|<yTquoro NnoJioXXeHnA
Max. X distance > no ocnm X
Max. ¥ distance Target layer | 1 v| > ﬂmana30H' 200-500 MM
® [Max. y Distance: pacctosaHue

NPOMEXYTOYHOIO MOJIOXKEHUA

no ocn X
- [Jwnana3soH: 200-500 mm

Mogaynb GreatCut A-6
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MEYE BuinonHuts File > GreatCut > Set Jog Marks. ByayT cosgaHbl 4 METKM, KaK Ha PpUCYHKe
HIXe.

File | Edit Object

Type

New... Ctrl+N
MNew from Template... Shift+ Ctrl+N
Open... (o FNo N /GPU Preview) X

Open Recent Files ¥
Browse in Bridge... Alt+Ctrl+ 0

Ctrl+W
Save Ctrl+5
Save As.. Shift+ Ctrl+ 5
Save a Copy... Alt+Ctrl+5

Close

Save as Template...

Save Selected Slices..

Revert

Search Adobe Stock...

Place...

Export

Export Selection...
GreatCut 4 3
Pk Alt+Shift+ Ctrl+P Difsst citiing
Nes . Contour
Multi-Copy
Document Setup... Alt+Ctrl+P Set Jog Marks
Document Coler Mode 3 ;
Outline
File Info... Alt+5hift+ Ctrl+1 Welding
Print... Ctrl+P Create Qutline-Layer
Exit Ctrl+Q et
Settings

File Edit t  Typ ect ¢ Window Hep [ Bl E= -~ 4

greatcutd user manual photo.ai* @ 24.41% (CMYK/GPU Preview) X
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Co3paHue Konun

ITEYE] [1ns HacTpoiikn NHUM pe3a 1 Co3AaHMSA MPUBOAOYHBIX METOK MOBTOPUTS LAY
n3 pasgena NosnumoHnpoBaHue No 4 Toukam.
Setup - Register Marks >

Type |[GCC (AAS ) o

@ Align to selection

CI Align to working area

Mpwn paboTe ¢ pyHKUMeEN

> Multiple Copies npumeHstoTCs
M COutzide corners

napameTpbl, yKka3aHHble B 3TOM
mm

Output marks (or by pressing Ctrl)

ize

Object Margin 5.00

L—T0 |

Max. X distance 600.00 | mm

Max. % distance 800.00 | mm Target layer

Line thiek

pasgerne.

. I - |

MEY®. BuinonHuts File > GreatCut > Set Jog Marks. ByayT cosgaHbl 4 METKM, Kak Ha pUCYHKe
HIXe.

File = Edit Type  Select ect View Window Help m | ’g

S — e RS D R A

Object

Mew...

Mew from Template... Shift+ Ctrl+ N
Open... (7PN N /GPU Preview)
Open Recent Files >

Browse in Bridge... Alt+Ctrl+ O

Ctrl+W
Ctrl+5
Shift+ Ctrl+5
A+ Chrl+5

Close
Save

Save As...

Save a Copy...
Save as Template...

Save Selected Slices...
Revert

Search Adobe Stock...

Place... Shift+ Ctrl+P

Export

Export Selection...
GreatCut 4 >

Prckatic o AltShift+ Ctrl+P Ritsckslting
Secripts > Contour

Multi-Copy
Document Setup... Alt+ Ctrl+P S e
Document Color Mode > 2
: ) Qutline
File Info... Alt+5Shift+Ctrl+1 Welding
Print... Ctrl+P Create Qutline-Layer

Ctrl+Q Bz
Settings

Exit

Mogaynb GreatCut A-6
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Al File  Edit

utd user manual p YK/Preview)

MEYEE] BLiGpaTh 06bekT Lienvkom, BKIoYast NPUBOAOYHBLIE METKM 1 JIMHUIO KOHTYpa,
1 BbIiNnosnHUTL File > GreatCut > Cut.

A
o
K

L[ fAne
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File

Edit Object Type v
Ctrl+N
MNew from Template... Shift+Ctrl+N
Open... Ctrl+0

New...

Open Recent Files
Browse in Bridge... Alt+Ctrl+0

Ctrl+W
Save Ctrl+S
Save As... Shift+Ctrl+5

Close

Save a Copy... Alt+Ctrl+5
Save as Template...

Save for Web... Alt+Shift+Ctrl+5
Save Selected Slices...

Revert F12

Place...

Save for Microsoft Office...
Export...

Export
Settings

U I GreatCut 4 » Cut

Scripts 3 Direct cutting
Document Setup... Alt+Crl+P Contour

Document Color Mode » Multi-Copy

File Info... Alt+Shift+ Ctri+1 SERDR

Outline
prnt.- Giiel Welding
Ctrl+Q Create Outline-Layer

MBI Cvictema aBTOMATUYECKN aKTUBMPYETCA U 3aMyCTUT UMMNOPT NPUBOAOYHBIX METOK
N nMHMM KoHTypa B GreatCut.

s GreatCut 4 - [(untitled - 4) *]

G
0.00 e 4EE.81 100.00 [Duplicate |
398.24 396.24 100.00 0.00
. = =
Db b bbb b b s e bbb b bbb bbb Do b
EEE
=
Bd 3 |
o 3
o 4
=
GE
8 3
&4 [l []
GE
=5
y 1
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[MEYEE 13 menio File BbiGpaTh komanay Output (BbiBog).
= GreatCut 4 - [(untitled - 1)

BB Edit Design View Tools
MNew... Chrl+M

Open... Ctrl+L
Save Ctrl+5
Save As... Shift+ Ctrl+5

Send by Email...

Import... Ctrl+I
Export... Ctrl+E

Print... Ctrl+P

Output... 5

Quit Ctrl+Q

MEE B none Mode Bbibpath Cut with AAS, ykasaTb KONMYECTBO M3Aenuii No ocsiM X
nY, paccTosiHve mexay konusmu. KHonky Output He HaxkuMaTb.

Output to device GCC i
Output
I ! -
Device: [GCC i-Craft v] Number of outputs: 1 Output only tool-azsigned layers
i Number of copies: 1 Keep reference point
Mode: | Cut with AAS Plot to fil
’ i v] Stack spacing: 5.00 mm D R

Enable tool tips
D Dizable sending of technology data

Output Profile: [Fnil v] [l weed border. =00 [

Copies spacing:  2.00 mm  [| wait after segment

[ Manage Profiles ... ] Segment spacing:  0.00 mm
Parameter Valug Sort before output
AAS Dffset origin X [mm] 0.00
AAS Offset origin " [mm] 0.00 Actual Sefting: rU
Pressure [g] 80 t
Speed [cmis] 21 [ search for best Sort Method
Material width [mm] 20843 -
Length [mm] 32018
Number of outputs in X-direction 2
Mumber of outputs in Y-direction 2
Distance between copies [mm] 0.00
Step count 1

Accuracy: | Normal

II

Origin: | Mew origin

Objects: Selected objects b

Output Read material Cancel

E
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BepHyTbcsa B Adobe lllustrator. Beinonuuts File > GreatCut > Multi-Copy.

File =Edit Object Type Effect

MNew... Crl+N

Window Help B | ey 4
v | opmtr 0%

Select View

MNew from Template... Shift+Ctrl+N
Open... (o PN I /GPU Preview) X
Open Recent Files ¥

Browse in Bridge... Alt+Ctrl+0

Ctrl+W
Ctrl+5
Shift+Ctrl+5
Alt+Ctrl+5

Close
Save

Save As...

Save a Copy...
Save as Template...

Save Selected Slices...
Revert

Search Adobe Stock...

Place... Shift+Ctrl+P

Export

Export Selection...
GreatCut 4 »
Packadics Alt+ Shift+ Ctrl«P Hiiee ey
Scripts > Contour

Multi-Copy
Document Setup... Alt+Ctrl+P Set Jog Marks
Document Color Mode ? =

Outline
File Info... Alt+Shift+ Ctrl+| Welding
Print... Ctrl+P Create Outline-Layer
Bxit Ctri+Q Hepart

— Settings

MEYE: Vkasats napameTpbl Number in X/Y (konuuecTso konui no ocsim X 1Y), paccTosiHne
Distance in X/Y (pacctosiHne mexay konnamm). Haxatb OK. Y6eouTtbes, 4TO 3Ha4YeHune
Distance in X/Y coBnagaet ¢ yka3aHHbIM B Liare 6.

Multi-Copy >
Numberin X |2 |
Mumberin ¥ |2 3|
Distance in X [(0.00 = mm
Digtance in ¥ |0 2 mm

Distance to object

Cancs

MpumeyvaHue. PacctosHune no ropusoHTanu u Beptukanu (Offset X & Y) gomxHo 6bI1Tb = 20 MM
nnn = 0 mm. PekomeHayeTcsa yctaHaBnmBaTtb napameTp Distance in X/Y Ha 0 MM, 4TO6bI
He AenaTb MPOMEXYTKOB MeXy KONMUAMW AN 3KOHOMUKU maTepuana.
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[MMEYE) Mporpamma cosnact Hackonbko Konuii 06bekTa ¢ MPUBOAOHHLIMI METKaMM, Kak
MOKa3aHO Ha PUCYHKE HUXE.

View dow Hep [ E1 HE~ o

6 (CMYK/GPU Preview) X

MEYEL) OTneyatath Konum M306paxeHUin, MaTepuan ¢ oTnevaTkaMu 3arpy3nTb B PeXyLLUi
nnottep GCC.
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File Edit Object Type Select Effect View

Mew... Ctrl+N
Mew from Template... Shift+Ctrl+ M
Open... Ctrl+O
Open Recent Files »
Browse in Bridge... Alt+Ctrl+ 0
Close Ctrl+W
Save Ctrl+5S
Save As... Shift+Ctrl+5
Save a Copy... Alt+Chrl+5
Save as Template...

Save for Web... Alt+Shift+Ctrl+5
Save Selected Slices...

Revert F12
Place...

Save for Microsoft Office...

Export...

GreatCut 4 4
Scripts 3
Document Setup... Alt+Ctrl+P
Document Color Mode 3
File Info... Alt+Shift+ Ctrl+1

I Print... Ctrl+P l

Exit Ctrl+Q

TEYEE] B okHe GreatCut HaxaTb kHonky Output.
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Qutput to device GCC i
Output
Device: [GCC i-Craft v] Number of outputs: 1 Output only tool-assigned layers
Number of copies: 1 Keep reference point
Mode: | Cut with AAS - ) [ Piot to file
Stack spacing: 5.00 mm
Enable tool tips
Output Profile: [Fuil v] [C]weed border. 2:00 oo [ Disable sending of technology data

Copies spacing:  2.00 mm  [_| Wait after segment

[ Manage Profiles .. ] Segment spacing: 0.00 mm
Parameter Value Sort before cutput
AAS Offzet origin X [mm] 0.00
AMAS Offzet origin " [mm] 0.00 Actual Setting: [1]
Pressure [g] a0 i
Speed [emis] 29 [7] search for best Sort Method
Material width [mm] 208.43 -
Length [mm] 32018
Number of outputs in X-direction 2
Mumber of cutputs in Y-direction 2
Distance between copies [mm] 0.00
Step count 1

Accuracy: | Normal

II

Origin: | Mew origin

Objects: Selected obiects -

m Read material Cancel
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MHcTpyKkuma no SignPal 12

Mporpamma SignPal 12 coBmectuma ¢ OC Windows. Bce Bepcun nogaepxuearoT
dyHKUMIO KOHTYpHOM pe3kn AAS II.

UHucTpykuuma no SignPal 12: coaepxaHue

[1] YcTaHoBKka nporpammHoro obecneyenus SignPal 12
[2] HacTpowka nnottepa GCC 4vepes Production Manager
[3] Hauano pabotsi ¢ SignPal AASII

[4] MepeyeHb yHkumn SignPal 12

[1] YcTaHOBKa nporpamMmMmHoro ooecneyeHmsa SignPal 12
[nsa yctaHoBKM nporpammMbl Heob6xoanmbl Npasa AamuHncTpaTopa (Administrator). ns

paboTbl C NporpammMmon Heobxoaumbl npasa OnbITHOro nonb3oBartens (Power User).

MogpobHee B pykoBoacTee nonb3osatensa Windows.

1. Ypanutb npeabigywive Bepcum nporpamMmbl, ECININ OHU €CTb.

2. OtkpbITb canTt GCC Club (http://gccf.gcc.com.tw/gccclub/login.aspx), BOWTU B CUCTEMY
1 BbIiNoNHUTL Drivers > Cutter > Others > SignPal 12, 4to6bl 3arpy3nts dpann WinRAR.

Welc

(& Tech Support
e (O Drivers
l.lser Manual @ Below you will find drivers for GCC cutting plotters and ID card printers. Simply choose from

2 the selections below and press the "Download” button. 4s to laser engraving/cutting/marking
@ Clipart Download systems or other products, please contact your local distributors for further assistance.
Product Video

- Step 1 Step 2 Step 3
[©)showcase ]
= g l| Cutter | ] [others [*]  |[—— ¥

Product Registration =

GreatCut 3 v16.0.10

Please note SignPal 10.5.1

SignPal 12
e

(% GCC Bonus Credit
{North America)

For some of the driver(s) version might cause problem(s) on youls ———
To ensure the correct version on your system, please contact your Totar suppmer
for support before you update your system.

Download

3. YcraHoBuTb 1 akTnBMpoBaTth SignPal 12, BbINONHMB NepeyYncrneHHble HuKe LWwarw.
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(1)YcTtaHoBKa u aktuBauuda NMNO Ha KOMNbLIOTEPEe C UHTePHeT-NOAKNIYEeHUeM

1.B agpecHon cTpoke b6paysepa BBecTu https://www.saicloud.com, HaxaTb Enter.
BeecTtun koa aktmBaummn n HaxaTb Activate. Koa aktmBaumm HaxoguTtcs Ha
3TUKETKE NPOorpaMMHOro obecneyeHus.

Activation Code

Please enter the activation code that accompanied your software purchase.

Activation Code SHALALWCZHTTW3TYZDU

=3

2.Mpwu Bxoage B cuctemy BoibpaTtb | am new to the SAi Cloud un ykasatb agpec
anekTpoHHoM noyTbl. HaxaTb Create Account. Ha ykasaHHbI agpec byaet
oTnpasneHo coobLleHue.

Create A Free SAI Cloud Account

i1 l'am a returning customer

@ | am new to the SAi Cloud

Enter your email address to get started.

Important: The email address you select for
thiz SAl Cloud account will be the owner of
the software. [t will be used for all SAi
software senvices. Itis recommended you
use a permanent business email address.

784306662@gg.com
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3. Hantu coobuieHne B NOYTOBOM SLLMKE W LLEMKHYTb NO CChIfKe B MUCbME.
3anonHuTb Nnonga Ansa nHgopmauuu.

Create Account

htype SmErasrd
r— Terms And Conditions
ooy e Terms and Conditions t
User Agreement
= Couniry = aEre choTra u IMPORTANT—READ CAREFULLY
This Account User's Agreement is a legal contract between You (defined below)
- T Zorw (GMT-0L00) UTT [} and
L SA International Inc

BY USING YOUR SAI CLOUD ACCOUNT, YOU (AS THIS TERM IS DEFINED
[ »BELOW) AGREE BY CLICKING ON THE “ACCEPT’ BUTTON TO BE BOUND
A Lna 2 BY THE TERMS OF THIS AGREEMENT (AS THIS TERM |S DEFINED BELOW) ,
INCLUDING, BUT NOT LIMITED TO, ANY WARRANTY DISCLAIMERS,
LIMITATIONS OF LIABILITY, JURISDIGTION, AND TERMINATION

=
PROVISIONS. IF YOU DO NOT AGREE TO THE TERMS OF THIS
AGREEMENT, DO NOT OPEN AN SAi CLOUD ACCOUNT AND EXIT NOW
St Frvince
Article . Defined Terms:
I 1. Account means your account on the SAi Cloud
2. Agreement means this End-User Account Agreement.
3. Entity means any individual. partnership. joint venture. corporation. limited i
Cremie Account e

I | Accept the Terms and Conditions

!

Step 2. Add Software to your SAI Cloud Account

Add To SAi Cloud Account

This software license will be added to your SAi Cloud Account.

[revern ]
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4. C nomouubto WinRAR 3anyctutb ns apxmea gann Autorun. YcTtaHOBUTb

nporpamMmy, criegys nogckaskam mMacrtepa yCTaHOBKU.

Select the language fos the installation from
the chaoicas below.

" SAi Production Suite Cloud

Ei
Chinese (Simplified)
Chinese [Traditional]
Diutch
Er
B3 s production Suite Cloud =2 |
v Setup Status PRODUCTION
‘Welcome to the InstallShield Wizard for SAi SUITE

Production Suite Cloud

The Installs hield? \wizard wil install 541 Production Suite
Cloud on your compuler. To continue, click Nest

541 Production Suite Cloud is configuring pour new software installation.

[

IS
SAi Production Suite - InstallShield Wizard

If the USB dongle is connected to the computer, please remove it now,
so that the dongle driver can be installed

InstallShield

[S ] ]
5Ai Production Suite Cloud AV 38 [ sai production suite Cloud —

Select Features

PRODUCTION
SUITE

Select the features you want to install, and deselect the features you do not want to install

Select the features setup will install.

Description

i Production Suite Cloud
SafeMet Sentinel driver

Setup Status

PRODUCTION
SUITE

S Production Suite Cloud is configuring your new software installation.

Instaling

DA ASAMNSAl Production Suite Cloud'ProgramtaGeyDev.dil

| |
T04.70MB of space required on the D drive
30888 40 MB of space available on the D dive
IristallS hield InstallShield
< Back H Nest > ] [ Cancel ]
E = = PR —
~
sai production sute cioud IR b B s procucton uite Cloud_Jit 8 | | [
License Agreement PRODUCTION Choose Destination Location PRODUCTION

Please read the following license agr

SUITE

Software License Agreement A
IMPORTANT(READ CAREFULLY: This Agreement [as defined below] is a legal =
cohtract between You [az defined below] and S4 International Inc. for the Flexi and
PhotoPRINT Software [a: defined belaw)

This Agreement (as defined below] sets forth the terms and conditions for licensing of
the Saftware from 54 Intemational Inc. and You (a5 defined below]. and installing and
using the Software. This Agreement applies to any (1) single-user license; (i) mul-user
license; and [iil] onginal equipment manutacturer (OEM) o Special Edition [SE] versions of

Select folder where setup will install fi

SUITE

Setup will install 541 Production Suite Cloud in the following folder.

To install ta this folder, click Nest. To install ko a different folder, click Browse and select
anather folder.

the Software and other branded or customized versions unless otherwise agieed, |

4

B DPENIMNG THE SEALED PACKAGE CONTAINING THE SOFTWwWARE OR
DOWNLOADING THE SOFTWARE FROM AN AUTHORIZED ON-LINE SITE. OR -

accept the tems of the license agreement I

da not accept The teme of the hoense agreement

Installs hield

[ < Back l Mext > l[ Cancel ]

Destination Folder

D% \SARSAI Production Suite Cloud

| Browse |

InstallShield

< Back
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5.BcTaBuTb KO B nore Ans Koga akTUBaLun.

-

o

]

Activation Code
Enter an Activation Code to get a license

©)

License
Success

®

o

Activation Code below.

Activation Code: I SHALALIICZHTTW3TYZDU|

‘When you purchase new software it comes with an Activation Code. Enterthe

Licensing Successful

< Back MNeat >

Close

< Back Next > Close

6.BbIbpaTb HyXHbIN A3bIK, HaxaTb OK 1 3aBepLUMTb YCTaHOBKY.

v

- Mot for resale

Product: IPhotoPR.INT SERVER-PRO Cloud

Language: |Eng|ish

..........................................

| [~ Clear Application's previous preferences
[~ Install to startup items
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(2)YctaHoBkKa u aktuBauusa NO Ha komnbloTepe 6e3 UHTepPHeT-

nogkrn4veHusa

1. C nomowybto WinRAR 3anyctntb ns apxmea gann Autorun. YcTaHOBUTb

nporpamMmmy, criegysa nogcka3kam mMacrtepa yCTaHOBKN.

Select the language for the installation from
ther choices below.

(Engiet o)

Dutch
Engish

SAi Production Suite Cloud

Coc )

" 5Ai Production Suite Cloud =2

Welcome to the InstallShield Wizard for SAi
Production Suite Clou

The Installshisld? Wizard willinstall SAi Production Suits
Cloud on your computer. To continue, click Next

Setup Status

PRODUCTION
SUITE

54 Production Suite Cloud is configuiing your new softvare installation.

[

SAi Production Suite - InstallShield Wizard

If the USE dongle is connected to the computer, please remove it now,
so that the dongle driver can be installed

InstalShield

Cancel

C X

PRODUCTION
SUITE

SAi Production Suite Cloud

License Agieement

Flease 12ad the following license agy

Software License Agreement -

IMPORTANT(READ CAREFULLY: This Agreement [as defined below) is a legal
contract between “ou (as defined below] and S& Intemational Inc. for the Flewsi and
PhotoPRINT Software [as defined below]

Thiz greement [as defined below] sets forth the terms and conditions for licensing of
the Software fram 54 [ntemational Inc. and You [as defined below), and instaling and
using the Softwars. This Agresment applies ta any (1) single-user license: (il multi-user
lizense: and (iii] orginal equipment manufacturer (DEM] or Special Edition [SE] versions of
the Software and other branded or customized versions unless otherwise agreed

By OPENING THE SEALED PACKAGE CONTAINING THE SOFTWwWARE OR
DOWwWMNLOADING THE SOFTWARE FROM &M AUTHORIZED OM-LINE SITE. OR -

aceept the teims of the licanse sgreement

o not acoanl the toms of he Teanss sareement

InstalShield

[ < Back I Mest > ][ Cancel ]

g U [0

”
SAi Production Suite Cloud

Setup Status

PRODUCTION
SUITE

54 Production Suite Cloud is canfiguring pour new software nstallation

Instaling

D4 ASARSAI Production Suite Cloud'ProgramAGreyDey.dil

InstallShield

Cancel

| 4 > E—— =

SAi Production Suite Cloud ul

=)

[

SAi Production Suite Cloud

Choose Destination Location

PRODUCTION
SUITE

Select falder where setup will install

Setup will install S&i Production Suite Cloud in the following folder.

Tainstall to this folder, click Next. Tainstal to a different folder, click Browse and select
another folder.

Destination Folder

D2\ ASANSA Production Suite Cloud

Browss... |

InstallShield

Select Features

PRODUCTION
SUITE

Select the features you want to instal, and deselect the features you do not want to irstall

Select the features setup will install

Description

440 Production Suite Cloud
Safieh et Sentinel driver

F04.70 MB of space required on the D drive
30888.40 ME of space available on the D dive
InstaliShield

[ ¢ Back I[ Next » ]l Cancel
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2. 3anucaTtb naeHTUMUKaALMOHHbBIN KOA4 KOMMboTEpPa U3 AManoroBOro OKHa HuxXe.
Hantn umsa Bawero komnbioTepa. [na 3Toro npaBon KHOMKOW MbILK LLENKHYTb Ha
3Hauyke Mowm komnbloTep 1 BbibpaTb CBOMCTBA.

r =

o

-

License
Could not communicate with the SAi Cloud

®)

S

License manager was unable to connect to the Cloud License Server. Possible
causes for this may include

- The "SAi Cloud” website may be experiencing issues. Please open your
browser and try to log into your accourt on www saicloud.com.

- Your activation code has not yet been linked to your saicloud .com account.
Please go to www saicloud.com, enter your activation code on the
"Activation Code” field, enter your email address and passwaord, and click on
"Activate License "

| - Your computer may not have access to the license server. Please verify that
port 443 is open for both incoming and outgoing connections in your firewall for
all SAi applications.

During the process you may be asked for a Computer ID. If you require a
Computer ID, use the value below.

https://www saicloud com/
[ Computer ID: 5E19DA26B331
You should retrieve a license file from the website. When you have a license file
imort it using the button below

= Import License File

< Use Proxy Settings

< Back DNexd

Systemn

Rating: m'u‘."indcws Experience Index
Processor: Intel(R) Core(TM) i5-2450M CPU @ 2.5C
Installed memory (RAM): 8,00 GB (7.90 GB usable)

Systemn type: 64-bit Operating System

Pen and Touch: Mo Pen or Touch Input is available for t

Computer name, domain, and workgroup settings

Computer name: Jeff-PC
(] I Full computer name: Jeff-PC I
| Computer description:
Workgroup: WORKGROUP

Close

Ha komnbloTepe ¢ MHTEPHET-NOAKINIOYEHNEM 3anyCcTUTbL Gpaysep 1 HabpaTb

B agpecHon cTpoke bpayaepa https://www.saicloud.com. NoaTeepanTb KnasuLen
Enter. BBecTtun kog aktuBauum n Haxkatb Activate.

Kop akTuBaumm HaxoguTcsa B

cepTudmkate nporpaMmmMHOro oéecrne4yeHus.

Activation Code

Please enter the activation code that accompanied your software purchase.

Activation Code

SH4LALLMCZHT TWATYZDU

=
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4.MMpwn Bxoge B cuctemy BblbpaTb | am new to the SAi Cloud v ykasaTb agpec
anekTpoHHou noyTbl. Haxxatb Create Account. Ha ykasaHHbIi agpec byaet
OTnpaBneHo coobLLeHme.

Create A Free SAI Cloud Account

2 lam a returning customer

|® 1 am new to the SAi Cloud

Enter your email address to get started.

Important: The email address you select for
thizs SAi Cloud account will be the owner of
the software. [t will be used for all SAi
software senvices. Itis recommended you
use a permanent business email address.

784306662@q9q.com

Create Account

5. Hantun coobLieHne B NOYTOBOM SILLUKE W LLEMKHYTb MO CChISIKE B MUCbME.
3anonHuTb Nonsa Anga nHopmMauuu.

Step 2. Add Software to your SAi Cloud Account

Add To SAi Cloud Account

This software license will be added to your SAi Cloud Account.

Activate Now
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6. HaxaTtb License Manager can’t connect? ([ucnetyep nuUEH3NA HE MOXET
noakmnounTbes?). YkasaTb KO KOMMbOTEPA M UMS KOMMbIOTEPA, KOTOPOE Bbl
3anucanm paHee. Haxatb Create License Now (Cosgatb nuueHsumio)
n Download License (3arpy3uTb NMLEH3UI0), COXPaHUTb hansi Ha KOMMbIOTEP.

Step 1 - Download
Clicking on the download button below will download a small application. Run the application to do

Download Mow

Step 2 - Install

Once the download is complete, run the installer. The final step in the install process will run a "Lic
application.

Step 3 - License
The "License Manager” application will ask for an activation code. Use the activation code below tc
QTPSNDBEFXYUXGXHLTAG

“License Manager” can't connect?

!

Create License Current Install

Go Back Computer ID: SE19DA26B331
Your software will be licensed to be used on the computer wit
Computer Mame: JEFF-PC

|:> User Name: Administratar

Mar 21, 2014

Computer ID

Computer Name

Download License

License Removed?

Create License Now

Download Now
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7. CkonupoBatb dain nNMueH3nMmn Ha KoMnbloTep 6e3 MHTEPHET-MOAKINIOYEHMS C ANCKa,
MMNopTUPOBaTb €rO.

o }

License
Could not communicate with the SAi Cloud
License manager was unable to connect to the Cloud License Server. Possible
causes for this may include:
- The "SAi Cloud" website may be experiencing issues. Flease open your
browser and try to log into your accourt on www saicloud .com.
- Your activation code has not yet been linked to your saicloud com account.
Please go to www saicloud.com, enter your activation code on the 0 Open
"Activation Code" field, enter your email address and password, and click on
“Activate License.” Gk./' w| L » Computer » Local Disk (D) » Users » « by W Search Users ]
|| - Your computer may not have access to the license server. Flease verify that | - —_ -
| port 443 is open for both incoming and outgoing connections in your firewall for | . e ok it i@
all SAi applications | A
=4 Ubrares
During the process you may be asked for a Computer ID. K you require a g Ademunmrated
Computer 1D, use the value below. i Aprs lieeree-0077325 kn
D 1
| https:/#www saicloud.com/ | 2 Music
Computer |D: 5SE19DA26B331 | B Piechures
You should retneve a license file from the webste. When you have a license file | > M Vicece
imort it using the button below E
™ Computer
B Local Dok ()
o Loeal Dink (D4}
s Mew Vlume (E)
- 1} €0 Orive (1) GRF
= Use Proxy Settings “é ﬁ\l?’:l'ﬁ.‘ri
File rame:  license-00773254n | License Fie tsn x|
=

(4] b B g179 - - - - - [

License @) License @)

License successfully imported I Software 1D 0077325
License Type TRIAL

Expire Date 20-04-2014
Licensed On This Computer
Computer ID 5E19DA26B331

= = Check For License Updates
# Import A License File

Click Next to continue % Remove License From This Computer

< Back Nesdt > Close < Back Close

8. BbibpaTb HYXHbI 53bIK, HaxkaTb OK 1 3aBepLUNTb YCTAHOBKY.
| - NOT Tor resale

Product:  |PhotoPRINT SERVER-PRO Cloud |
\ Language: IEninsh LI
| W install to desktop:

[ Clear Application's previous preferences
[ Install to startup items
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(3) MepeHOC NUUEH3UUN HA KOMNbIOTEPEe C UHTEePHeT-NoOAKIIYeHUuem

1.07kpbITb License Manager 13 meHio Start.

. 58 Preduction Suite Cloud
;% Install Manager
‘.;“_;E Job Monitor

License Manager
il PhotoPRINT EDITOR-PRO Cloud
E PhotePRIMT SERVER-PRO Cloud

|ﬁ] Preference Manager

2. Boibpatb Remove License From This Computer (YganuTb nuueH3nto ¢ aToro
KomnbtoTepa). Tenepb nporpammHoe obecrneyeHne MOXXHO YCTaHOBUTb Ha ApYyromn
KOoMMbloTEP.

- —

- ®

Software 1D 0077325

License Type TRIAL

Expire Date 20-04-2014
Licensed On This Computer
Computer ID BE19DAZ6E331

= Check For License Updates

= Import A License File

# Remove License From This Computerl

—

-o ll ﬂ‘
- ®)

The license was successfully removed from this computer.

Software ID: 0077325
Removal Code:  NLSK7RKC3R

# License this computer again

)
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14§I'IepeHoc JInleH3nn Ha KoMmnbrTepe oe3 nHTepHeT-noAK/M4YeHUA

1.07kpbiTb License Manager us menio Start.

. 5Ai Production Suite Cloud
% Install Manager
T Job Monitor

License Manager
i1 PhotePRIMT EDITOR-PRO Cloud
a PhotoPRIMT SERVER-PRO Cloud

i Preference Manager

2.Bbibpatb Remove License From This Computer. Bsect Kog, feaktnuBaumm B

Ananorom okHe License.
‘© =i’ g O =

License @) License @)

Software ID 0077325

License Type TRIAL

Expire D 20042014 The license was successfully removed from this computer.
ire Date

Licensed On This Computer
Software 1D: 0077325

Removal Code GMYKCTIGAS

Computer ID 5E15DAZ6B331

= Check For License Updates

N
=
. : = License this computer again
= Import A License File

# Remove License From This Computerl

3.Ha komnbloTepe ¢ MHTepHeT-NOAKMYEHNEM 3anyCcTuTL bpaysep,
3anTun Ha https://www.saicloud.com 1 BOUTM B CBOIO YYETHYIO 3anncb. BeibpaTtb
License Removed (JluueH3na yganeHa), BBECTU KO A€aKTUBALMUN N HAXXaTb
Remove. Tenepb nporpaMmmy MOXXHO YCTaHOBUTb Ha APYron KOMMbIOTEP.
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@) Cloud
Current Install

Computer |D: 5SE19DA26B331

_ Software Removed?
Computer Mame: jeff-pc

USEF Name: Jeff When a software license is removed from your computer, it will attempt to
over the Internet. If your computer was unable to communicate over the Int
have displayed a removal code. Enter the removal code below.

Mar 21, 2014 =) play

Removal Code

Download License [[ewmcnoss

. Remove
|L|cense Remnved'?l

No Remaval Code?

Download Mow
Go Back

[2] HacTpounka nnoTtrepa GCC yepe3 Production Manager

1. OTkpbITb Production Manager 12

2. BbibpaTb 1 HacTpouTtb pexywmin nnotrep GCC
(Cuctema AAS Il paboTtaeT Tonbko ¢ mogenamu RX I, Jaguar V LX, Puma Il
Expert Il LX.)

Choose a device

What is the brand name of your viryl cutter?

lacc -]
What is the modal name of your GCC?

[AR24 ~|
GRC-23 |7|
i-Craft e
Jaguar [11-101

Jaguar I11-132

Jaguar [1I-183

Jaguar |I1-61

Jaguar III-76

Jaguar IV-101

Jaguar IV-132

Jaguar IV-183

Jaguar [V-61

Jaguar IV-76

Jaguar JIF1015

Jaguar JII-1325

Jaguar JII-61

Jaguar JII-765

Jaguar JR-1015

Jaguar JR-1325
Jaguar JR-E1
Jaguar JR-765
Jaguar V-101
Jaguar V-101 LX

Jaguar V-132 m
i ] [ concer ]
@ Jaguar V183
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What do you want to call your new setup?
Jaguar V-61 LX

How iz your Jaguar V-61 LX connected to your computer?

v] [ EBrowse...

GCC UsB 000 \

/

[ Ba | Finishﬂ

Cancel ]

Edit Setup View Help
e ® Ty @

Help ¥

File

Job ¥ Send Abort Delete

A GCC Jaguar V-61 LX@GCC USB 000 Job Name

‘%‘ Jaguar V-61 LX

Setup

T —TT—

Tools

-
=

Flexiquote Reports

Status

Files

Resources

- @ &

Printer Support License L=
Profiles

You

 Tube]

Youtube Facebook

More

@ 2012-2016 SA International, Inc.

s

C: Free: 217.7 GB

VM Frea: 3.57 GB
C: Total: 302.2 GB

FAM Free: 720.6 MB
VM Total: 4.00 GB

RAM Total: 4.00 GB

D: Free: 379.4 GB
D: Total: 396.3 GB

NHcTpyKuma no SignPal 12
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3. B nporpamme SignPal BbinonHuTh File > Print Setup v BoiGpaTh npuHTEp.

SignPal Expert - [Untitled 1] - - - ‘ ] : :

@ Edit View Armange Text Effects Bitmap Window Help mﬁ]m

N Ctrl+N o PO
bl "Nl o BEG QR |
F Open.. Ctrl+0
16 % 3 mm‘
Close Ctrl+F4 | L | L | L 1 L ] ' L | =
ﬁ Find File...
H Save Ctrl+5§
Tools
& SaveAs. Ctrl+Shift+S
= Import.
B Export... .
E Files  Flexiquote Reports
Acquire Image 3 b
E% Document Setup... Ctrl+B A
sal Resources 5
M F CutPlot.. Ctrl+L
S Cut Contour... g
| Print Setup.. Crl+ Shift+P .
&  Print.. Ctrl+P Printer  Support License
Profiles
2 Archive to Cloud
—— o
Workspace > [ m 3 5
4y 1 FillJooo2 [ ([ A T |
Cha 2 FillIoooL | |License expires in 14 days. Stroke [0 Fill I 2
= E
-

-
Print Setup / / u

— Printer
MName: "gpprinter?dF_TTEH_HH_FX DocuPrint i Properties... |
Status: Ready

Type: Microsoft enhanced Point and Print compatibility driver
Where:  4F_1T3H
Comment:

— Paper Crientation

Size: IM LI * Portrait

Source: I.ﬂu_nnmaticalhrSeled | " Landscape

Hep | Network... | oK ; Cancel

N

- = B
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4. B nporpamme SignPal BeinonHuth File > Document Setup n ykasatb bopmat Bymarm.

Edit View Armange Text Effects Bitmap Window Help mmm
] “l o oo B G Q6 @ |
F Open.. Ctrl+0

16 2 ) inches

Close Crl+F4 | L | ' | L ! L 1 L L | =
ﬁ Find File...
H Save Ctrl+5 Tase
@ SaveAs.. Ctrl+Shift+5

N % Import...

Export...
ﬂ Files Flexiquote Reports

Acquire Image 3

L Document Setup... Ctrl+B l L
Resources 3
. | Cut/Plat.. Ctrl+L

-', Cut Contour... g

B Print Setup... Ctrl+Shift+P -
&  Print.. Ctrl+P Printer  Support License
Profiles

" Archive to Cloud

- &
Workspace > m 3 5

£ 1 Filllonoz2 [ ([ A T |
Spe 2 FillIoooL | |License expires in 14 days. Stroke [0 Fill I 4
— E = ——
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[3] Hayano pa6oTbl ¢ SignPal AASII

EEIE]
DEERRSTFILIDAo e BESAE2*
e e e b e 8 R e R

s

. \

-+ —| -

m. |

B CIIN Vg 5 7,
GPPPHLP P S

B

Y

4 1 F

]« < A 0 D 1

[( 8476, 0574)

|License expires in 14 days.

2. BoinonHutb Effect > Contour Cut. B okHe DesignCentral HaxaTb Apply (MpuMeHuTs).

[ ™
S Signpal Expert - Uniied 1] WR— e ] S

File d ‘u’i Arange Text Effects Bitmap Window Help [- =] =]
DEFARRATIN DA e BRSAE
[ Lo tI:l Mo Lo .‘T ol B T i T i T el IF Nen i 1I2 . |m?ﬂ|
K| Q[ | .
; DesignCentral "~ HEd

% % - 7|

|j Q \c-—- iCorltour vI
N " _I vI

B | & =71 [0.500n : R

Z Q ] +*[2.000in — ﬂ

| & = ¥ [2.000m =

T __ ¥ Proportional

_____ ‘@ ] [~ With holes

o | | E~| =X

e *®
= 4 L (2 5
< RO R EEE O EEEEEEEECT

( -1615 2748) |License expires in 14 days. v
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3. NpumeHnTb MeTKy KoHTypHOM pe3kn GCC AASII, soinonHue Effect > Contour Cut Mark.

SignPal Expert - [Untitled 1] =R
File Edit View Arange Tedt [Effects| Bitmap Windew Help [- [=]x]
NERBRS Y o lenBEeqleos

o et f 10 12 imches|
I_- m L 1 1 | ! 1 :LDJ Contour Cut... 1 | ! | 1 | I | 1 | I I | T
| k1 b *-': Contour Cut Mark... =
IT Q ] [} Shadow... \
S-é @ A [1 Clear Contour Cut DesignCentral =l
|:I Q a—] ml Separate Contour Cut IH-IG Dl
J;.‘ & __ IContour vl
] ] =——1l|| 4
|:) Q = — mﬂ.ﬁﬂ[ﬁn =
j + [2.000n =]
0 & $ [2000n
& _{_j?_ i ¥ Proporticnal
7 '|j ] [~ With holes
L LR
b | -
L] | 1 | 2
ROTIN v | (o e A
Creates cut marks around contour cut objects |License expires in 14 days. 4
—— — — — E— — E— E—

4. B okHe SignPal DesignCentral Boibpate GCC AASII, 4T06bI co3aaTb
npuBogoydHble MmeTkn AAS Il (no3nunoHmpoBaHue no 4 Toykam). NoareepanTb
kHonkou Apply.

DesignCentral | ]
‘ \ i
2 D 030 I

L _ |upm—s

¥ One set for all

Bptions,. | & ﬂ
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5. EcTb Tpu BapmnaHTa npuBogoyHbix MeTok GCC AAS II: 4-Point Positioning (no
4 Toukam), Segmental Positioning (no cermeHTam), Multiple Copies (co3gaHune
konui). [na no3mumoHnpoBaHmna no cermeHtam B okHe DesignCentral BbibpaTb
GCC Segmentation 1 HaxaTb Apply.

DesignCentral |

4k
H

AT

r__-
ol
G
oo Iﬁ
¥ Ore st for al

options.. | X] w|

6. CosgaHue konun B SignPal HegocTynHO. Ha TekyLmin MOMEHT BOCMOSb30BaTbCS
YHKUMEN KONNMPOBAHNA MOXHO TONbKO Yepe3 moaynb anga CorelDraw.

7. Ansa BbiBOAA n3obpaxenus BoinonHuTb File > Print.

S e P [ i, _.g. J m-@g
™ New Ctrl+ M ; -
——— B Open... Ctrl+0 = Eh il
D E Close Ctrl+F4 ﬂ e} ﬂ.. @ Q ﬁ C'.;_l-’:b '\_—i‘:)
’T % ﬁh Find File... ? 1 | 1 ji‘ 1 | 1 li:l 1 | I 1|2’ 1 1 m:?la!
: Save Ctrl+5 3
IT G Save As... Ctrl+Shift+5
Sa E 7 Import..
|:i @8 Export. | I
j;: é Acquire Image »
@ E¥ Document Setup... Ctrl+B I |E|
@ @ F Cut/Plot. Ctrl+L
4 & & CutContour.. |
Print Setup... Ctrl+Shift+P |
O | <Sh Print.. Ctrl-P
‘ 4% Archive to Cloud
Fi Workspace 3
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i = ™
SignPal Expert [

% Printer paper orientation does not match docurment., Adjust printer

autornatically?
Yes Ma /l

b L

8. B okHe Print (NeyaTb) ycTaHOBUTbL 3HaYyeHne Scale (MacwTab) paBHbiM 100 %.

— Prirker — Freview

Mame: W\gpprinter2\4F_{TH8_=£F_Fx Doct | Properties... |

Status: Ready

Tupe: Microzaft enhanced Paint and Print compatibility driver [
PostScrpt data: ¢ Binary & ASC

— Copies — Print Ophionz

| Nurnber of copies: I'I 3: I™" Selection only
I 3 3 ™ Border
_]-'JJ _]-'JJ W' Collte [~ wireframe

l [~ Substrate -
| Scale .
© Fit drawing to paper 7 Guides

l ™ Fit border to paper I Grid

| & Scale: ™ Contour cut paths
12in = 1ft [1005%) I™ Template | |

Select Template... |

— Tiling
[ Print tiled pages — Position
| Ovwerlap: IU.UUUin = ICenter ;I
S A Ofiset: [0000n = I
¥ Use device margins Offsetr: IU.EIEIDin ::’

W lgnore overprint I
I ™ lagnore bitmap trarsparency oK Cancel |

é

9. 3arpyauTb B NSIOTTEP BUHUI 1 OTNpaBuTb AaHHble komaHaown File > Cut Contour.
Ha Bknagke Properties (CeowncTtea) guanorosoro okHa Cut Contour goctyneH
npeaBapuTEnbHbIV MPOCMOTP 3adaHna. 34eChb Ke MOXHO M3MEHUTb NapameTpbl
peskn. Cuctema Production Manager aBToMatnyeckn aktmempyeTcs ans
BbINOSTHEHUSA 3aJauMn.
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i1]

ange

Text Effects Bitmap Window Help

18 7

gajin

) ) 0 M
T

—

=)

Select a Production Manager

* On this computer [Local)

{7 On another computer [Mebwork)

" On the intermet address:

| ] g Cancel |

Jaguar V-61 LX@GCC USE 000 Johb Status
Propetties... | g ’
@9 %
— Materidl 24 22 20 18 8 4 2 0 & & 4 2 cli 1
| [24 000 1968.000n - & 8 |
I = ® il I
] IZAE..[':DDin 3: 10 I'IBEE».DDL‘Iin 3: 4 |~ ]
g_
g_
. £
Send mode: ISend now LI -
— Position &)
¢ [1.575in =] = [1:575in = 5
I ‘@
—Size H—
T FE T & [o0.000% &l
®
1 |2.33Jin 3: ™ Fit to media rn_
rCopies q_
BE [i =  Wfosen = |
=]
—I~ Repeat Job
DU_
Send job I‘I =] Li
2Na jol = Imes o
= o P
N_
& L _I} |
4] b
ITG)‘|@|®‘| Send Done | ‘
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[4] MepeuyeHb cbyHkuun SignPal 12

9KkcnepTtHoBUYOK
TekeT
PaboTta c TekcTom ° °
TekcT no gyre °
TekcT no kprBon °
BepTukanbHbIN TEKCT ° °
Mo BepTMKanbHOW KPUBOWM °
KepHUHr °
Pasgenntb/O6beamHnTb ° °
PucoBaHue
Kpusble besbe ° °
CBoboaHoe pucoBaHue ° °
Purypsbl
MpaMoyronbHuK ° °
Osan ° °
MpuBOgOYHbIE METKM ° °
Paamepbl ° °
PepaktupoBathb KpuBYHO
BbiOpaTb TOuKy ° °
Yoanutb TOUKyY °
[obaBnTb TOYKY °
BbinpsiMuTb KpuByto °
CKpyrnuTb yron °
3aocTpuTb yron °
OnTrMnsmpoBaTh MO KPUBON °

OnTUMK3npoBaTh Mo Ayre

OnTuMmaMpoBaTth Mo 3 TOYKaM Ayru °

Cospatb oyry °
CokpaTuTb YNCNO TOYEK °
3aMKHYTb Kp1BYIO °
M3MeHUTb HavanbHyt TOYKY °
Paspenutb °
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Ho*KHMLbI

Co3paatb NpAMoOM yron
Pa3opBaTb Kpusyto
CoeanHUTb KpuBble
BbIpOBHATbL NO rOPM30OHTaNN
BbIpoBHATbL NO BEPTMKaANU
BbIpOBHATb TOUYKM
MpumeHnTb AAUHY U

yron

Yaanutb menkme o6bekTbl
BeKTOpPHbIN NacTuK

Pa3genutb No KpuBoi

Pabota ¢ daitnamu
NHdopmauma no 3agaHuto
CkaHupoBaHue

BbiiTn B 061aKo

Paboune obnactu

Bupg,
DesignCentral
LlBeToBOM MUKLIEP

3axBaT

YnopagounsaHue
CrpynnuposaTtb
O6beaAnHUTD
MacKkupoBaTb
Hanpasnatowme
KoHTypHaAa peska
MepeBecTn B KpuBble

dNeMeHTbl B KpuBble

MNpeobpasosathb Linked
to Native
HanpasneHue Kpusown
Yrnopagounts

MopAanoK pesku

NHcTpyKuma no SignPal 12
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BblpoBHATL
PacctoaHune

MNoBepHyTb

N3meHnTb pasmep
Y6paTb nepekoc
3epKanbHO 0TOOpPa3nTb

MHOroKpaTHO KOnNnpoBaTb

3dPeKTbl
KombuHupoBaHue
KoHTyp

KoHTypHan peska

MeTKa KOHTYPHOM pes3Kku

TeHb

PacTp
ABTOTpaccMpoBKa

LiBeToBOM pexnm

MNpoussopacTeo
Pesatb/pucoBatb

Py4yHoe pasaeneHune AuHWUM
YnopsaaounTb Bce KONUK
MOHTUPOBATb A0 rPaHMULLbI
ABTOMaTHYeCKOE CAUAHUNE
ABTOMATUYECKMIA TPEMMUHT

Haxnect

OnNTMMM3auma NopALKa pPesKku

NHcTpyKuma no SignPal 12
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NMporpamma Sure Cuts A Lot

Hwxe npuBeneHbl 6a3oBbie cBeaeHus no padote ¢ nporpammont Sure Cut A Lot.
3a 6onee nogpobHom nHdopmaumen obpawaTbes K cnpaBoyHbiM dhainam Sure Cut A Lot.

1. BbIOpaTb HY)XXHbIA NPUHTEP U UISMEHUTb paboyyro obnacTb.

3anycTutb nporpammy Sure Cuts A Lot.

e ot L e e T=To i

Fie (9 Omject Patn Lo Page ffects Tee View Cutin Windon ey

WVarsien 4005
 Copyright © 2014 Gl Baolne:
Al Righty Bt

21 ABATA|[ON|D RN Re|aa0k

|

[nst nameHeHnst paboueit obnacTtu B MeHio Cutter BoiGpaTts My Cutter, 3aTem
Manage Cutters.

4 Sure Cuts A Lot 4: Untitled
File Edit Object Path Layer Page Effects Text View [Cutter| Window Help

o W o 5 o . Mat Size 3
A D || ' Ii |F. Mat Orientation »

Preview Ctrl+Shift+P

Cut with GCCi-Craft

Cutter Settings.
My Cutter 3 Manage Cutters...
Tablet Connection v GCCi-Craft I

Mporpamma Sure Cuts A Lot A-8
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B cnucke komnaHuin n mapok BbibpaTe GCC 1 HyXXHY0 Moerb, HaXaTb KHOMKY
Add to list.

]

_ |
e T |

Cutters you currently have added are listed below. To add another Cutter, dick the Add button
Cutters you currently have added are listed below. To add another Cutter, dick the Add button to add another Brand/Model.
to add another BrandModel.

Add a Cutter
Cutter
Add a Cutter T
Cutter GCC iCraft
Company/Brand: |GCCi-Craft - Model:
GCC i-Craft e

<lUnspecified:= e— L
Model;  [FE68 s e
GCC i-Craft —
Expert 241X

Expert 52LX
ExpertII 24
Expert 11 241X
ExpertII 52
Expert 11 521X

4 [ 3

Expert Pro
Jaguar I
\ EX Lbrary " Puma 1T E
Remove C {20 Arroy ;;ma mox ._/;
: {1 Basicpy 1
[ V2

{0 Fall (Sable
F e,

Fame

Cnesa Bbibpate GCC u Haxatb Done.

Cutters you currently have added are listed below. To add another Cutter, dick the Add button
to add another Brand Model.
Add a Cutter
Cutter Jrand
GCC i-Craft pany
Model: [Jaguar v -
< I 3

UT06bI M3MEHUTL pasMep W OpUeHTaLMio paboyel 06nacTu, HYXHO BBECTY
COOTBeTCTBYHOLWME 3Ha4YeHnss B okHe Document (JOKyMeHT).

DOCTIMENT

Mat Size: 12" x 127 - l:l
Orientation: | Vertical (Portrait) -
Units:

Show Grid

Grid Lines: ~ 6.00in

=6 6l

{E| EE

Subdivision: &

Workspace Alpha:
] 7

[] show Outlines Only

Mporpamma Sure Cuts A Lot A-8
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2. BcTaBka nsobpaxeHus ns 6ubnuortekm

11ET | [1nsa BcTaBku BblbpaTb B GUBNMOTEKE HYXXHbIN dhann ¢ n3obpaxeHnem.

FOEITION & S0E

% nooom & " °

e (] ) [

e (] (8] (o Pliissg
vaior: (1] (o] (R

W 10 e

S0l #BUN[IN|ERN NS |27

3. [o6aBneHue TeKkcTa
LLlenkHyB Ha 3Ha4dke T cneBa, B TEKCTOBOM OKHE BBECTM TEKCT M BblOpaTh HYXXHbIN LIPUQT.

[ sure Cuts A Lot 4: Unt [E=EER )

File Edit Object Path Layer Page Effects Text View Cutter Window Help

AEz e mml EN AN A

I
Fell 9]0 TEXT [
T O L L P A O O B - e
o] nt!  Ludda Caligraphy  abe (48]

AN

el

- el
= Algrments
i T Size: 1.00in 1

] éd A Widh:  10000% 2
s : By @ Ay Tracing:  100.00% %]
s—f Shapas & lesdng: .00l [

1 == A{ vOffset 0.00in 12
" EEIEE aQ o

| Rotate: A
L B Library 7 = & —

B - Amows (18) = \;:> gﬂf\ KJ [:_L D (/}\/ Q m
b | 0 Basic Shapes (31) | _ = Sl I Y

] LA Fa(2) 3
5= {1 Game (12)

] i {0 Music (10)

<[ v

| 13 Newborn (15) @.@@@@@@
{C Spring (13) ~ Ol Y Y
Bt il @@ -

gle i pBUN|[ON|DON SN |HAD >
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4. UmnopTtupoBaHue MakeTa

MakeT n3 gpyron rpaduyeckon nporpamMmmbl UMAOPTUPYHOT KoMaHgon Import nnun Place
image n3 meHto File. SCA nopgepxmBaet hopmaTthl svg, scut, scal, pdf, ai. eps, png n wpc.

I Edit Object Path Layer Page Effects Text

Mew Project Ctrl+N
Open Project Ctrl+0
Save Project Ctrl+8
Save Project As... Ctrl+5hift+5
I Import... Ctrl+Shift+1 I
Export... Ctrl+Shift+E 5 o
Trace Image... Ctrl+Shift+T

I Place Image... I
ScandCut...
FCM Batch Convert...
Send to 3

eshape Store...

Share Project...

Sync My Library:

Print Setup.
Print...

Recent Projects 3

Exit Ctrl+Q

CneumanbHo ansa MO Sure Cuts A Lot co3paHbl Thicaum ¢hannoB SVG!
http://SVGCuts.com — ny4yimnm pecypc gnga co3gaHnsa au3anHoB B popmarte
SVG. TbicA4n aNeMEHTOB B BbICOKOM Ka4yecTBe: LWabnoHbl Anst OTKPbITOK,

cKkpanbyKunHra, nogapoYHbIX NaKkeToB, KOPOOOK, O6GbEMHbIX LIBETOB.

Mporpamma Sure Cuts A Lot A-8
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5. lMNMpeobpa3oBaHue nsobpaxeHuns B hann pesa

ITET| OTKpbITb OKHO HAacTponkn, BbinonHue Trace Image (TpaccupoBka n3obpaxeHus) n3a
mMeHto File nnu wenkHys Ha kHonke Trace Image Ha naHenn UHCTPYMEHTOB.

2 sure cusa Lot Uit

I[ Edit Object Path Layer Page Effects Text View Cutter Window Help

Mew Project Ctrl+M
Open Project Ctrl+0O
Save Project Ctrl+5
Save Project As.. Ctrl+Shift+5
Import... Ctrl+Shift+1
Export... Ctrl+Shift+E
Trace Image... Ctrl+Shift+T
I Place Image... I
Scan2Cut...
FCM Batch Convert...
Send to ’ | |

MmnopTtupoBaTb nsobpaxeHune kHomnkon Choose an image, ykasaTb HaCTPOWNKM
nsobpaxenna (Image Settings) n BeiBoga (Output Settings) n HaxkxaTb OK.

I'Iporpamma aBTOMaTU4ECKN CO34acCT KOHTYP M306pa>+<eH|/|;|.

g;f’, Trace Image

Input

e
._.": Cat_airl_kids_cartoon.ipg

B (1775 x 1115)

Image Settings

Contrast (0-100): {1} 194
Dutput Settings
Smooth (0-100): 80 -
Detail (0-100): 98 =
Single Line Threshold: 0 e
[] Break Apart Qutiines [ Blackout

[7] add Image Layer {Print+Cut)

’ Restore Settings ] [Save as SVGE... ]

Al |

Output
[]5how Modes Modes: 1885
Show Source Image: - {1
.
*ﬁ*\ K|
<l b

: The preview is currently showing
Update Preview | yhat will be traced. Click the Update

Preview button to see trace result.

[ cancel % oc. ]

7

MpumeyaHue

v' Ha pesynbTaTbl TPAaCCUPOBKN BUAIOT KOHTPACTHOCTb U NMUKCENW.
MpegnoyTnTenbHO MNOPTUPOBATL (Pansbl C BbICOKOW KOHTPACTHOCTLIO.

Mporpamma Sure Cuts A Lot
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6. Pe3ka maketa

(11T Lllenykom Ha kHonke Cutter Ha naHenn MHCTPYMEHTOB OTKPbITb AManoroBoe OKHO
HaCTPOEK.

B | Sure Cuts A Lot 4: Untitled

File Edit Object Path Layer

) T

Page

Effects Text WView Cutter Window Help

- B S i ==
< Bl B

LLlenukom Ha KkHorke Settings... OTKpbITL Ananorosoe okHo GCC Cutter Settings.

General
[ Sethgs...K

GCC 90 12 3 45 6 7 8 9 101112
v] @ [TestConnecﬁon]

Model: [Jaguar v

7]

UsB hd

Connection:

Port: | <Auto Detect>

Cut Settings

CutMode: |WySIWYG -

Use Software Speed and Pressure

End Action: |Rewind to origin hd

|:| Mirror H |:| Mirror V

MpumeyaHue

v' VcxogHasi Touka HaxoguTcs cripaBa BHU3Y.

B okHe GCC Cutter Settings npu Heob6xoanMoCT oTperynnpoBaTb NPUBOAOYHbIE METKM
. GCC Cutter Settings (==

Registration Marks
Mark type:

Mark offset:
Mark size:

Mark thickness:

0.50 cm

1.50 cm

1.00 mm

om

o

mm

[ set Defauts |

’ Cancel

J

Save

J

* Registration Marks ([MpvBOAoOYHbIE METKW): HACTPOUTb pPaCCTOsIHUE MexXay
KPOMKOM maTepmana n npuBoAoYHbIMM MeTkamu B none Mark Offset; pasmep
MeTok — B none Mark Size; TonwmHy nuHnin — B none Mark Thickness.
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GCC.. Expert Il. PykoBoactso

Mpu HeobxoaMMOCTM 3aaaTh HacTpoiiku Blade Offset, Overcut Value, Multi-Cut
n Quality B okHe CutSettings.

et

GCC 0 12 3 456 7389 10112 ;
Madel: []aguar v '] [ Settings... ]
Port: | <Auto Detect> +] (@] [restconnection]

Cut Settings

CutMode: |wWysSIWYG -

[#]Use Software Speed and Pressure [CImirror 1 [T mirror v

End Action: |Rewind to origin =

Preset: [Copy Faper v]
Holder: [R.egular Blade (0.25 mm) ']
[BladefPEn Prompt ']

Blade Offset: Overcut: | 0.0 (None) hd

Speed: —} - 15amfs
Pressure: D 70g
Printtcut | [ Savetofie | [ canel ][ cut |

* Blade Offset (CmelleHune HOXa): 3agaeTcsa ¢ y4eToM Tuna Hoxa; ans
CTaHOgapTHOro Hoxa coctasngeT 0,25 MM, Ans 4ONOSTHUTENBHOIO
yny4LweHHoro Hoxa — 0,5 MM, Ans gononHuTeneHoro nepa — 0 MMm.

* Quality (KayecTtBo): YeM BblLLEe KA4eCTBO, TEM HUXE CKOPOCTb
obpaboTkn.

* Multi-Cut (Heckornbko npoxodoB): 4515 NOBTOPHOIO BbIMOMHEHUS
3aaHuns 13 TOM e No3nLMKn Npu peske TONCToro marepuana.

* Overcut (Haxnecr): ynpowaet otaeneHne obrosi u KOMneHcmpyeT
He3aMKHYTbl€ NTMHUK pe3a.

L

A A

~
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B paspene Cut Settings npeaycMoTpeH psia nonesHbix yHKUMIA. 3a4aB HyxXHble
napamMmeTpbl, AaHHble OTNpaBnAlT Ha pexywmn nnotrep GCC kHonkon Cut.
MnoTtTep HaunHaeT pabory.

-
General
GCC
Model: [JaguarI\c' '] [ Settings... ]
Port: [<AuhoDebect> v] @ [TestConnecnon]
||

Cut Settings

CutMode:  |wySIWYG -

[#]Use Software Speed and Pressure [CImirorH [T Mirrer v

End Action: |Rewind to origin hd

| Preset: lCopy Paper 'Il
Haolder: [Regular Blade (0.25 mm) V]
[Blade/Pen Prompt - Preset: I< Custom Preset = - ]
) ) Cardstock (120b.)
Blade Offset: (0,25 -] overat: Holdz Cardstock (250b.)
Multicut: [Off - Quality: Cardstock (3500b.)
Copy Paper
Flocked heat transfer
S i e Heat transfer
Pressure: {} g Blade Offse Sign Vinyl M
Soft Magnet (0. 2mm)
Multi-Cv Printable tatoo EaEer iD.Zme:i !e
Print+Cut ] [ Save to file ] [ Cancel ] [ Cut J\ Speed: D 3

* Cut Mode (Pexum pesku): napametpbl WYSIWYG u Origin Point.
Pexum WYSIWYG — nnoTtep BbIBOOUT U300paXkeHne TOYHO Tak Xe,
Kak B OKHe npeaBaputenbHoro npocmotpa. B pexume Origin Point
(McxogHas Touka) NOTTEP HAYMHAET PEe3Ky C NEBON BEPXHEN TOYKM
mMartepuana.

* Use Software Speed and Pressure ([MporpammHble CKOpPOCTb
W gaBneHune): ycTaHoBuTe (pnaxok, 4TOObl BpyYHylO 3agaTtb

napamMeTpbl CKOPOCTU U OaBJIEHUA.

* Preset (lMpegBaputernbHble HACTPOKMKK): NporpaMmMma aBTOMaTUYeCKU
3apaeT CKOpOCTb U JaBrieHne pesa Ans BblbpaHHOro matepuana.

* Speed & Pressure (CkopocTb W [faBrieHue): ONA MNOBbIWEHUS
KayecTBa MOXXHO HacTpavBaTb BPY4YHYH CKOPOCTb M AaBreHue pesa.
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7. MeuaTb U pe3ka MakeTa

®dyHkuma Print and Cut no3sonsieT otnevaTtaTb u3obpaxeHue m3 nporpammbl Sure Cuts
A Lot Ha npuHTepe, a 3aTem 3arpy3anTb Matepuan ¢ pacnedaTkon B pexymi nnotrep GCC
n Yepes Sure Cuts A Lot Bblpe3aTtb Mo KOHTYpY.

OTKpbITh (haiin ¢ nsobpaxeHnem B nporpamme Sure Cuts A Lot.

File Edit Object Path layer Page Effects Text View Cutter Window

SE vy e ra &

Ed

28 UN|UN|DeN Re|5»D

Ha naHenn MHCTPYMEHTOB HaxaTb Ha 3Hauke nnoTTepa (Cutter), 3aaaTb HyXHble
napameTpbl. HaxaTb Ha kHonky Print+Cut, 4Tobbl O6aBUTL NPMBOAOYHbBIE METKU

General @

GCC

Model: [Jaguarl\‘ '] [ Settings... ]

Connection: | USB -

Port: | <Auto Detect> - [Test connection|

Cut Settings

Cut Mode: |WYSIWYG -

Use Software Speed and Pressure [CImirror - [Emirror v

Preset: [Cop'yPape( V]

Holder: [Regular Blade (0.25 mm) ']

[Bladeﬁ?en Frompt v]

Hlade Offset: [0.25 ~|  overat: [0.0ione)  ~|

Multicut: [off v Quaity: [smallietter  ~|

Speed: —{} 15 cmjs
Pressure: - D— — T0g

/
J/
pintscut X savetode |
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GCC.. Expert Il. PykoBoactso

HaxaTb KHoMKy Print... B OTKpbIBLLIEMCA OKHe HacTpoek npuHTepa BbibpaTh OK.

.+ Sure Cuts A Lot 4: Untitled ! L

IFl\e Edit Object Path Layer Page Effects Text View Cutter Window Help

(250

%

EIE: [Miomanft KPS Document Writer

X $ERY: Microsoft KPS Docwment Wiiter L
= || uE: HPEPort:

s i 8
FlENERE
@ &R 158#(C):

& T weklL B o

Va [OF: 5 12 ﬂﬂ _2)2 _3|3 Cut Settings

; D Print outlines only Preset: [Copy Faper V]

Print ragistretion marks Holder: [Regu\ar Blade {0.25 mm) v]
E‘ [ Print selection only
E B [Blade;PEn Prompt v]
[ ] Canosl

/ = Blade Offset: [0.25 '] Overcut: [0.0 (Mone) ']
E 3= = Multi-Cut: | OFF - Quality:
A‘ Speed: i 15am/fs

= Pressure: ——{| = g

O]

HIETE: PacneyaTtaTb MakeT C HAPY>XHbIMW NPUBOLOYHBIMU METKaMMU.

[ 1 r—"

el *,

Printer

MMEYEE 3arpysuTh 3anevaTaHHbI MaTepuan B pexyLumii nnottep GCC.

Haxatb Next, 3aTem Scan+Cut. Mnotrep GCC pacnosHaeT npuBoAoYHble METKM 1
aBTOMAaTUYECKW BbIPEXET KOHTYPHbIE NIMHUN.

Print and Cut Print and Cut
. Redistration Marks & - ~  Registration Marks
- an for )
Print and Cut RegMark 1: Static R i ration Matks Reg Mark 1 Static
(Auto Scan) Reg Mark 2: Static Reg Mark 2: Static

Reg Mark 3: Static RegMark 3: Static

Position the Carriage so that
it is over the first printed
registration mark at the top-
left of the design.

Click Scan+Cut to start the
Auto Scan.

This will guide you through
the steps needed for doing 2
Print and Cut

If you have not already
printed your design, dick the
Print button below to print
with your printer.

You must print using the
Print button below in order Use Software Force & Speed Use Software Force & Speed

to prir:atdynur artwork with tll::

required Registration Marks. o = Preset: [ Custom Preset > - [+]
Place the printed paper onto R sl v = .
the Cutting Mat and load it

into the cutting machine. Speed: I 5 Speed: - I 5

Click the Next button when Pressure: 3 45 Pressure: - 1} 5]

you are ready to continue

and follow the instructions Mt Cut M Cut

displayed in this window.

[ Cancel ] [ Print... ] Prev Il Next |I [ Cancel ] [ Print... Scan+Hut
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Kak akoHoMuTb MmaTepuansi ¢ cpyHkumnen Test Connection.
v" Haxatb kHonky Test Connection, 4ToObl NPOBEPUTL COEANHEHME.

General

GCC

Model: [Jaguar v

Connection: [USB

Port: [<Auho Detect>

Cut Settings

CutMode:  |wysIwyg -

Use Software Speed and Pressure

End Action: |Rewind toorigin v |

) (@] frestcomecto)

[ Mirrar H Mirrar V

Preset: [Cop'l_.' Paper

2 (b

Holder: |Regular Blade (0.25 mm)

) ()

[EJade!Pen Prompt

8

Speed: —}

Pressure: — D

0.0 (Mane) -

15 cm/fs

70g

@@l Q@

G102 FoECE BOTTE o101

| print+cut | | savetofie |

[ cancel | [ cut

If you do not see the rollers or blade move, double chedk the connection and

make sure the cable is not loose and the power is turned on.

This test will not lower the blade and will not cut anything.

This will attempt to move the rollers or blade a short distance back and forth.

carca ] |

K|

éi

AEMNOBASI
NHNUNATNBA

www.delinit.by
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